MegaDots 2.5 Reference Manual

Important Note

This Reference Manual tells you how to insert many special items in your MegaDots file. It does not tell you how to take them out. To remove a special attribute or format, see the entry for delete special item. 

abnormal paragraph break [spell checker]

The abnormal paragraph break message means that the spell checker has found a paragraph break which might not be appropriate. For example, the spell checker gives this message if the character after the paragraph break is a lower case letter. Usually your choices are: press A to accept the paragraph break as it is or press <Enter> to change the paragraph break to a space. 

abnormal punctuation [spell checker]

The abnormal punctuation message means the spell checker has found punctuation it identifies as abnormal. This can include parenthesis or quotation marks which are not paired. A previous punctuation error may trigger this message for correct punctuation later in the same paragraph. Usually your choices are to press A to accept the text or V to visit and edit the text. 

accented letters

One reason for the use of accented letters is doing diacritics (the special pronunciation symbols used in dictionaries or glossaries). If so, see diacritics. 

(The rest of this text assumes you are not doing diacritics). 

To get lists of accented letters, type Control-Insert A. Each of the different kinds of accented letters (accent acute, accent grave, cedilla, etc.) also has its own shortcut command from the Editor. These shortcuts are displayed when you type Control-Insert A. If the Default Translation Mode is set to O for grade one, and the Braille Standard is set appropriately, then MegaDots can do French, German, Italian, Portuguese, or Spanish. These two prompts are in the Translation Setup screen of the Document Menu. See also foreign text. 

It is not unusual for English text to contain some foreign words or phrases with accented letters. In braille, the accented letter appears as the ordinary letter preceded by a dot 4. There are two different contexts for these words or phrases. The braille world makes a distinction between an Anglicized word and a non-Anglicized word. An Anglicized word is one that has been adopted by the English language. In braille, a non-Anglicized word is produced in grade one, and Anglicized word is produced in grade two. MegaDots does not automatically make this distinction for you. As a rule of thumb, if the inkprint uses a special typefont to show a word with accented letters, use grade one for that word (it is considered non-Anglicized). If there is no special typefont, leave it alone (it is Anglicized). See also grade one braille. 

accept current spelling [spell checker]

When you select this option, the highlighted text remains the same, and the spell checker moves on to find the next suspicious item in your text. 

access technology

MegaDots works with voice, refreshable braille, or large print access. See Chapter 13 for the basic information. A source of information on specific products is the Interface Guide (from the Editor, press F10 H I, and select the appropriate product). 

MegaDots has a series of commands that configure MegaDots for different forms of access technology. From the Editor, press control-Z A for the list. Don't forget to save your preferences if you find a combination you prefer. See also starting MegaDots and save preferences. 

Acknowledgement [book section]

An Acknowledgement is part of the preliminary pages in literary format and in British braille. An Acknowledgement is part of the main body pages in textbook format. See Preliminary pages. To start an Acknowledgement as a preliminary page, type Control-Insert B P and pick Acknowledgement from the list. This starts the material on a fresh braille page. 

Acrobat file

See PDF file. 

acronym

An acronym is usually produced in grade one braille. For example, the acronym SEATO is produced in braille without using the "ea" contraction. In British braille without caps, an acronym gets a letter sign. 

If a word is in the spell checker vocabulary list as "upper case only", MegaDots knows that it is an acronym and handles it correctly. Thus you do not have to do anything with each and every instance of an acronym. See the documentation on the spell checker about adding words to the dictionary. Select UPPER CASE to show that you only want to the spell checker to recognize the word if it is in all upper case. 

acute accent

One reason for the use of accented letters is doing diacritics (the special pronunciation symbols used in dictionaries or glossaries). If so, see diacritics. (The rest of this text assumes you are not doing diacritics). 

The accent acute slants up from left to right. Type Alt-/ (Alt-forward slash) followed by the appropriate letter. The forward slash is suggestive of the direction of the slant of the accent acute. See also foreign translation. 

Acrobat PDF files

See PDF file. 

advanced features [preferences menu]

The advanced features are a screen in the preferences menu. These contain the auto save, the auto backup, expert user, and transcriber view. 

ae diphthong

See diphthong. 

Alphabetic pn [style]

Use this style to enter the inkprint page number for the new inkprint page in words. Use this when the sponsoring agency requests that the inkprint page number be given both in digits and in words. This format, introduced in the BANA Braille Codes Update 2007, is used mostly in material for early grades and in foreign language material. This style starts a new line in cell 1, with six hyphens followed by the print page number in words blocked in cell 7. 

alphabetize clipboard [tools menu]

The alphabetize clipboard option from the Tools Menu alphabetizes the clipboard on a paragraph by paragraph basis. To alphabetize a list, type in the list with a carriage return after each entry. Block the entire list. Press <F10 T A> to alphabetize the list. Press <Control-E> to get back to the Editor. 

An Open Book

See Open Book. 

angled bold

Angled bold is what the rest of the world calls bold italics. MegaDots likes to use a unique letter for each option. To set some text as angled bold, mark a block, and then type Control-F A. The Translation Setup Screen in the Document Menu controls how angled bold is represented in braille. If you have a braille document, and you want to change how angled bold material is shown in braille, first translate back to inkprint, then change the Translation Setup Screen, then translate back into braille. 

When editing a document, you may wish to search for material that has been set in Angle bold emphasis. You can do this with Complex find; include [emph]=~a in the Complex find text. For example, to search for a hyphen in Bold emphasis, use [emph]=~a~- in the Find text. You can also use this in a rules file. 

Anglicized word

See accented letter. 

apostrophe

An apostrophe and a single quote are different characters in braille. In inkprint the same ASCII character is used for both of these symbols. Usually, the distinction is very clear from context. However, MegaDots allows you to force the distinction. To type a character in the Editor which is always an apostrophe, just press Control-A. To enter a character in the Editor which is always a single quote, just press Control-Q. In dialect, you want to use the apostrophe, not the single quote. Use Control-A in data entry instead of the ambiguous single quote character to make correct braille. This looks like an upside down green triangle if you go into show all markup mode (Control-Z M A). See Supplement 5 for more information. See also dialect. 

When print uses an apostrophe to indicate feet, press Control-R S, apostrophe in MegaDots. The markup on the print side shows Require special symbol followed by apostrophe. This becomes the letters ft in braille, preceded by a letter indicator where needed. 

When print uses a quotation mark to indicate minutes of arc, press Control-R S Control-R S followed by apostrophe in MegaDots. The markup on the print side shows Require special symbol, Require special symbol, apostrophe. This becomes dots 134, 35 in braille, preceded by a letter indicator where needed. 

append copy

The Append copy command adds text to the clipboard. You can then place the new contents of the clipboard somewhere else in any MegaDots document with the Paste command. To add text to the current contents of the clipboard, mark it as a block (see mark a block) and press Alt-C. Instead of marking a block, you can press Alt-C and choose the text to be the character, word, line, paragraph, page, or document containing your cursor. The Append copy command is like the Control-C Copy command, except that it does not clear out the previous contents of the clipboard before it copies in the new text. Use Append copy if you want to combine text from several places and place the combined text somewhere else in a MegaDots document. See also clipboard and append kut. 

append kut

The Append kut command adds text to the clipboard and deletes it from your document at the same time. You can then place the new contents of the clipboard somewhere else in any MegaDots document with the Paste command. To use the Append kut command, mark the desired text as a block (see marked block) and press Alt-K. Instead of marking a block, you can press Alt-K and choose the text to be the character, word, line, paragraph, page, or document containing your cursor. The Append kut command is like the ordinary Kut command, except that it does not clear out the previous contents of the clipboard before it copies in the new text. Append kut is very useful for reorganizing your text. See also clipboard and append copy. 

append to clipboard

See Append copy and append kut. 

Arabic numbers

We use the term Arabic numbers to refer to numbers written with standard digits, as opposed to Roman numerals. Most page numbering in braille is done with Arabic numbers. In MegaDots, different "style sheets" apply different format guidelines for different kinds of documents. The two main style sheets are called TEXTBK97 (for textbooks) and LITERARY (for literary books). Among other things, the style sheet determines the layout of different kinds of pages. In the style sheet editor, one of the General Questions for a style sheet is Arabic preliminary pages? 

article terminator

An article terminator is a series of 12 centered hyphens used to separate articles in a braille magazine. Call up an article separator by typing Control-Insert L A. See also magazine format. 

ASCII braille on screen

There are five choices of how to view a braille document on the screen. One of these is ASCII braille on the screen. To switch modes, go to the Editor Preferences Screen of the Preferences Menu. Or you can type Control-Z D A from the Editor. This command does not change your data at all, it only changes the manner in which you view a braille document. The effect of this command is not apparent if your current document is inkprint. You can save the current view mode as the default by Save Preferences. 

ASCII file

An ASCII file is a generic file without specialized formatting information. All formatting is done with spaces, carriage returns, and form feeds. MegaDots can read and write ASCII textfiles. See Chapter 7 for more information. MegaDots handles two kinds of ASCII files: ASCII document and ASCII line. Chapter 7 details many options you have to affect the importing of ASCII files. 

ASCII keyboard

See full keyboard. 

Attribution [style]

An attribution states that someone wrote the previous material in the text. For example, an attribution may give the author's name of a poem in the text. Type Alt-N A <Enter> to specify the Attribution style. 

audio cues [editor preferences]

Your Audio cues preference controls the degree of cuing with either tones or messages which appear on the bottom screen line for voicing and viewing. Choices are S for Sounds (tones), M for Messages (which remain on the bottom screen line until the next command), C for Combo (tones and messages which do not stay on the screen), and N for None. If you use voice output, you can choose S, C, or M; choose M if your co-workers are annoyed by beeps and boops. If you use refreshable braille, choose M. If you are sighted, choose M or N. 

When you first load MegaDots, the default settings are set as described above. To set the Audio Cues preference, press F10 P E F9 A <Enter> F2, select your choice with <Enter>, and press F10. 

AUSSIE [style sheet]

AUSSIE is short for Australian. It does Australian braille. It is similar to BRITUP, but contains some customizations used in Australia. It also does North American CBC. See British braille and BRITUP for more information. Use the style sheet selection option from the Document Menu to select a style sheet for the current document. Use the New Document Preferences to specify the style sheet for future documents. 

Australian Braille

Australian braille is similar to standard British braille; except that the capital sign is used an North American CBC is used instead of British computer braille. Use the AUSSIE style sheet for Australian braille. See also Chapter 17. 

Australian localization of MegaDots

MegaDots 2.5 can be localized in three different ways: North American, Australian and British. The Australian localization uses the AUSSIE style sheet as the default. All MegaDots documentation files are automatically converted into Australian format. See also North American localization of MegaDots. 

auto backup [advanced features]

If this feature is on, ever time you save a MegaDots file, the previous copy is saved under the name *.BAK first. This gives a degree of protection against damaging a file by saving inappropriate "corrections". To reconstruct your data, you will have to compare the meg file with the bak file. To turn on this feature, go to the Advanced Features Screen in the Preferences Menu. 

auto correct braille

In the Editor Preferences Screen, one of the prompts is auto correct braille. The choices are B for Braille, I for Inkprint, and N for None. In Braille mode, any changes to words in a braille document are corrected by MegaDots on a character by character basis for errors in braille. For example, if you type "phone," MegaDots corrects you by using the "one" contraction. In Braille mode, it is assumed that your data entry is in braille. 

In Inkprint mode, it is assumed that your entry is in inkprint. Use this as a way of directly typing inkprint into a braille file. 

If you choose None (the supplied default), then MegaDots makes no effort to correct your data entry. 

auto numbered paragraphs

Microsoft Word uses autonumbered paragraphs. When you import into MegaDots, these are automatically handled correctly. 

auto save [advanced features]

You can have MegaDots save your current work every so often (you specify how many minutes between saves). Your document is auto saved only if it has changed within the designated time interval. The file is saved with the .SAV file extension. To turn on this feature, go to the Advanced Features Screen in the Preferences Menu. 

We have heard reports that using auto save may make be the cause of frequent MegaDots crashes. If this is your experience, please discontine the use of auto save. 

automatic file recognition

When a file is imported or loaded into MegaDots, MegaDots examines the file carefully to figure out what kind of file it is. MegaDots automatically uses the appropriate conversion software, so you do not need to specify what kind of file you are loading. 

automatic style sheet selection

MegaDots can decide for itself when you import a file whether to use LITERARY or TEXTBK97 style sheet. Press F10 P F <Enter>. One of the last prompts is "auto style sheet selection". Set this to "Auto". This feature only makes sense for North American users. 

baby Nemeth

Baby Nemeth refers to the built in capability of doing simple Nemeth code (math braille) in MegaDots. Baby Nemeth contrasts with the MegaMath Nemeth translator. To use baby Nemeth in MegaDots, select the style sheet BABYNEM. See style sheet selection. For information on how to use this feature, select F10 H N after selecting this style sheet. Historical note: at one time, MegaMath was an option to MegaDots. 

backup

See auto backup. 

BANA

BANA stands for Braille Authority of North America. They determine the braille translation and formatting rules. Publications from BANA are available from the American Printing House in Louisville, KY. 

BANA Braille 2010 (Word Template)

BANA Braille 2010 is a Word Template created by Susan Christensen. The intention is to offer Duxbury DBT users some of the organized structure found in MegaDots to the DBT user. Natually, Team MegaDots is not standing still. Now MegaDots 2.5 can read Word files created with this Template. Documentation is provided in the file Bana_template.htm. 

MegaDots 2.5 can to export Word files that use the BANA 2010 Template. Export to the file type MS Word/BANA Template. These Word files can be loaded into DBT with full braille formatting information. MegaDots can create these files in either inkprint or braille. Importing a braille MS Word/BANA Template file into DBT requires DBT 11.1 SR3 or greater. 

BANA Rule Changes 2007

This is a document published in late 2007 describing a series of rule changes for braille translation and formatting. MegaDots 2.5 is designed to address these changes. The PDF and the braille formatted file of this document is available with this copy of MegaDots. 

bana.mws

This textfile, included with MegaDots 2.5 controls how Word Styles are read by the DBT-based importer and then into MegaDots. If you are importing Word files into MegaDots, and get too many paragraphs in MegaDots with the style "Basic unstyled". You can fix this with additional entries in bana.mws (Using Notepad or Wordpad). You need to to go into Word to see what the paragraph style is. Then add an appropriate entry to bana.mws. We trust you are capable to looking at the simple structure of this files, and figuring out how to clipboard one entry and paste it so you can create a new entry. 

Banner [style]

The Banner style is used to make is a pattern of braille dots on a page that is discernible to a sighted non-braille reader. Use for a very short paragraph at the top of your document. To specify the Banner style, type Alt-N B <Enter>. The braille banner is placed on a separate braille page. 

banner, braille

A braille banner is a pattern of braille dots on a page that is discernible to a sighted non-braille reader. A braille banner is useful when your embossing staff cannot read braille. MegaDots has two ways of generating a braille banner. You can use the Banner style or use the MEGABANNER environment variable. See MEGABANNER. 

bar, proofreading

See proofreading bar. 

Basic table [style]

For tables with row headings, use the Basic table style. The distinction is important, because it determines how any runovers are handled in MegaDots. 

Table entries are separated by a <Tab>. Each line of the table ends with a carriage return. Blank entries are created by another <Tab>. Use a dash (two hyphens) or an ellipsis if shown in the print table. 

MegaDots assumes the top line of a table are column headings and automatically puts in the separation line. Place the cursor on this text line, and use <Shift-Alt-C> to toggle a line from column headings to a regular line (no separation line). 

When tables have long lines (many columns) and do not fit in the table, even with some runovers, MegaDots solves the problem by letting you specify a Backup table method. The backup default method is Stairstep. To change this default in your Preferences, go to <F10 P N B, Table backup method> (and save your Preferences when you are done). To change it for the current document only, use <F10 D B, Table backup method>. 

For detailed information on tables in MegaDots, See Chapter 11. Also see the subdirectory EXAMPLES in your MegaDots directory. 

Basic unstyled [style]

You can set the indent, runover and blank lines above just as in the Spacing same style. For every five spaces of inkprint indent or runover, the braille uses two spaces. To specify the Basic unstyled style, type Alt-U B <Enter>. 

If you get paragraphs marked Basic unstyled when you import from Word, this could indicate that you need to update the file bana.mws. See bana.mws. 

BAT files

Files whose names end in .BAT are batch files. A batch file is a file containing the keystrokes that you could type in at the command line. Batch files allow you to automate many basic computer functions. You can use the DOS EDIT program to create batch files. See EDIT. 

batch files

See BAT files. 

begin box

Begin box is the marker to show the beginning of a box in a book (a box is a side area of text separated from the main stream of text). In braille it is shown by a line of dropped g's. To enter a begin box indicator, position the cursor on top of the beginning of the box and type Control-Insert L B. See also end box and double box. 

Beginner Braille [Tools Menu]

The Beginner Braille feature lets you select which contractions or short form words you want used in your braille. You can make braille with any combination of contractions from grade one braille to grade two braille. Beginner Braille gives you the tools to teach your students proper braille. To use the Beginner Braille feature, press F10 T B to select Beginner Braille from the Tools Menu. See Chapter 15 for more information on Beginner Braille. 

BFM file

See braille ready file. 

bible verse

In order for bible verse references to be done correctly in braille, substitute a number sign (#) for the colon separating the chapter from the verse. For example, type 11#7 instead of 11:3. MegaDots uses the number sign for Literary braille, or the colon for Textbook braille. 

bibliography [book section]

A bibliography is a list of sources for a document. To create a bibliography, Type Control-Insert B S B <Enter>. To specify the Bibliography style, type Alt-S B <Enter>. 

Bibliography [style]

A bibliography is a list of sources for a document. To specify the Bibliography style, type Alt-S B <Enter>. 

big dots

See braille dots on the screen. 

bird's eye view

See hyper text. 

BKEYS and BKEYSDRV

BKEYS is a program that makes allows the braille keyboard program to work. See Chapter 19 for more information about BKEYS. BKEYSDRV is the braille keyboard driver in MegaDots. See Perkins keyboard entry for more information. 

blank (fill-in)

A common item in inkprint is an entry line. This is a horizontal line on which you print your name or other information. If you are brailling an entry line, type a series of underbars in your inkprint data entry. 

blank character

In MegaDots, a blank character is a space which cannot be used to divide a line. In your output (print or braille), you just get a space. Press a Control-B to get a blank character. In some word processors, this is called a hard space or a sticky space. 

blank lines

Blank lines are an aspect of output format, which is controlled by the MegaDots style system. For example, if a paragraph of Body Text is adjacent to a paragraph of List, then MegaDots puts a blank line between them. Getting the right pattern of blank lines is usually a matter of selecting the right styles. 

As a general rule, avoid creating a blank paragraph (i.e. two carriage returns in a row, so there is no text between them). See Chapter 4 for more information. 

If you want to see all the blank lines in a file you import, see skip blank lines. 

block, column

See column blocking. 

block, marked

See mark a block. 

body text [style]

Body text is the style to use for standard text paragraphs. In braille, body text paragraphs are indented to cell 3, and runover to cell 1. To specify the Body Text style, type Alt-B B <Enter>. 

bold

To mark some text as bold, first define a block. Do this by pressing Control-X and then moving the cursor. To force the block bold, type Control-F B. The Translation Setup Screen in the Document Menu controls how bold is represented in braille. 

If you have a braille document, and you want to change how bold material is shown in braille, first translate back to inkprint, then change the Translation Setup Screen, then translate back into braille. 

When editing a document, you may wish to search for material that has been set in Bold emphasis. You can do this with Complex find; include [emph]=~b in the Complex find text. For example, to search for a hyphen in Bold emphasis, use [emph]=~b~- in the Find text. You can also use this in a rules file. 

bold italics

See angled bold. 

bold underline

See dark underline. 

book title

The braille rules say that the full title of a book should be used on the title page and on line 1 of the first main body page, even if there is a running head. If a running head is set up, MegaDots does this automatically. Create a proper title page with the full title. Somewhere in the preliminary pages, create your running head, with an abbreviated title. Without your doing anything else, MegaDots uses the full title on the top of the first page but leaves the running head intact. MegaDots uses the style "Book title" to do this. 

BookMaker [embosser]

The BookMaker is an interpoint embosser made by Enabling Technologies. See the Interface Guide or press F10 H I from the Editor for directions on setting it up for use with MegaDots. 

bookmark [document menu]

Bookmarks are named positions in your file so you can locate previous positions. MegaDots automatically creates a bookmark called "last save". Press Alt-J Ins to create a new bookmark. Press Alt-J and select from the list to move to an existing bookmark. See also Quick Mark. 

Bookshare

Bookshare is a nonprofit service which provides accessible text for registered, eligible individuals. When you download a book from Bookshare, you select the format that you want. Usually BRF and XML files are available. See braille ready file and XML file. You get a file or collection of files zipped up with a password. Follow the Bookshare instructions for unzipping. 

If you have chosen the XML package, unzipping it gives several files. Of these, The one for MegaDots to open is the .xml file. 

The Bookshare .brf files are designed for refreshable braille reading and are somewhat nonstandard. There are no braille page numbers, and the only print page indicators are at the start of each print page. This is because page numbers for each braille page are not relevant on a refreshable braille device. If you are planning to emboss, we recommend importing the XML choice, translating to braille, and embossing from MegaDots. 

bottom margin

Setting a bottom margin decreases the number of lines printed on each page. To set the bottom margin in inkprint, type Control-Z I. To establish a bottom margin in braille, set the form length to the desired number of lines per braille page. To set form length permanently for a braille device, press F10 P B and select that brailler to get to the Set up a brailler screen. In addition, when you press F7 to emboss, you have an opportunity to change form length before pressing F10 to start embossing. See also form length. 

box

A box (or sidebar) is an element of text separated from the main stream of the text. To show the beginning of a box, position the cursor at the beginning of the box and type Control-Insert L B (this puts in a row of dropped g's in braille). To show the end of a box, position the cursor at the end of the box and type Control-Insert L E (this puts in a row of g's in braille). If there are two adjacent boxes, use one double box line (Control-Insert L D) instead of a close box line followed by an open box line. 

braille

In MegaDots, a document is either inkprint or braille. To find out what kind of document you have opened, look at the bottom left of your MegaDots screen: I stands for inkprint, B stands for braille. To switch from one to the other, press the F5 key. A braille document can be viewed on the screen in a number of different ways. See also braille dots on the screen and ASCII braille. 

Braille 'n Speak

The Braille 'n Speak is a small portable device which can be used as an access device. It can also exchange information with MegaDots. Look at the Interface Guide (F10 H I) for the details. 

Braille 'n Speak file format

MegaDots can import and export files designed for the Braille 'n Speak/Braille Lite. These files use a double carriage return (and no line feeds) to show a new paragraph. If you export to the Braille 'n Speak with MegaDots markup, you get an easy to read markup that can be read on the Braille Lite. 

Braille 2000

The Braille 2000 program from Computer Application Specialties Company creates files with a .abt extension. A file of this type is made up of two portions. The first portion is like a braille ready file. The second portion contains additional information used by Braille 2000. When you open an .abt file in MegaDots, you want to eliminate the extra formatting information that follows the braille material. There are several ways to accomplish this. 

When you open an .abt file, use the  -? parameter and choose the file type "Braille ready file," and do not use the Spacing same style selection. Then MegaDots eliminates the extra material following the text, and it also "interprets" the format of the braille material, making its best guess at where to place the paragraph breaks and what style to use for each paragraph. (Note that if you specify Braille ready file for the file type but also set style selection to Spacing same, MegaDots does not eliminate the extra material.) 

If you use the Spacing same style selection, to retain the original format without changes, then just manually delete the extra material following the braille text. Search for the words of "end of braille text," and delete from that point on. 

If you prefer, you can create an ordinary .brf file from a Braille 2000 .abt file by using the program called microcon in the MegaDots program folder (or by using the DOS copy command with the  /a parameter). For example, for a Braille 2000 file orange.abt in your MegaDots working directory, you can create an ordinary .brf file as follows. Go to Windows Start menu, Programs, Duxbury, Command line for MegaDots. Then type: 

microcon orange.abt orange.brf <Enter> 

exit 

Note that the earlier program program ED-IT PC also creates files with the extension .abt. The difference between the files from Braille 2000 and from ED-IT PC is that those from Braille 2000 include form feed commands to show where each braille page ends, but those from ED-IT PC do not. 

See also braille ready file. 

braille access

A braille access program hides in memory to assist a blind person to use the computer. The blind access software drives a refreshable braille display to read the text that is presented on the computer screen. See braille preferences and Chapter 13 for detailed information. 

Braille Blazer [embosser]

The Braille Blazer is an embosser made by Blazie Engineering. See the Interface Guide or press F10 H I from the Editor for directions on setting it up for use with MegaDots. 

braille contraction

See contraction. 

braille correspondence

By braille correspondence we mean a letter to be sent in the mail. If you set your carriage width to 30 and put in 2 fold lines in your output, you can easily fold your letter and place it in a number 10 envelope (you may have to trim the edges though). See also fold line and letter. 

braille device

MegaDots classifies devices as either braille or inkprint. Use the Braille Device Screen in the Preferences Menu to describe your equipment. See Chapter 5 for more information about specifying equipment preferences. See the Interface Guide or press F10 H I from the Editor for information about interfacing your braille device with your computer. 

Braille Document Setup [Document Menu]

Press F10 D B to get to the Braille Document Setup Screen. The Braille Document Setup Screen in the Document Menu allows you to specify certain details about the entire braille document: 

· You can suppress even page numbers (intended for interpoint output). 

· You can run a pre-output rules file (do this for special applications). 

· put in fold lines on a braille page (do this for a braille letter you want to send in a regular envelope). 

If you need help with any of these questions, press F1 for help when you get into the menu. 

braille dots on your inkprint printer

MegaDots offers ten different ways to print out braille dot patterns on your inkprint printer. See Chapter 10 for the details. 

braille dots on the screen

The key question is "are you operating MegaDots in the full screen"? See full screen. Once you know the answer, see braille dots on the screen for (full screen) or braille dots on the screen (for non-full screen). 

braille dots on the screen (for full screen)

MegaDots lets you choose among five different methods of viewing braille documents on the screen. Two of these methods, called Big Dots and Dots, show braille dots on the screen. The larger Big dots are easier for most sighted people to look at, and they allow for a choice of Braille shadow dots (showing the unused dots, see Braille shadow dots). 

There are two ways to change the Braille viewing method. One is to choose the Braille view mode preference in the Preferences Menu under Editor. The other, using the Zippy Menu, is to press Control-Z D from the Editor and then B for Big dots or D for Dots, which returns you to the Editor. 

Your document must be in braille, showing B in the lower left corner, for you to see what the braille looks like; if your document is in inkprint, translate to braille to see the effects. After you have found what you want, save your preferences by pressing F10 P S <Enter>. See also braille view mode. 

braille dots on the screen (for non-full screen)

MegaDots comes with two braille screen fonts (True-type fonts) for use when you cannot use the full screen. These are called MegaDots cleaner braille (no shadow dots) and MegaDots window braille (with shadow dots). See Chapter 2 for details. 

braille embosser

A braille embosser is a device to punch braille onto paper. To select your braille embosser in MegaDots, use the Braille Devices Screen in the Preferences Menu. See Chapter 5 for more information about specifying equipment preferences. See the Interface Guide or press F10 H I from the Editor for information about interfacing your braille device to your computer. 

Braille Express [embosser]

The Braille Express is an interpoint embosser made by Enabling Technologies. See the Interface Guide or press F10 H I from the Editor for directions on setting it up for use with MegaDots. 

braille format

There are very specific rules for how braille should be presented on the page. The MegaDots program uses a paragraph's style as a guide for laying out braille format. It is very important that each paragraph in a MegaDots document be marked with the appropriate style. See Chapter 4 for more information. 

braille formatted file

See braille ready file. 

braille introduction

See contraction. 

braille keyboard

See Perkins keyboard entry. 

Braille Lite

See Braille ‘n Speak. 

braille only [translation mode]

When you mark one or more characters as braille only, they appear only when the document is in braille, and not when it is in inkprint. One use of this feature is to adjust the translation by marking an inkprint word as inkprint only and following it with the desired translation marked as Exact translation and braille only. To mark something as braille only, mark it as a block and then press Control-T B. See also inkprint only and exact translation. 

Please note: if you have Transcriber View mode on, then "braille only" text is visible in the inkprint and in printouts. If you have Transcriber View mode off, then "braille only" text is invisible in inkprint. See also Transcriber View. 

braille page [Insert Menu]

You get to the Braille Page Menu by pressing Control-Insert B. From this menu you can start a fresh page, start a fresh right hand page for interpoint, change the braille page numbering, or specify the start of a new category of braille page. For example, you can specify the beginning of the table of contents, etc. See Chapter 10 for more information. See also the file prelim.meg in your MegaDots directory for examples of different kinds of preliminary pages. 

braille page number

Usually, each braille page being embossed has a sequential braille page number. In MegaDots, the choice of style sheets determines how the braille page number is done. Literary format puts the braille page number in the upper right corner, Textbook and British format puts it in the lower right corner, using the upper right corner for the inkprint page indicator. To switch style sheets, Press S in the Document Menu. If you want to alter a style sheet and modify how the braille page number (BPN) is done, see Supplement 4. 

The sequential braille page number should not be confused with the inkprint page indicators used in Textbook and British formats see inkprint page indicator). 

To suppress braille page numbering in an entire document, choose the NONUMS style sheet. To suppress braille page numbering in only part of your document, do not use the NONUMS style sheet. At the point where you want braille page numbering to stop, press Control-Insert B N 0 <Enter> to set the braille page number to 0 (which suppresses it). At the point where you want to resume braille page numbering, give the same command but with the new starting braille page number instead of 0. 

To change the braille page numbers at a certain point, type Control-Insert B N followed by the new page number and <Enter>. This sets the next braille page number to the number you specified. To reset the braille page numbering, type 1 as the new number. See also the next entry, braille page number prefix. 

braille page number prefix

A braille page number can have a single letter prefix indicating the part of the book. For example, all preliminary pages in Textbook format have the prefix p. That happens automatically when you tell MegaDots that you are using TEXTBK97 style sheet and have preliminary pages. Any other prefix requires work on your part. 

Lets say you want a glossary in textbook format to have the prefix letter of ‘g'. Press F10 T S to get into the style sheet editor. Select "Textbook" style sheet, "page layouts", and "glossary". The third prompt is "BPN prefix". Enter a single lowercase ‘g'. Press F10 4 times and let MegaDots save the change. Press Control-E to get back into your document. Press Control-Ins B P G to indicate that you are starting a glossary. MegaDots puts in the ‘g' before the braille page numbers. Don't forget to give another braille page command at the end of the glossary to stop using the prefix. When you are finished, you may want to restore the style sheet so that you do not get the prefix letter on another document. 

braille page size

Most braille pages are 25 lines, with each line made up of up to 40 characters across. To change the default size of the braille page, Go into the Preferences Menu, and then select braille devices. To add a new device, type Insert, then F2 to get a list. After you make your selection, you have an opportunity to change the default size of the braille page. 

Braille Planet

The non-profit corporation that once produced MegaDots. MegaDots is now produced, supported, and distributed by Duxbury Systems. Braille Planet in turn, took over from Raised Dot Computing. So MegaDots has been passed from Raised Dot Computing to Braille Planet (1998) to Duxbury (1999). The best source for current information on MegaDots is //www.duxburysystems.com. 

braille preferences

Launch MegaDots with mega /ar /f <Enter> to force MegaDots into braille preferences. From within MegaDots, type Control-Z A R for braille preferences. For more information about voice access, See Chapter 13. 

braille ready file

The topic of Braille ready files is complex. This article covers what braille ready files are, how to create them in MegaDots, and two different ways to import them into MegaDots (for 2 very different applications). 

What are braille ready files? 

A braille ready file contains the exact characters which need to be sent to your embosser to make hardcopy braille. When you send a braille ready file to your embosser, you get well-formatted braille. The simplicity of braille ready files (just printable characters, spaces, carriage returns, and form feeds) make them attractive. The simplicity is also their limitation. A braille ready file has a fixed carriage width and form length. In contrast, a MegaDots file can be expressed in a huge variety of layouts, translation modes, and other options to meet specialized needs. A braille ready file is not a substitute for a MegaDots file. Never save your work as a braille ready file and then delete the associated MegaDots file. 

For Duxbury DBT and for MegaDots, the preferred file extension is .BRF (prior editions of MegaDots used the .BFM file extension). 

To generate a braille ready file from MegaDots, switch to braille with F5, if necessary. Now press F7. Make sure you have selected "generic" or "generic interpoint" as your embosser. Press PageDown to get to the "Name of Port/file" prompt. Just type in a drive letter followed by colon. Now press F10 to initiate the creation of the file. 

This creates a file with the current name, with a file extension of .BRF. If the drive letter is the same as the one for the MegaDots file, then the .BRF file is placed in the same folder as the MegaDots file. You are also free to type in a specific path and filename of your choice at the Name of port/file prompt. 

To examine braille ready files, use the VIEW utility included with MegaDots. To use this program, type VIEW [filename] <Enter> from the DOS command line. See Chapter 19 for more information about VIEW. 

There are two ways of importing braille ready files into MegaDots: with or without interpretation. Importing a file with interpretation means that MegaDots attempts to build a natural MegaDots file, which can then be processed further, back translated, edited, re-translated, and expressed in a variety of translation and format modes. 

Importing a file without interpretation means that MegaDots creates a non-interpreted file, one that rigidly contains the layout of the source file. There is no opportunity to make more than microscopic changes to these files. The usual reason to import a file as a non-interpreted file is to drive an embosser with these exact characters. 

To import a braille ready file with interpretation just import it. You will probably have to do a lot of editing to make the file meet your standards for a MegaDots file. 

To import a braille ready file without interpretation, set "Style selection" to "Spacing same" and "Source" to "Retain blank lines." To do this, get to the "Open file" prompt, type the filename followed by -? -spa <Enter>, and choose "Retain blank lines" from the list. 

Or you can set Source and style selection in the Interpret format screen. After opening the file, don't forget to switch the style sheet to NONUMS to keep MegaDots from adding page numbering (since the text of the file already contains the page numbers). 

When you have done this, you can emboss the file, but you cannot edit it without messing up the format. Any editing throws off all page numbers after that point. 

Braille Section Layout [Document Menu]

Press Control-Z B to get to the Braille Section Layout Screen (also available in the Document Menu). It controls aspects of the braille pages (margins, linespacing, footnote status, or tab stops) which you may want to change in the course of a document. 

Braille Shadow Dots [editor preferences]

The Braille shadow dots choice in the Editor Preferences Menu determines how unused dots appear on the screen when the braille view mode is Big Dots. The choices are N for None, L for Light (look close to see them), and H for Heavy. 

If you have a 32 bit Windows 7 system, the choice of Braille Shadow Dots will also affect the choice of fonts used for braille. 

Braille Standard

The Braille Standard choice in the Document Menu's Translation Setup screen determines the kind of braille for the entire document. The choices are N for North American (and New Zealand), B for British, F for French, G for German, I for Italian, P for Portuguese, S for Spanish, and O for Other European. For the non-English language braille codes MegaDots does not do grade two braille. You must also set the Default translation mode to grade One in the Document Menu's Translation setup screen for the foreign language choices. 

When you get MegaDots, the default Braille standard is North American. To change this default for all new documents, change it in the New Document Preferences' Translation screen. For example you can save your preferences in a special environment file for doing a special project. Do not select the Math setting, even if you are doing a Nemeth book. See Nemeth for more information about Nemeth Code. 

Some style sheets force the choice for braille standard. For example, the NEMETH style sheet forces the Math translation mode, and the AUSSIE, BRITISH and BRITUP style sheets force the British translation mode. If you just change the value in the Braille Standard prompt, you only change the translation mode. If you choose the appropriate style sheet, you also change the format. See Chapter 17 of the User Manual for more information about British braille. 

braille transcription

See transcriber and transcription. 

braille translation

Braille translation is the act of turning an inkprint document into a braille document. Or of turning a braille document into an inkprint document. In MegaDots, this is accomplished by pressing the F5 key from the Editor. Remember that F5 is a toggle, if you press it once to change an inkprint document into braille, you can press it again to turn the document back into inkprint. 

braille volume

The size of a braille volume depends on your own circumstances (weight of paper, use of interpoint, binding technique, and the age of the person reading the braille you are producing). A braille volume may range up to 100 pages of braille. 

While MegaDots can deal with documents larger than one braille volume, we recommend limiting MegaDots files to a single braille volume. If you do have documents larger than one braille volume, MegaDots uses the transition from Main Body or Supplemental text pages to Preliminary pages to determine that a new braille volume has started again. 

brailler

See braille embosser. 

brailler graphics

Many embossers can eliminate the extra space between braille cells to make an array of evenly spaced dots available for brailler graphics of diagrams, maps, etc. Programs like QuickTac and TGD Pro can produce brailler graphics files that can be imported into MegaDots. NimPro (See Chapter 14) can automatically bring brailler graphics into MegaDots, and do all the reformatting that otherwise requires the use of a macro. 

If you have used a program that generates separate graphics files, bring them into MegaDots using the file open/import command. Once you have the graphic in MegaDots use a macro to reformat the graphics. There are two: the FIX-GR macro handles graphics when the graphic is a portion of the braille page; the FIX-GR-P macro handles graphics when the graphic is an entire braille page. For example, type Shift-F10 FIX-GR <Enter>. Both of these macros copy the graphic into the MegaDots clipboard, so you can easily insert the graphic into the correct spot in a larger MegaDots file. 

The resulting graphic in your MegaDots document has some "Section info" paragraphs just before and just after it. These paragraphs set up margin commands and commands to avoid a braille page break within the graphic. However, you may also need to insert your own Bottom margin commands around the graphic. You can insert a bottom margin command by pressing Control-Z B. When brailling in graphics mode, an embosser can handle more lines per page than when brailling in text mode. For example, you may need to insert a command like Bottom margin: 35. If you are producing a high resolution graphic as described below, you'll need a higher number in the bottom margin command. If you start the graphic with a bottom margin command, also insert a command for Bottom margin: 0 at the end of the graphic, to return the bottom margin to the ordinary form length. 

Files containing graphics cannot be sent to an embosser through the Embossit program. Instead, use the MegaPrn program to drive an Embosser as a Windows device. See Chapter 5 for the details. 

A few of the Enabling Technologies embossers (Juliet, Romeo Pro 50, and Thomas) can produce high resolution graphics. If you choose a brailler name containing +H in the MegaDots brailler list, then MegaDots uses high resolution brailler graphics. 

See Chapter 16 for more information about brailler graphics. 

Braillo [embosser]

Braillo is a brand of braille embossers made in Norway and sold in the United States by American Thermoform Corporation. Some are single-sided, and some are interpoint. See the Interface Guide or press F10 H I from the Editor for information on using them with MegaDots. 

breve

See diacritics. 

BRF file

See braille ready file. 

BRITISH [style sheet]

The BRITISH style sheet produces British braille without capitalization. The BRITUP style sheet uses capitalization, and thus supports the current rules. See British braille and Chapter 17. Use the style sheet selection option from the Document Menu to select a style sheet for the current document. Use the New Document Preferences to specify the style sheet for future documents. For all new documents, use BRITUP. 

British braille

MegaDots supports British standards for braille translation and format. British braille customarily does not use the capitalization sign. Some words (such as "edition") are translated differently than in North America. There are also differences involving some punctuation and numbers. British braille has significant format differences from North American braille. 

To effect these changes, select the BRITUP style sheet from the Style Sheet Selection Screen in the Document Menu. This changes the translation and format to British standards, changes the vocabulary list in the spell checker, and changes the Computer Braille Code. 

The style sheet AUSSIE does Australian braille. Another style sheet BRITISH does British braille without capitalization (but with British Computer Code). 

For more information about British braille, See Chapter 17 of the User Manual. See also British localization of MegaDots. 

British pound sign

To enter a British pound sign in your document, press Alt-dollar sign and select British pound sign. You cannot use simple replace to search for this symbol. Use complex replace (Control-F9), search for and Alt-dollar sign L inside of quotes. 

British localization of MegaDots

MegaDots 2.5 can be localized in three different ways: North American, Australian and British. The British localization uses the BRITUP style sheet as the default. All MegaDots documentation files are automatically converted into British format. It also contains a conversion (from ITS software) only found in Britain. See also North American localization of MegaDots. 

BRITUP [Style Sheet]

The BRITUP style sheet produces British braille with capitalization (and with British Computer Code). See British braille and Chapter 17. Use the style sheet selection option from the Document Menu to select a style sheet for the current document. Use the New Document Preferences to specify the style sheet for future documents. 

bugs

See crash 

bugfixes.meg
The file bugfixes.meg, which is installed in your MegaDots directory, describes What is New with Version 2.5. Use the menu of documentation from Start Menu, Programs, Duxbury, MegaDots 2.5 Documentation. See also documentation. 

buildbat

This is a high-powered front end MS-DOS program for GLOBAL.EXE to allow large scale text manipulation. Type buildbat ? <Enter> for documentation. 

bullet

To represent a bullet, type in Alt-plus sign B. A bullet becomes two hyphens and a space in braille. Usually bulleted items are in a list, so use the List style. You cannot use simple replace to search for this symbol. Use complex replace (Control-F9), search for and Alt-plus sign B inside of quotes. 

bus schedules

Bus schedules often have very wide tables. Wide tables are tricky in braille, none of the standard ways are very satisfactory. We have invented a few new methods to make bus schedules more readable in braille. We recommend using the Labeled table style. Follow the instructions for entering data into tables. Mark the table paragraphs in the Labeled style. 

capitalization

Braille shows uppercase letters with the capitalization indicator, dot 6 (which appears as the comma character in the ASCII braille viewing mode). Braille shows the capitalization of one letter with a single dot 6 before the letter, and it shows the capitalization of a whole word (or several letters) with two dot 6 indicators before the first letter. If the capitalization of multiple letters ends in the middle of a word, the termination indicator, dot 6 followed by dot 3 (comma followed by apostrophe) marks the return to small letters. 

The MegaDots translator makes appropriate use of the capitalization indicator. However, you may want to have manual control of the use of the capitalization indicator. To require a capitalization indicator, press Control-R D. To suppress a capitalization indicator, press Control-S D. 

The British rarely use the capital sign. See British braille. 

Outside of North America and the U.K., dots 4-6 is used as a capital sign. See foreign text for more information. 

Sometimes you need to change the capitalization in an inkprint file. There are several supplied rules files that manipulate capitalization. See rules files. 

Another issue with capitalization is dealing with excessive capital marks in Computer braille code. See Reverse CBC. 

caption [style]

A caption is the text under a picture or other graphic element. To select the Caption style, type Alt-N C <Enter>. 

carriage width

In MegaDots, carriage width is measured in inches for inkprint, and in characters for braille. There are several places in MegaDots which allow you to set the carriage width. When you specify your default output device (in the Preferences Menu), you can specify the carriage width. 

If you want to change the carriage width of a specific document, you have an opportunity to do so when you give the F7 Print command. If you want to change the effective carriage width inside of a document, you can do it by changing the right margin with an inkprint section layout or braille section layout form in the Document Menu. 

cartoon style

Use this style for the text in a cartoon. To select the Cartoon style, type Alt-N Car <Enter>. 

case sensitive/insensitive

In a case sensitive search, the text you find must match the text you specified, including the capitalization of any letters. In a case insensitive search, the capitalization of letters is not relevant. It is okay to find the same text but with different capitalization of the letters. 

For a case insensitive search in MegaDots, you can use Simple find (F9 from the Editor) and simply type a find string with no uppercase letters. You can also use Complex find and enclose the text inside single quotes (apostrophes). For a case sensitive search, you can use Simple find if you include one or more capital letters in your find string. For a case sensitive search for text that is all lowercase, you must use Complex find and enclose the text inside double quotes (quotation marks). 

CBC [translation mode]

When you mark one or more words as CBC, it uses the Computer Braille Code translator. Use this translation mode for file names or bits of computer notation mixed with ordinary literary text. To mark something as CBC, mark it as a block and then press Control-T C. See also CBC. 

CBC (Computer Braille Code)

Computer Braille Code is the official braille code for material in computer notation. It was adopted by BANA (the Braille Authority of North America) in 1987. MegaDots automatically puts file names and Internet addresses in CBC. See also computer notation, computer program, and reverse CBC. For information about the British Computer Braille Code, See Chapter 17. 

CD [DOS command]

To change from on directory to another, use the DOS CD command. CD stands for Change Directory. From MegaDots you can use the DOS shell (Alt-F10) to quickly get to the DOS command line. At that point, you can issue the DOS CD command and other DOS commands. To change to the WORK directory, type CD \WORK <Enter>. When you are ready to go back into MegaDots, just type EXIT <Enter>. See also Supplement 1. 

CD-ROM

The CD-ROM disk is usually designated by the drive letter D (or another letter higher than D). For example, there may be a file called D:\README.1ST on the new CD-ROM you just purchased. 

cedilla

One reason for the use of accented letters is doing diacritics (the special pronunciation symbols used in dictionaries or glossaries). If so, see diacritics. (The rest of this text assumes you are not doing diacritics). 

The cedilla is an accent mark that looks like a comma, usually placed under the letter c. Type Alt-, (Alt-Comma) followed by the appropriate letter. The comma is suggestive of the shape of the cedilla. See also foreign text. 

cent sign

To enter a cent sign in your document, press Alt-dollar sign and select Cent sign. You cannot use simple replace to search for this symbol. Use complex replace (Control-F9), search for and Alt-dollar sign C inside of quotes. 

Center unstyled [style]

Center unstyled centers your paragraph without any blank lines before or after it. Never use this style for a heading. You may find it useful in a glossary. 

Centered text [style]

If you want to center text, and do not want to declare the item to be a major heading, type Alt-S C <Enter>. 

centering text

To center text, use the appropriate style command. Usually, you want to set the paragraph to heading level 1 or 2. Press Alt-H 1 <Enter> or Alt-H 2 <Enter>. In a title page, use the Centered text style instead of a heading style. See Centered text. 

change directory

See CD. 

chapter title

See headings. 

character attributes

To choose character attributes, mark a block of text and then press Control-F for a list. For example, to put a word in italics, put a word in a block and type Control-F I. To see the current character attributes on the bottom line of the screen, type Control-W C. 

characters per line

See carriage width. 

CHARS.MDR
This rules file is supplied with MegaDots to count the characters in your document or marked block. To invoke it, just type Alt-F9 CHARS <Enter>. Your document is unchanged. The character count is on the bottom line. See also WORDS.MDR and rules file. 

chemistry symbols

MegaDots supports some chemistry symbols (various bonds) as part of MegaMath (Nemeth translator). 

chording

Chording means using the 6 keys SDF-JKL as a Perkins-style braille keyboard. See Perkins keyboard entry. 

circle accent

To choose a circle accent, press Alt-Period. See also foreign text. 

circumflex

One reason for the use of accented letters is doing diacritics (the special pronunciation symbols used in dictionaries or glossaries). If so, see diacritics. (The rest of this text assumes you are not doing diacritics). 

A circumflex looks like a upside down v (otherwise known as a caret) on top of a character. Press Alt-Caret to get a list. The caret character is the shift of the 6 key. See also foreign text. 

clipboard [MegaDots]

The MegaDots clipboard is a storage area that allows you to move text from one area of your document to another area or to another document. First mark a block, and then press Control-C to copy. Next move the cursor to a new location. Then press Control-P to paste the clipboard to a new location. To combine deleting the text from its current location with copying it into the clipboard in one command, use Control-K instead of copying into the clipboard and then deleting as two separate operations. Control-C and Control-K replace whatever was in the clipboard before with the marked text. 

To view the contents of your clipboard, open a new file (press F2, give a name followed by <Enter>) and then issue the Control-P paste clipboard command. You can go back to the document you were working on by pressing Control-F8. 

If you need to take an entire file and insert it into another document (in essence merge files), use the insert doc feature (Control-F3) from the Editor. 

See also Clipboard [Windows]. 

Clipboard [Windows]

To paste the Windows clipboard into a MegaDots document at the cursor position, press Alt-Spacebar E P. Do not use this as the primary means for moving text into a MegaDots document. 

See also Import file and Clipboard [MegaDots]. 

close document [File Menu]

Press F6 to close your current document. Close means to purge a document from memory. You get a warning screen if you have not saved the most recent edition of the document before attempting to close the document. The purpose of closing a document is to free up memory space so that you can open other documents for your current session with MegaDots, or just to get it out of your way. 

code page 1250 (and others)

Sometimes textfiles are created with other code pages. Such a textfile has the correct letters, numbers, and punctuation, but accented letters are all crazy characters. Import the file into Notepad, and export to UTF-8. MegaDots can import UTF-8 textfiles. 

See UTF-8. 

codes

See markup. 

color indicators

Sometimes you need to mark the color of some text. Do this only if you have to. An example would be in the event the inkprint made reference to words printed in a particular color. Your first choice is to use another form of emphasis which is described in a transcriber's note. But if a number of colors are referred to, you need to use a color indicator. 

To mark some words as being printed in color, first mark a block, then type Control-F C followed by your color selection. You can choose your color by pressing F2, and letting MegaDots present you with a list. 

color palette

Use the Control-Z C color palette to change the colors used on the screen. 

column blocking

To block an entire column, press <Control-Alt-X> and move the cursor to highlight the entire column contents. This is useful in manipulating tables. You can do such things as cut and paste entire columns (works great when there are too many columns to fit and you need to split the table), swap columns, or mark one column in emphasis or translation. 

If you are pasting the column(s) to another location, you MUST make sure you create the space for it by pressing <Enter> for each line of text to be inserted (this is not like regular pasting where MegaDots creates the necessary space). 

See also Mark a block. 

column headings of a table

MegaDots assumes the top line of a table contains column headings and inserts the separation line after this line. To toggle this line from column headings to a table line (no separation line), press <Shift-Alt-C>. 

Column material [old style]

The Column material style has been withdrawn from MegaDots. It is replaced by Related cols and Unrelated cols. Use Related cols for tabular material in which there are no row headings, but there is a relationship between material on a single row. Use Unrelated cols for columnar material that is not a table and for which there is no reason to read the material across as a row. One example is a vocabulary list. See also Basic table, Related cols and Unrelated cols. 

columnar material

See column material. 

com port

See serial port. 

combination tab

A combination tab is used when a column heading ("parent column") has subheadings ("child columns"). After the "parent column," use one <Control-Tab> for each additional column under the "parent". For example, a heading with three subheadings would be entered as: Parent heading <Control-Tab><Control-Tab><Enter>. On the next line, <Tab> between the subheadings. MegaDots places the appropriate separation lines under each of these parent and child headings. 

combined contents

The Combined contents is the table of contents in British braille for a single volume work. It shows the print page number and the braille page number of each item in the table of contents. The guide dots for combined contents is dots 3-6. MegaDots can create the Combined contents automatically using the table of contents generator. You can also create a Combined contents manually by typing Control-Ins B P C (as long as you are using British braille). See also British braille, table of contents generator, and Chapter 17 of the User Manual. 

command line

The command line is the DOS prompt. There are a variety of MegaDots commands you can use at the command line. See Chapter 19 for more information. 

You can get into the command line by clicking on the Command Line for MegaDots item in the Programs, Duxbury Group. If you do this, you will notice that the DOS window is full sized. This is appropriate for sighted persons. Blind persons using a speech program such as JAWS or Window-Eyes need to use the "window" sized screen. If the smaller screen is needed, right click on the icon, select properties, screen, and then click on the Window button (instead of full size). 

Another way to get to the command line from MegaDots is to type Alt-F10. Some applications do not work in this DOS window. To pop back into MegaDots, just type EXIT <Enter> at the DOS command line. 

Command Summary

The Command Summary is a basic list of MegaDots commands. It is provided in print and in braille with every copy sold. To get access to the Command Summary within MegaDots, press F10 H C. Use the menu of documentation from Start Menu, Programs, Duxbury, MegaDots 2.5 Documentation. See also documentation. 

compact tables

The prompt compact tables is located in the Braille Document Setup Screen of the Document Menu. This question affects offset and labeled tables (two table layouts invented by the MegaDots developers). In uncompacted tables, columns line up. Answer no, and there may be gaps in the second braille line for each inkprint line. Answer yes, to close these gaps (a compacted table uses less braille space but may be harder to read). 

complex find

Complex find gives you more options than simple find. You can search for certain character patterns (3 numbers followed by 2 letters), use logical statements, and search for a variety of character patterns. Press Control-F9 from the Editor for complex find/replace. See Chapter 12 for more information. 

compound hyphen

See diacritics. 

Computer [style]

Use the computer style when an entire paragraph is in computer notation. Transcribers describe this as set off CBC. Type Alt-T COM <Enter> to specify the computer style. 

computer braille code

See computer notation and CBC. 

computer notation

Computer notation refers to file names, exact strings of characters which are part of computer dialogue, and in general the odd strings of letters, numbers, and punctuation marks, found in computer books, which are not straight text. For example the sequence COPY G:*.* <Enter> is computer notation. MegaDots automatically puts file names and Internet addresses in CBC. 

The proper code for computer notation in braille is Computer Braille Code. MegaDots supports both North American and British computer braille codes. 

When computer notation is embedded in a paragraph which also contains regular text, mark it as a block and press Control-T C (for CBC translation). If an entire paragraph is in computer notation, put it in the computer style by pressing Alt-T COM <Enter>. If you are doing data entry with the document in braille, you can write in CBC and mark it as CBC as just indicated, using the translation markup inside a text paragraph or the Computer style for an entire paragraph. If an entire document is in computer notation, see computer program below. 

In the braille copy of the MegaDots documentation, the computer notation appears in CBC. For a short guide to reading CBC, see the beginning of the braille edition of the MegaDots Command Summary. Or press F10 H C from the Editor. 

computer program

To make a braille copy of a file containing a computer program, add <space> -com after the file name when you bring it into MegaDots. In addition to using the Computer style for the entire document, importing it with the -com option preserves blank lines and turns tab characters at the start of a line into the line indent used in CBC. 

CONFIG.SYS file

On older DOS systems, the CONFIG.SYS file is a system file which sets up your computer's memory. It is run right before the AUTOEXEC.BAT file. 

contents

see table of contents. 

Contents [style]

This style is used for a table of contents. See table of contents for full information. To apply the Contents style, type Alt-S CO <Enter>. To specify guide dots, type Control-Insert G. To create a table of contents automatically, use the Create Contents option from the Tools Menu. 

context sensitive help

Context sensitive help is the term used for supplying the help screen which is appropriate to where you are in the program. In MegaDots, what you get when you press F1 depends on your current screen or menu or your current item in a menu. If you want help on a particular subject, press F12 to get the Reference Manual. No matter how you get to a particular help screen, pressing F7 prints it out on your choice of inkprint or braille printer, and Control-C copies the text into the clipboard. 

contraction

A braille contraction is a grade two abbreviation. To get a list of contractions, press F10 H B to pull down the Braille Intro screen from the Help Menu. This screen uses a different font depending on the braille view mode is. See braille view mode. 

In a braille file, the lower right corner of the screen tells you what the character under the cursor means. 

To translate an inkprint file into braille, press F5. See grade two braille. 

MegaDots lets you force or suppress contractions. See require contraction or suppress contraction. You can select which contractions to use with the Beginner Braille feature. See Beginner Braille. 

convert file.

See import file and export file. 

copy [Edit Menu]

To copy some text into the clipboard, first highlight a block (use the mouse or Control-X), then press Control-C to copy the highlighted block into the clipboard. If you have not already marked a block, pressing Control-C brings up a menu of choices (word, sentence, paragraph, page, document) to help you specify what you want to copy: Character, Word, Line, Sentence, paraGraph, Page or Document. See also Cut to clipboard and Append copy. 

copy file [DOS command]

To copy a file from one place to another, use the DOS COPY command. From MegaDots you can use the DOS shell (Alt-F10) to quickly get to the DOS command line. At that point, you can issue the DOS COPY command and other DOS commands. To copy a file to the directory junk, type COPY filename \JUNK <Enter>. When you are ready to go back into MegaDots, just type EXIT <Enter>. See also Supplement 1. 

copy from clipboard (paste)

To paste the clipboard into your text, first position the cursor to where you want the new text to go. Then press Control-P. See copy [Edit Menu]. 

copy into clipboard

See copy [Edit Menu]. 

copyright information

Sometimes you need to include more copyright information in a document than can fit on a braille title page. Create a page after the title page by typing Control-Insert B P, and then select copyright from the menu. 

copyright symbol

To enter the copyright symbol directly in MegaDots, type Alt-period c (Alt-period followed by the letter c). When the cursor is on this character, the status bar says "c overdot". MegaDots does generate the correct braille for this symbol (in BANA, this is dots 4-5 followed by the letter c). 

correspondence, braille

By braille correspondence we mean a letter to be sent in the mail. If you set your carriage width to 30 and put 2 fold lines in your output, you can easily fold your letter and place it in a number 10 envelope (you may have to trim the edges though). See fold line and letter. 

count characters or words

See CHARS.MDR or WORDS.MDR. 

Cranmer Brailler [embosser]

The Cranmer (Modified Perkins) Brailler is an embosser which was produced in the 1980's. See the Interface Guide or press F10 H I from the Editor for directions on setting it up for use with MegaDots. 

crash

Yes, software crashes do occur. MegaDots does its best to save your work before anything else. When you restart MegaDots, you are asked if you want to restore these files. 

See Chapter 21 for more information on MegaDots program crashes, and how best to avoid them. 

Create Contents [Tools Menu]

The Create Contents option in the Tools Menu scans the main body of text, looks at the pattern of headings and prepares a table of contents for you. This can save a large amount of manual work for you. Wait until you have finished with everything else in your document, and then type F10 T C to select this utility from the Tools Menu. You can redo the table of contents by creating a new table of contents. 

create directory

See MD. 

create file

To create a file in MegaDots, you can use the save option (F4) to create a file in the MegaDots file format. Or you can use the export file option (Control-F4) to create a file in a different format (such as a file readable by another word processing program). See copy file, save file and export file. 

Cross reference [style]

Unmarked cross references (such as "See page 45.") are brailled without a reference indicator, placed in a 7-7 paragraph, and a blank line precedes and follows the reference. Press <Alt-N Cr> to specify this style. This style is the same as Incidental note. 

crossword puzzles

There is no automatic method for producing braille crossword puzzles in MegaDots. You need to know the braille rules and enter the braille directly. Use the Alt-U T command for the Translate Exact style. Do not mark a block and issue the Control-T X command. This gives you a control of the format as well as control of the translation. 

currency

To enter a currency symbol in your document, press Alt-dollar sign to access the Currency Menu. Then select the appropriate symbol. 

current page number [Insert Menu]

In inkprint, the running header or footer frequently contains the current page number. To cause this to happen, type Control-Insert C into the text which is going to be the running header or footer. 

cursor

The cursor is the flashing underbar or solid square which draws the user's attention to a single spot on the screen. The cursor shows where the next keystroke goes in the file. If you cannot see the cursor easily, use the big cursor choice in the Editor Preferences. 

Cursor go everywhere [Editor Preferences]

The Cursor go everywhere choice in the Editor Preferences Screen determines where MegaDots allows your cursor to go. The choices are N for NO and Y for Yes. 

The primary method for creating blank lines between paragraphs in your MegaDots print or braille output is the use of styles which automatically generate them. Ordinarily, cursor movements in the MegaDots Editor skip over blank lines which are forced by the adjoining paragraph styles. Since blind users do not automatically notice these blank lines on the screen, they may not know about them if the cursor does not land on them. Setting Cursor go everywhere to Yes allows the cursor to land on these blank lines to make blind users more aware of them. 

Pressing Control-E in the Editor toggles between Yes and No Cursor go everywhere. Be aware that issuing a Delete command with the cursor on such a blank line combines the paragraphs, rather than simply eliminating the blank line. If you want only to eliminate the blank line, change the style of an adjacent paragraph. 

cursor movement commands

MegaDots has a very comprehensive list of cursor movement commands. You can move by character, by word, by sentence, by line, by paragraph, or by page. Press F10 H C CU <Enter> from the Editor for the details. 

custom page layout

You can create a new page layout for your style sheet with the Style Sheet Editor in the Tools Menu. See Supplement 4 for more information about page layouts and the style sheet editor. See also Generic preliminary page. 

cut

Kut (in MegaDots spelled with a k instead of a c) means to remove a section of text and also copy the material into the clipboard. Use Kut when you want to move some text from one location to another. The sequence is: mark a block, press Control-K, move the cursor, and press Control-P to paste the clipboard to the new location. See also append kut. 

dagger

To enter a dagger in a MegaDots footnote, start the footnote with the plus sign. Use 2 plus signs for a double dagger. See footnote. 

dark underline

MegaDots calls bold underline dark underline. To mark some text as dark underline, define a block, and then type Control-F D. The Translation Setup Screen in the Document Menu controls how dark underline is represented in braille. If you have a braille document, and you want to change how dark underline material is shown in braille, first translate back to inkprint, then change the Translation Setup Screen, then translate back into braille. 

When editing a document, you may wish to search for material that has been set in Dark underline emphasis. You can do this with Complex find; include [emph]=~d in the Complex find text. For example, to search for a hyphen in Bold emphasis, use [emph]=~d~- in the Find text. You can also use this in a rules file. 

dash, braille

A braille dash is made up of two hyphens. 

dash, unbreakable

See unbreakable hyphen. 

date (version)

To find the version number and release date of your MegaDots software, press F10 H A (to get the About MegaDots screen from the Help Menu). 

DBT

Duxbury Systems developed the Duxbury Braille Translator (DBT). Duxbury Systems also markets and sells the MegaDots software. MegaDots 2.5 can import DBT print files. See dxp file and dxb file. 

The best way to send a file to Duxbury DBT is to export to MS Word/BANA Template which can be imported into Duxbury. See MS Word/BANA Template. 

You may want to offer a braille file to someone using DBT. From MegaDots, create a Braille Ready File (see Braille Ready File). When you give the file to the DBT user, tell them to use Global Settings, Formatted Braille Importer, and to check the box Formatted Braille Without Interpretation. 

If someone gives you a Braille Ready File from DBT, see Braille Ready File for instructions on how to import the file into MegaDots. 

DBT assisted import

MegaDots contains its own copy of the DBT software used to import files. If you review the different file type MegaDots imports, you will see two versions: "DBT assisted import: DBT, Word, WP", and "DBT assisted import: OCR to textfile". The former is to be used for just about all file imports. The latter is used to attempt to improve the use of MegaDots styles on file import. See chapter 16 for more on this distinction; and for how to make use of both versions of this file import. 

DBT error message

When you import a file, you might see a DBT error message. MegaDots uses the machinery of DBT to execute quite a few file imports. If there is an error during file import, the error message may havea title that says "DBT". It is quite likely that the error message will tell you something useful. 

It is our sense that the leading reason for getting an DBT error message during file import is an attempt to import a Word file containing mathematics (i.e. created using MathType) directly into MegaDots. You need to load these files first into DBT, save as a DXP file, and then attempt to import the DXP file. 

decimal tab

See tab. 

dedication

A book dedication is vertically centered on a page. Make sure that you specify that you are starting a dedication by typing Control-Insert B P D. Enter the dedication normally. The formatter takes care of the vertical centering. 

default

Default is a word that shows up very frequently in a computer manual. A default value is the computer's best guess as to what you want. Depending on the application, you might press <Enter> or F10 to accept the default value. 

default directories [preferences menu]

Default directories is a choice from the Preferences Menu. This option is used if a file operation (load or save MegaDots file, import or export a file, etc.) usually happens in only one directory. By specifying a default directory, you can simplify file operations since you do not have to specify the directory name. This feature is designed to make file operations easier on a computer network. See network. You can use the environment variable MEGADIRS to set the default directories before you launch MegaDots. See MEGADIRS. 

degree sign

To enter a degree sign in your document, press Alt-plus sign and select degree. You cannot use simple replace to search for this symbol. Use complex replace (Control-F9), search for and Alt-plus sign D inside of quotes. 

DEL [DOS Command]

See delete file. 

delay footnotes

In MegaDots, footnotes and end notes are entered the same way. The delay foot note question is used to determine if you want footnotes (material showing up at the point of reference in braille) or end notes (material showing up at the end of the book or chapter). See footnotes for information about data entry. See end notes for information about using the delay footnotes command. 

delete [Edit Menu, verb]

To delete some text, mark it as a block and press Control-D. If you have not already marked a block, pressing Control-D brings up a menu of choices (word, sentence, paragraph, page, document) to help you specify what you want to delete: Character, Word, Line, Sentence, paraGraph, Page or Document. See also delete special items. 

delete directory

See RD. 

delete file

There are two ways to delete a file. You can do it from inside MegaDots. By pressing F3 F2, highlighting the filename, and then pressing delete. 

Or you can issue the DOS DEL command yourself. From MegaDots you can use the DOS shell (Alt-F10) to quickly get to the DOS command line. At that point, you can issue the DOS DEL command and other DOS commands. To delete the file fishy.txt, type del fishy.txt <Enter>. When you are ready to go back into MegaDots, just type EXIT <Enter>. See also Supplement 1. 

delete special items

MegaDots lets you insert many special items which are not part of the text, such as emphasis, translation information, page format information, inkprint page indicators, etc. To delete these items, you must be in Format Markup mode; if you are in WYSIWYG mode, press Alt-W. The special items appear as markup. Some markup commands begin with a left pointing arrow, and some are paragraphs that begin with <<Section Info>>. Once you are in Format Markup mode, get your cursor on the unwanted item and press the Del key. For example, Format Markup display shows italics beginning and ending with markers of Ei and \Ei enclosed by arrows. 

delete text [spell checker]

This option deletes the highlighted text located by the spell checker. 

diacritics

Diacritics are additional marks on a character to show stress or pronunciation. The word or words with diacritics should be in diacritic translation. Mark the word or words as a block and issue the command Control-T D. Diacritic translation is very similar to grade one, except that accented letters are handled differently than standard grade one/grade two. 

To enter the diacritics, press Alt-* (also known as Alt-Shift-8). At the diacritic menu, press F1 for help. Follow the inkprint placement of primary and secondary stress markers, even though this is different from the proper placement in braille (where the stress symbol is moved to be before the affected syllable). When you follow the inkprint copy, MegaDots automatically places the stress symbols properly in the braille copy. However, if you second guess MegaDots and enter the stress markers before the syllable in question, MegaDots places the stress markers in the wrong place in the braille copy. 

For more information about diacritics, see Formats, Print to Braille Transcription--1997. 

When editing a document, you may wish to search for material that you know has been set in Diacritic translation. You can do this with Complex find; include [trans]=~D in the Complex find text. For example, to search for a hyphen in diacritic translation, use [trans]=~D~- in the Find text. You can also use this in a rules file. 

Diacritics [translation mode]

See diacritics. 

diaeresis

One reason for the use of accented letters is doing diacritics (the special pronunciation symbols used in dictionaries or glossaries). If so, see diacritics. (The rest of this text assumes you are not doing diacritics). 

The diaeresis or umlaut is an accent mark that looks like two dots above a letter. To access the list of diaeresis or umlaut characters from the Editor, press Alt-" (Alt-Double Quote). The double quote is suggestive of the appearance of the double dots. See also foreign text. 

dialect

The difficulty of doing dialect in braille is that of ambiguity: inkprint uses the same symbol to show both the single quote and the apostrophe, while braille uses different symbols. You want this symbol treated as an apostrophe in braille. In MegaDots, use a Control-A to force an apostrophe, and Control-Q for single quotes. 

dictionary

To show a pronunciation guide, see diacritics. 

diphthong

One reason for the use of diphthong is doing diacritics (the special pronunciation symbols used in dictionaries or glossaries). If so, see diacritics. (The rest of this text assumes you are not doing diacritics). 

To enter the ae diphthong in MegaDots, press Alt-& (alt ampersand) followed by a letter a. To enter the oe diphthong, press Alt-& followed by a letter o. At present, only these two diphthongs are supported by MegaDots. 

DIR [DOS command]

To list the contents of a directory, use the DOS DIR command. From MegaDots you can use the DOS shell (Alt-F10) to quickly get to the DOS command line. At that point, you can issue the DOS DIR command and other DOS commands. To list all the batch files in the directory in the order of creation, type DIR *.BAT /OD <Enter>. When you are ready to go back into MegaDots, just type EXIT <Enter>. See also Supplement 1. 

direct entry braille

Direct entry braille means using the 6 keys SDF-JKL as a Perkins-style braille keyboard. See Perkins keyboard entry. 

Directions [style]

Directions here means directions for exercises or tests. Use the Directions style for directions, use the Exercise style for exercises and for answer choices. Type Alt-B D to specify the Directions style. In braille the text is blocked in cell 5 and is preceded with a blank line. Be careful: in the Exercise and Directions styles any multiple spaces in inkprint become multiple spaces in braille. Since braille does not use two spaces between sentences, do not do this in the inkprint for these two styles. 

directory

A directory is a file structure created by the operating system that allows for a hierarchical system of storing files. See also default directories and Supplement 1. 

disk drive

On a PC, different disks have unique drive letters. A disk can be an internal hard drive, an external (USB) drive, a CD-ROM or DVD-ROM drive, or even an obsolete floppy drive. 

display modes

For a braille document, there are five different display modes. These are ASCII, Big Dots, Dots, Expanded, and Special. To access these, type Control-Z D followed by a letter A, B, D, E or S. Of course, you need to be in braille to see any effect. 

You can also change the markup view. The four choices are No markup (WYSIWYG), Format markup only, All (format markup and translation markup), and Style changes in text. When you use choices F or A, you get to see the internal codes of MegaDots on the screen, and you lose the ability to see exactly how the output appears. Type Control-Z M followed by a letter N, F, A or S. You can toggle between WYSIWYG and markup modes by pressing Alt-W. 

ditto mark

Just press the double quote mark (") to make the ditto mark. 

document [noun]

The document refers to an entire file loaded in memory. To get a list of documents currently opened, type Control-J D. This gives you the option to switch to other loaded documents. You can also use F8 and Control-F8 to switch to other documents. 

Document Menu

The Document Menu gives you a range of choices having to do with how the document looks. Type F10 D to get to the Document Menu. If you want to make the same choices for many documents, you may want to build your choices into your current preferences. Use the New Document Screen of the Preferences Menu to set up your document defaults. 

documentation

The Start Menu has a Group called Duxbury. Press Control-Esc P then enough D's until the highlight is on Duxbury. Click on MegaDots 2.5 Documentation. 

MegaDots documentation is also available by pressing U in the Help Menu of MegaDots, from the Duxbury Systems website, and from the MegaDots installation CD-ROM. 

You can also access much of the documentation from within MegaDots. The documentation consists of the User Manual (F11), Reference Manual (F12), Command Summary (F10 H C), Interface Guide (F10 H I) and the Nemeth Guide (F10 H N). 

DOS

DOS means Disk Operating System. The disk operating system is the software that lets you type characters, load and save files, and generally use a computer. All computers have an operating system. You happen to be stuck with an operating system that is: (1) widespread, (2) hard to learn and (3) making Bill Gates rich. See also Supplement 1. 

DOS command line

See command line. 

DOS commands [File Menu]

DOS commands let you perform basic functions with files (copy, list, locate, etc.) MegaDots has a DOS shell that lets you to and from the DOS command line with ease. See DOS shell. In this Reference Manual, there are entries for COPY, DEL, DIR, REN, CD, MD, RD and FORMAT. There are also entries for directory, path, and locate file. See also Supplement 1. 

DOS file names

For more information about DOS file names, press F10 H D from the Editor. 

DOS shell

A DOS shell means having the ability to quickly drop into the DOS command line and then drop back into your applications program at the same point you were when you issued the DOS shell command. The DOS Shell command in MegaDots is Alt-F10. To get back into MegaDots, type the word EXIT followed by <Enter>. See also DOS commands. See also Supplement 1. 

dot matrix printer

The two major types of inkprint printers are dot matrix printers and laser printers. 

dots on the screen

To put braille dots on the screen, type Control-Z D B (big dots) or Control-Z D D (small dots). These commands require EGA or VGA graphics on your computer. You can set the default mode for showing braille on the screen in the Editor Preferences Screen. You can also specify the kind of shadow dot you want for the Big Dots mode. You can have no shadow, light shadow, or heavy shadow. Big Dots can be slower. Dots can fit an entire braille page on the screen at once. 

double box line

A double box line is used to separate two boxes. If the inkprint has two boxes in a row, use the double box line to show the end of the last box and the beginning of the next box. A double box in braille is a line of full cells. Type Control-Insert L D for a double box line. 

double spacing

You can create double spaced braille for your whole document in MegaDots by going to the top of your document, pressing Control-Z B, changing line spacing to 2 and pressing F10. To change inkprint line spacing, do the same thing except press Control-Z I for Inkprint Section Layout instead of Control-Z B for Braille Section Layout. 

Braille double spacing is used for lower grade material. Remember to move to the top of the file before typing Control-Z B, if you want the entire document double spaced. See also physical underscoring and grade one braille. 

drive letter

On the PC, a unique letter is used to designate the different disk drives. See disk drive. 

dxb file

.dxb is the file extension for "Duxbury braille files." These are braille files in the file format for the Duxbury Braille Translator (DBT). See also dxp files. 

The dxb file is useful for DBT, but not for MegaDots. MegaDots cannot read in the braille formatting commands. You get the braille words, but not the braille format. With MegaDots 2.5 you could open a .dxb file without any special steps. But do not do this. 

Instead, to preserve format, you should create a braille formatted file (brf) in DBT, and import that braille file using "spacing same" into MegaDots. See braille formatted file. 

To open a document from MegaDots in DBT, see DBT. 

dxp file

.dxp is the file extension for "Duxbury print files." These are print (non-braille) files in the file format for the Duxbury Braille Translator (DBT). See also dxb file. 

With MegaDots 2.5 you can open a .dxp file without any special steps. Just tell MegaDots to open the file, and the MegaDots importer takes care of it. 

To open a document from MegaDots in DBT, see DBT. 

e-mail address

You can reach technical support for MegaDots at megadots@duxsys.com. General inquiries can be addressed to info@duxsys.com. Our web address is //www.duxburysystems.com. 

ED-IT PC

See Braille 2000. 

EDIT [DOS command]

Edit is a simple textfile editor that predates Windows. Many users may prefer Notepad or Wordpad. To use EDIT from the command line, just type EDIT followed by the file name. To exit the program and save your changes, type Alt by itself, followed by return, X, return. To exit the program without saving your changes, type Alt followed by return, X, N. See also Supplement 1. 

Edit Menu

The Edit Menu allows you to perform common manipulations on your document, such as setting emphasis or translation mode. Type F10 E to get to the Edit Menu. Since the commands on the Edit Menu are all common commands you may want to execute frequently, they all have short cuts. For example, to mark a block as italics, just type Control-F I. 

Editor

The MegaDots Editor is the program that lets you enter, edit, and modify text or braille. MegaDots uses the term "Editor" to contrast with the MegaDots menus or to the DOS command line. If you can type text, you are in the Editor. The Control-E command always takes you from the menus back to the Editor, no matter how deep you are in the menu windows. 

embosser

See braille embosser. 

embosser file

See braille ready file. 

Embossit 3.0

Embossit is a Windows program that MegaDots can use to produce braille output. The details about Embossit are in the Interface Guide and The Embossit Help File. You can launch Embossit from the Start Menu, All Programs, Duxbury, Embossit. 

Embossit cannot be used for embossing files containing graphics. For files containing embosser graphics, use MegaPrn instead of Embossit. See Chapter 5 for the details. 

emphasis

Examples of emphasis are italics, bold and underlining. When MegaDots imports files it keeps track of the inkprint emphasis. Using the Translation Setup Screen in the Document Menu, you can control how emphasis is shown in braille. See also italics, bold and underlining. If you have a braille document, and you want to change how emphasized material is shown in braille, first translate to inkprint, then change the Translation Setup Screen, then translate back into braille. 

MegaDots eliminates "excess emphasis" when importing a file into MegaDots. You can control this process from the F10 P F screen, from the Alt-I screen, or by command line options. The "excess enphasis" also controls what happens to unfamiliar HTML commands when importing a web (html) file. See web (html) file. 

end box

A box is material separated from the main stream of text. An end box is shown in braille by a line of g's. To enter an end box, position the cursor at the end of the box and type Control-Insert L E. See also begin box. 

end notes [book section]

End notes are footnotes delayed to the end of a chapter or document. The data entry in MegaDots is the same for footnotes and end notes. See footnotes for information about the data entry of footnotes. See whole paragraph note for information about changing the format for the End Notes Pages. 

The difference between footnotes and end notes in MegaDots is the use of the Delay Footnote command. Position the cursor where you want it (Usually at the top of a file). Type Control-Z B. One of the questions that comes up is "Delay Footnotes". This is a yes/no question. Answering "no" means you want immediate footnotes. Answering "yes" means that you want the notes collected for an End Notes page. MegaDots automatically places the End Notes pages at the end of the chapter or the end of the book. 

For British braille, the default is for end notes (as if you answered "yes" to "delay footnotes" question). The End Notes are placed at the end of the document, or before an index if an index is in the document. For North American braille, the default is for regular footnotes (as if you answered "no" to the "delay footnotes" question). 

To delay notes delayed for a shorter amount of space, like for a chapter, move the cursor to the beginning of this area, and answer yes to the Delay Footnotes? question. Now go the end of the chapter and repeat the same process, only answer the Delay Footnotes question with no. You can repeat this process for each chapter or poem in your document. 

end of book indicator

To show the end of a whole book, type Control-Insert L W. This puts in the appropriate mark in braille. 

end of volume indicator

To show the end of a braille volume, type Control-Insert L V. This puts in the appropriate mark in braille. It automatically puts in what MegaDots thinks is the appropriate Roman numeral (End Of Volume III etc.) If this is wrong, put your own Roman numeral after the end of volume indicator. 

Enter

Use the <Enter> key to separate paragraphs. Every paragraph has exactly one style associated with it. Do not use <Enter> for extra blank lines. See Chapter 4 for more information about formatting. If you want to force a new line within a paragraph, press Alt-Enter. If your Windows system does not allow you to use the Alt-Enter command, an alternative is Control-Ins L F. 

enter new spelling [spell checker]

This option allows you to replace the highlighted text located by the spell checker with new text typed in by you. If you need to modify text outside of the highlight, use the Visit text option instead. 

environment variable

An environment variable is a setting that many computer programs can read. In Windows, these are set from the control panel. Click on the Start Menu, Settings, Control Panel, Settings, Advanced, Environment variables. Here you can add, edit, or delete an environment variable. 

On older systems without a control panel, you need to add a line in your AUTOEXEC.BAT file, such as: SET MEGAHTML=1 

estset character (German)

Enter as a Greek beta (Alt-G b). When translation is set to grade one and Braille standard is set to German, this creates dots 2346 in braille. When importing a Word file, the estset character becomes a beta in MegaDots, so these are handled automatically. 

Euro sign

To enter a Euro sign in your document, press Alt-period e. This is the same as entering the "e overdot" character. This becomes dot 4 e in braille (for both the e overdot and the Euro sign). 

even page numbering, suppressed

It is common in interpoint output to only use odd page numbers. Choose this option in the Braille Document Setup Screen of the Document Menu. MegaDots ignores this command (i.e. puts page numbers on all pages) when embossing to single-sided embossers. See also interpoint output. 

Everest [embosser]

The Everest is an interpoint brailler made by Index of Sweden. Driver software for Index embossers is included with MegaDots 2.5. See the Interface Guide or press F10 H I from the Editor for directions on setting it up for use with MegaDots. 

exact translation [translation mode]

In MegaDots, you can mark a block as being in exact translation mode. This means that these characters are being exactly copied into the braille copy (i.e. no changes happen during translation). To mark something in exact translation, highlight a block and type Control-T X. See also Translate exact [style]. 

EXAM [Style Sheet]

The EXAM style sheet should be used for preparing tests or quizzes. It is a variation on the TEXTBK97 style sheet. Use the style sheet selection option from the Document Menu to select a style sheet for the current document. Use the New Document Preferences to specify the style sheet for future documents. 

excess emphasis

See emphasis. 

exclamation mark, upside down

To enter an upside down exclamation mark in your document, press Alt-plus sign and select exclamation. See also Spanish. You cannot use simple replace to search for this symbol. Use complex replace (Control-F9), search for and Alt-plus sign E inside of quotes. 

Exercise [style]

An exercise is a question in a test or exam. Type Alt-B E to specify the Exercise style. Exercises are done as a hierarchy (i.e. there can be a main level, a sub-level, a sub-sub level, etc.) Use the Directions style for directions, use the Exercise style for exercises and for answer choices. Use the hierarchy commands (Alt-Right arrow and Alt-Left arrow) to set the appropriate hierarchy levels. Use one additional level for the answer choices. If you want to, you can use three spaces between answer choices and enter them as a single paragraph. Be careful: in the Exercise and Directions styles multiple spaces in inkprint become multiple spaces in braille. Since braille does not use two spaces between sentences, do not do this in the inkprint for these two styles. 

exit MegaDots [File Menu]

To exit MegaDots, press Alt-X. You are asked if you want to exit now. Answer Y to exit without saving your work. Answer N to go back to the Editor. Answer S to save your work and exit. 

expanded mode of braille display

There are five choices of how to view a braille document on the screen. One of these is expanded mode. In this mode, each line of braille is back translated into inkprint (the line containing the cursor is not back translated for editing purposes). This lets you see the exact format of your braille while still reading inkprint. 

To switch modes, go to the Editor Preferences Screen of the Preferences Menu. Or you can type Control-Z D E from the Editor. This command does not change your data at all, it only changes the manner in which you view a braille document. The effect of this command is not apparent if your current document is inkprint. You can save the current view mode as the default by Save Preferences. 

Expert user [Advanced Features]

The Expert user setting does something only for voice output users. The choices are N for No and Y for Yes. When it is set to No, voice-only prompts identify each new screen and guide the user. When it is set to Yes, there are fewer voice-only prompts. 

export file [File Menu]

Exporting means creating a new file which can be read by other word processing programs. To export a file, press Control-F4. For example, if you export a file as web (html), it means that the new file now contains the text and formatting commands needed for HTML. For more information about exporting files, See Chapter 20. 

Do not use the export option to create a file for a remote embosser. See braille ready file. 

extended screen

See small text size. 

extension

A file extension is the three characters that come after the period in a file name. In DOS, there is a limit of 8 characters in the main part of the file name, and 3 characters in the extension. Usually the file extension tells the nature of a file (.txt for textfile, .doc for Word, etc.). 

An extension can be entirely arbitrary. You can have a textfile with the extension .qwp if you want. MegaDots does not require any specific extension. We recommend using the extension .meg for MegaDots files. Please note: batch files must have an extension of .bat, style sheets must have an extension of .ss, preferences files must have an extension of .env, and MegaDots rules files must have an extension of .mdr. See also Supplement 1. 

Windows often uses four characters for a file extension, such as DOCX for the latest Microsoft Word file format. Please copy your files you need to import into MegaDots into a separate directroy just for this purpose. Change the file names so all files have three letter extensions (change DOCX to DOC). 

extra right zone

Extra right zone is a phrase referring to setting up an area on the right hand side of the page reserved for page or line numbers. Tables of contents, poetry line numbers, and menu items now automatically set an extra right zone of the appropriate amount. You can use this feature in a style by setting this parameter to its minimum value in the braille specific style information. You can also override this information in the Braille Section Layout Screen in the Document Menu. 

extra space between lines, characters

When you produce inkprint, you can add extra spaces between characters or between lines. This is usually needed when producing large print and you are getting output that is too cramped either horizontally or vertically. Note that there is nothing you can do to compress text beyond answering 0 to these prompts. The unit of measurement is the point. There are 72 points to the inch. 

extracts

Extracts are what North Americans call Quotations. If the extract is just ordinary text paragraphs, you can use the Quotation style in British and North American braille. British braille format allows for more complex extracts. See Chapter 17 for the details. 

fax number

The Duxbury Systems fax number is +1-978-692-7912. 

file

The information that your computer uses is stored in files. Files can contain software programs or data. Each file has a name. Once you know a file's name, you can copy it, import it, delete it or execute it. Sometimes one does not know the exact name of a file or the location (i.e. in which directory). See WHERE. 

file conversions

MegaDots is well known for importing and exporting from a long list of file types. To get a list of file types, press F10 H C <End> <Up arrow> <Enter> from the Editor. See automatic file recognition. 

You can use MegaDots to perform direct file conversions. To do that, you need to know the internal 4 digit code for the target file format which is provided with the list of file types. For example, the 4 digit code for web (htm) is 9906, so to convert the file sample.doc into web (html), type: mega sample.doc /sSAMPLE.HTM#9601 <Enter>. 

file export

See export file. 

file folder

A file folder is the Macintosh name for a file directory. See directory. 

file for remote embosser

See braille ready file. 

file import [preferences menu]

File Import is a choice from the Preferences Menu. This option is used to control the action of the file importation process. For example, you can specify that optical scanning cleanup occur during file importation. Or you can disallow the use of some styles. By making effective use of these options you can greatly speed up your work in bringing in a new document into MegaDots. 

Sometimes you may want to modify the file before it is imported. See auto numbering for one example. 

File Menu

The File Menu gives you access to a number of options that manipulate entire documents in one stroke. Type F10 F to get to the File Menu. The File Menu lets you translate or print entire documents. Each of the items in the File Menu has a simple shortcut using the function keys. These are listed once you type F10 F. 

file names

MS-DOS limits your choice of file names. File names are limited to 8 characters, with a three letter extension. We recommend using .meg as a file extension for MegaDots files. Press F10 H D from the Editor for more information. 

file size

When you press F3 from the Editor, MegaDots tells you how much memory is available. A rule of thumb is for your files to be up to half that size. To import larger files, you may need to add more RAM memory to your computer or to rearrange your memory management. 

file types

See file conversions. 

find [Tools Menu]

Find and find/replace are in the Tools Menu. Press F9 from the Editor for simple find. Press F1 for help on simple find. Press Control-F9 for complex find. Press F1 for help on complex find. See Chapter 12 for more details on find and replace. 

find file

See locate file. 

finetune rules file

A finetune braille rules file is a global replace rules file which is executed automatically every time a document is translated into braille. As an example, lets say you never wanted to use the "sh" sign in the word "fish". Create a MegaDots file called FIX.MDR in the MegaDots directory consisting of 'fi'{}'sh'\\"!!" (the double exclamation mark stands for the suppress contraction mark. Type Control-S C to get this mark. Now choose Translation in the New Document Preferences and type FIX into finetune braille rules file prompt. Once you save your preferences, you are never be bothered by an "sh" in "fish" again. Please note that the use of the "sh" sign is recommended in standard grade two, so do not try this at home. 

FIX-GR.MAC
The FIX-GR macro brings a graphics file into MegaDots (when the graphic is meant as a portion of the braille page). See brailler graphics. 

FIX-GR-P.MAC
The FIX-GR-P macro brings a graphics file into MegaDots (when the graphic is meant as an entire braille page). See brailler graphics. 

FIXCAPS.MDR
This rules file is supplied with MegaDots to repair capitalization. It corrects a file which is all lower case and guesses which letters should be upper case. To invoke it, just type Alt-F9 FIXCAPS <Enter>. See also rules file. 

FIXMATH.MDR
This rules file is supplied with MegaDots to repair math issues. It actually fixes two different problems, but any file will only have one of these issues. It fixes advanced math symbols from math NIMAS files. See Chapter 14 for more on NIMAS files. It also fixes emphasis on math files imported through DBT. See Chapter 22 for more on using the MegaDots math translator. 

To invoke this rules file, just type Alt-F9 FIXMATH <Enter>. See also rules file. 

floppy disk

A floppy disk is usually designated by the drive letter A. For example, to open a file from a floppy, type F3 A: F2 (the A: means search the A drive). It is possible to purchase inexpensive USB floppy drives if you need to access floppy disks. See also directory, hard disk and drive letter. 

fold lines

Fold lines are extra lines of dropped c's that are used to fold pages of braille paper into an envelope. Use 2 fold lines to put braille into a standard business envelope. Use 1 fold line for a large envelope. See the Braille Document Setup Screen of the Document Menu for this prompt. 

folder, file

A file folder is the Macintosh name for a file directory. See directory. 

font size.

MegaDots lets you specify a typeface and a font size for inkprint. Fonts (inkprint letters) are measured in points. There are 72 points to an inch. The standard font on most laser printers is 10 points, with 6 lines printed per inch. The post office says that anything that is in 14 point type can be sent "free matter for the blind". Once we get up to 24 point, it is quite large print. 

You can set up document defaults. You can specify that some portion of the text is printed in a different typeface or font size than the default. To set the default, press F10 D I. Press F1 for help on the different prompts. 

You can also change the font size for headings in the Heading Setup screens of the Document Menu. 

To mark a segment with a different typeface, mark a block and then press Control-F F. To mark a segment with a different font size, mark a block and then press Control-F P. See also typeface. 

Footer [style]

A footer is a paragraph which is placed on the bottom of each page. Footers are rarely used in braille, but often are used in print. 

To specify a footer, create a paragraph containing the text that you want in the footer. Put the cursor back on the paragraph and type Alt-R F <Enter> (to select the Footer style). To have the running page number printed as part of the footer on each page, place your cursor where you want the page numbers to go, and press Control-Insert C (for Current page number). See also numbering pages. 

To terminate a footer, create a blank paragraph and apply the Footer style. 

Footer even [style]

An even footer only shows up on even pages. This format is never used in braille, it is common to have footers on odd pages only in interpoint output. We offer this style for completeness. This style only does alternating output on interpoint embossers. On single-sided embossers, MegaDots ignores the command. 

Footer odd [style]

An odd footer only shows up on odd pages. This format is often used in interpoint output. This style only does alternating output on interpoint embossers. On single-sided embossers, MegaDots puts the footers on all pages. 

footnote

MegaDots formats footnotes automatically when the appropriate steps are followed. In other words, in textbooks the footnote indicator is placed at the reference point, the braille line is completed, and the footnote is placed in the appropriate position starting on the next line (usually 7-5, but may be different in such styles as Poetry). After the footnote is completed, the remaining text paragraph is completed, using the correct runover position. In literary braille, the footnote placement is determined by whether it is a short footnote of seven words or less, or a long footnote. 

A footnote consists of two elements: the footnote reference indicator (the number, asterisk, dagger at the reference point), and the footnote text. In inkprint, the footnote text is located either at the bottom of the current page, or at the end of the current chapter or at the end of the book. See End note, Whole paragraph note and Delay footnote for information about collecting all the footnotes at the end of the current chapter or at the end of a book. 

To create a footnote in MegaDots, type the reference indicator, a space, and then the footnote text right at the reference point (this is likely to be in the middle of a paragraph). The reference indicator and the footnote text must be marked as a block and then formatted as a footnote with the <Control-F N> command. Note: do not put another reference indicator before the markup. 

The asterisk (*) is the most common footnote indicator. When other punctuation symbols are used, enter the same symbol in MegaDots. If a dagger is used in print, enter a plus sign (+) in MegaDots. If a double dagger is used in print, enter a double plus sign (++). Literary format does not use punctuation reference indicators, so MegaDots generates an automatic number instead if you are using the LITERARY Style Sheet. 

If you want your footnotes automatically numbered, just enter a number sign (ble) as the reference indicator. If you want to force a specific number, type in the number. All subsequent automatically numbered notes use this number as a starting point. Literary format does not use the general reference indicator, so MegaDots uses your number or generates an automatic number (if you are using the LITERARY Style Sheet). 

The braille reference or marginal note indicator (two dropped g's) is created by using the at sign (@) as the indicator. Special indicators such as the gloss note can be marked with @g. 

Marginal notes with no particular print location are placed at the most appropriate location in braille. Use the Manual note style, starting off the paragraph with () [open parenthesis, close parenthesis, space]. In braille this becomes two dropped g's followed by a space. 

If you need to place several paragraphs together as a footnote or an end note, then you need to use the <Alt-Enter> command to separate the paragraphs. Do not have any regular <Enter> paragraph divisions within footnote markup. If your Windows system does not allow you to use the Alt-Enter command, an alternative is Control-Ins L F. 

One bug we have found is that footnotes in paragraphs near section info paragraphs mess up the format. If you run the rules file notefix (Alt-F9 notefix <Enter>), a non-printing null paragraph is inserted to avoid this bug. 

force contraction

See require contraction. 

force new page

In MegaDots, you can independently force a new inkprint page and/or a new braille page. To force a new braille page, type Control-Insert B F (use Control-Insert B R if you or someone else might emboss this file on an interpoint embosser and want to force a righthand page). To force a new inkprint page, type Control-Insert I F. 

foreign text

Books written in a foreign language in the United States should be produced in grade one braille. MegaDots handles accented letters appropriately as long as you properly specify the document. In the Translation Setup Screen in the Document Menu, you need to answer two prompts appropriately. Set the Default Translation Method to O and set the Braille Standard appropriately. If only a portion of your document is foreign text, then mark that part as grade one. See also accented letters. 

In North America, the dot 6 is used for the capital sign. This is the default for MegaDots. If you are preparing materials for use outside of North America, then you need to use dots 4-6 for the capital sign. To do this, change the European caps sign dots 4-6 prompt in the Translation Setup screen in the Document Menu. 

foreign words

The rules of braille make a distinction between foreign words which are Anglicized and those which are not. Look at the original inkprint. Anglicized words are the same typeface as the rest of your text, while non-Anglicized words are in a different typeface. In MegaDots, put any non-Anglicized words in grade one. Mark the word or words as a block, then type Control-T O. 

In English contexts, accented letters show up in braille as a dot 4 before the appropriate letter. For example, an accented e becomes dot 4 followed by e in braille. 

foreword [book section]

A book foreword is part of the preliminary pages in literary format and in British braille. A foreword is part of the main body pages in textbook format. See Preliminary pages. To start a foreword as a preliminary page, type Control-Insert B P and pick forward from the list. This starts the material on a fresh braille page. 

form (information interface)

MegaDots uses several different systems for getting different kinds of information or selections from you, the user. We call these systems form, quick form, list, user list, and menu. When MegaDots needs several pieces of information from you on a particular topic, it puts you in a form. In a MegaDots form, you supply information for the different fields (prompts), like filling out the various blanks on a paper form. When you are in a MegaDots form, pressing F1 twice provides help on using forms. 

form feed

See force new page. 

form length

The form length is the number of lines per page in a braille document, or the number of inches of printing per page in an inkprint document. To change the form length, go to the Braille Section Layout Screen or the Inkprint Section Layout Screen of the Document Menu. See also bottom margin and top margin. 

format

Format is a confusing word in MegaDots. To format a disk means to wipe it out and prepare it for accepting data (see format a disk). To a braille transcriber, format refers to the code for laying out braille. In MegaDots, we use format to refer to a broad range of attributes which can be applied to your text. 

format [Edit Menu, verb]

To format means to modify something. In this context, formatting refers to changing some kind of attribute to the character or word (italics, underlining, boldface, etc.) To format some text, mark it as a block and press Control-F. You are presented with a list of 13 formatting attributes. If you have not already marked a block, pressing Control-F brings up a menu of choices (word, sentence, paragraph, page, document) to help you specify what you want to format: Character, Word, Line, Sentence, paraGraph, Page or Document. 

fourth sign

To enter a one fourth sign in your document, press Alt-plus sign and select fourth. You cannot use simple replace to search for this symbol. Use complex replace (Control-F9), search for and Alt-plus sign F inside of quotes. 

fraction

To enter a mixed number in Literary or Textbook braille, use a hyphen to separate the whole number from the fraction. For example, type 2-1/2 instead of 2 1/2. Nemeth braille is done differently. See Nemeth for more about Nemeth braille. 

fragment

A fragment is the characters between the current cursor position and the next major piece of punctuation. These include comma, semi-colon, colon, closed paren, hyphen, exclamation and question mark. For example, if you place the cursor in the middle of a sentence, typing Control-D F deletes till the end of the sentence (unless there is other major punctuation before the end of the sentence). 

framed mode

When MegaDots is used in framed mode, there is a decorative frame around the text screen and a top menu bar. Framed windows are designed to be more visually attractive. Unframed mode strips off these decorative elements to make it easier to use MegaDots with access technology. You can change set framed mode in the Editor Preferences Screen of the Preferences Menu. 

French

All French documents in the United States are produced in grade one braille. French uses a different accented e than other languages, so you need to tell MegaDots that the document is in French. Go to the Translation setup screen in the Document Menu. Set the Braille Standard prompt to F for French, and set the Default Translation Method to O for One. A shortcut is to load the document with a slash tof (for Translation grade One for French). For example, you can type mega sec1.txt /tof <Enter> to force French translation. 

If you want to mix grade two English with grade one French, just set the Braille Standard prompt for French, leave the Default Translation Method at T for Two, and mark any text you want in French as grade one (mark a block any type Control-T O). 

As an alternative, you can set the Braille Standard prompt for French, set the Default Translation Method at O for One, and mark any text you want in English as grade two (mark a block any type Control-T T). In either system, English is grade two and French is grade one. It is just a matter of deciding whether you want to be marking English or French segments. 

You can enter all the accent marks within MegaDots. See accented letters and foreign text. 

Be aware that the Spell Checker is MegaDots is only good for English. This makes spell checking material containing French a problem. You may find proofreading without the Spell Checker more efficient. 

In North America, the dot 6 is used for the capital sign. This is the default for MegaDots. If you are preparing materials for use in France, then you need to use dots 4-6 for the capital sign. To do this, change the European caps sign dots 4-6 prompt in the Translation Setup screen in the Document Menu. 

fresh line

If you want to force a fresh line inside of a paragraph, press Alt-Enter. This keeps the same paragraph, but forces a new line. This shows a symbol on the screen like a "double less-than" sign. To remove the fresh line, you can delete this special character with the backspace or the delete key. If your Windows system does not allow you to use the Alt-Enter command, an alternative is Control-Ins L F. 

full keyboard

Full keyboard means not using a 6 key braille keyboard. Press Alt-Scroll Lock to switch between full keyboard and braille keyboard. If you have a top menu bar, <6> symbol shows up on the upper right corner when 6-key braille keyboard is active. If Audio cues is set to Messages, pressing Alt-Scroll Lock gives the message "braille keyboard on" or "braille keyboard off." If Audio cues is set to Sounds, pressing Alt-Scroll Lock generates two beeps when you turn braille keyboard on or one beep when you turn braille keyboard off. See also Perkins keyboard entry. 

full screen

Some computers can display an MS-DOS full screen, some cannot. When you install MegaDots 2.5, you are asked if you can use MS-DOS in the full screen. If you answer "yes", and the resulting MegaDots does not work, then the correct answer is "no". (and yes, you need to re-install). 

If someone else has installed MegaDots, the question is "does the (normally blue background) screen of MegaDots fill the entire screen"? It is important to know if you can or cannot use the full screen. Several screen modes only work for full screen, and several only work for the alternative. 

gap for graphics

A gap for graphics leaves a gap in the page numbering for a later insertion of graphics pages. Press Control-Insert B G and enter the number of pages needed for graphics followed by <Enter>. As an alternative, be aware that MegaDots can also import brailler graphics files, to integrate the brailler graphics material in with the text (see brailler graphics). 

garbled text

Sometimes when you import a file, you get a lot of garbled text. This could be a graphic, an encoded attached file, or the result of optically scanning a picture instead of text. The file importer can remove garbled text. Press F10 P F to see what your preferences are for dealing with garbled text. You can over ride these preferences with a command line option of -gar or -nogar when you import a file. 

general contents

The General contents is one of three kinds of table of contents in British Braille. The General contents is the full table of contents placed in volume 1 of a multi-volume work which gives the print page numbers. It is followed by a Volume contents which gives the braille page numbers just for that volume. You need to create the General contents yourself by typing Control-Ins B P G (as long as you are using British braille). The guide dots in a general contents are dot 3. Type a Control-Insert G for guide dots in a general contents. See also British braille, volume contents, and Chapter 17 of the User Manual. 

generic document

You may want to create a document that could be printed or brailled on any device. MegaDots can do this. Format as if you are going to an (unnamed) interpoint embosser. MegaDots is designed to make proper single-sided output if you print to a single-sided embosser rather than an interpoint embosser. 

First, make sure embosser and printer fields are blank in the Braille Document Setup and the Inkprint Document Setup screens of the Document menu. Second, make sure that the margins are set at the default. Go to the top of the document. Press Control-Z I. The Top and Left Margins should be 1 inch, the Bottom and Right Margins should be zero. Press escape to close the window. Press Control-Z B. The Bottom and Right Margins should be zero. Press escape to close the window. 

When this document is printed or embossed on a copy of MegaDots with a printer or embosser configured as the default, it is used for controlling the format. Second, use formatting commands designed for interpoint embossers (instead of single-sided embossers). If MegaDots actually embosses to a single-sided embosser, MegaDots changes to single-sided formatting. Thus your document is nicely formatted no matter what embosser you use. 

In the Braille Document Setup screen, suppress even page numbers. Use Header odd or Footer odd styles instead of Header or Footer. Use Control-Insert B R to force a right-handed braille page instead of Control-Insert B F. 

German

All German documents in the United States are produced in grade one braille. German uses a different accented e than other languages, so you need to tell MegaDots that the document is in German. Go to the Translation setup screen in the Document Menu. Set the Braille Standard prompt to G for German, and set the Default Translation Method to O for One. A shortcut is to load the document with a slash tog (for Translation grade One for German). For example, you can type mega sec1.txt /tog <Enter> to force German translation. 

If you want to mix grade two English with grade one German, just set the Braille Standard prompt for German, leave the Default Translation Method at T for Two, and mark any text you want in German as grade one (mark a block any type Control-T O). 

As an alternative, you can set the Braille Standard prompt for German, set the Default Translation Method at O for One, and mark any text you want in English as grade two (mark a block any type Control-T T). In either system, English is grade two and German is grade one. It is just a matter of deciding whether you want to be marking English or German segments. 

You can enter all the accent marks within MegaDots. See accented letters and foreign text. 

Be aware that the Spell Checker is MegaDots is only good for English. This makes spell checking material containing German a problem. You may find proofreading without the Spell Checker more efficient. 

In North America, the dot 6 is used for the capital sign. This is the default for MegaDots. If you are preparing materials for use in Germany, then you need to use dots 4-6 for the capital sign. To do this, change the European caps sign dots 4-6 prompt in the Translation Setup screen in the Document Menu. 

For the German estset character, enter as a Greek beta (Alt-G b). Outside of Nemeth, if you really want a beta, enter as "require special symbol" followed by a beta. When importing a Word file, the estset character becomes a beta in MegaDots, so these are handled automatically. 

get started with MegaDots

See starting MegaDots. 

GLOBAL

GLOBAL is a program that lets you make changes to ASCII textfiles. See Chapter 19 for more information. 

global change [spell checker]

This option allows you to perform replacements throughout the text in one operation. For example, lets say that your text has a frequently misspelled word. Instead of dealing with it one at a time, you can type G 1 to globally change the highlighted text with the first suggested option. Or you can type G E to globally change the highlighted text with text you type in. Or you can type G A to globally accept the highlighted text. 

global replace

Find/replace is in the Tools Menu. Press F9 from the Editor to specify which string you want to find, press Control-Y to specify the string you want to replace it with. If you want to move through the file and be prompted for each change, press Control-Y to make a replacement, and Control-N not to make a replacement. To avoid being prompted, press Control-G for global replace. For complex find/replace, press Control-F9. See Chapter 12 for more details on global replace. 

glossary [book section]

A glossary has specific requirements in braille. Use the Glossary style for most of the material. For the centered single letter used to show where the first letter changes, use the Centered text style. 

The bottom line has guide words (the first and last term defined on that page.) MegaDots can generate the guide words, but you need to tell it which words could potentially be guide words. 

Type Control-Insert B S G <Enter> to start a glossary. For each glossary item, select the defined word as a block, and then type Control-F G. This marks the text as possible guide text. When the braille is produced, the correct guide words are placed automatically on the bottom line. See also guide words and page layouts. 

Glossary [style]

To specify the Glossary style, type Alt-S G <Enter>. 

go everywhere mode

See Cursor go everywhere. 

grade one [translation mode]

The default translation mode is grade two braille. If you want to mark something in grade one braille, mark it as a block, and then type Control-T O. To mark a whole document for grade one translation, go the Translation Setup Screen in the Document Menu, and set the Default Translation Method to One. 

If you want most of the document in grade one, with some segments in grade two, mark the entire document as grade one (as above). Then mark segments of the text as a block, and issue the Control-T T command so those segments are rendered in grade two. If you want to produce braille omitting some braille contractions (but keeping others), see Beginner Braille. 

grade two [translation mode]

Standard braille is called grade two braille. Grade two braille has over 180 contractions or braille abbreviations. See contraction. To produce grade two braille with MegaDots, usually all you have to do is press the F5 key. "Usually" is not a very reassuring word in a computer manual. 

For better control of the translation, see the Translation Setup Screen of the Document Menu. 

If you have indicated that you want the entire document produced in another translation mode (such as grade one or exact translation), and you may want a section of the document in grade two. Mark the section as a block and issue the command Control-T T. If you want to produce braille omitting some braille contractions (but keeping others), see Beginner Braille. 

Graphics [style]

MegaDots has a style designed to allow you to combine brailler graphics in a MegaDots file. See brailler graphics and gap for graphics. 

graphics files

See brailler graphics. 

grave accent

One reason for the use of accented letters is doing diacritics (the special pronunciation symbols used in dictionaries or glossaries). If so, see diacritics. (The rest of this text assumes you are not doing diacritics). 

The accent grave slants down from left to right. Type Alt-\ (Alt-backslash) followed by the appropriate letter. The backslash is suggestive of the direction of the slant of the accent grave. If you are using a U.K. keyboard, you must type Alt-Grave (to the left of the '1'). See also foreign translation. 

Greek letter

To enter Greek letters into a MegaDots file, press Alt-G. Select a letter from the available menu. This works whether or not you doing Nemeth braille. See Nemeth for more information about Nemeth braille. 

guide dots [insert menu]

Guide dots are the line of dots used to separate an item in a table of contents with the page number. To insert guide dots in a table of contents, press <Control-Insert G>. For each row of dots in a document imported into MegaDots, MegaDots substitutes guide dots. In North America, guide dots are dot 5. In British braille, guide dots are dots 3-6 (except for the general contents, which uses dot 3). 

Braille tables use guide dots, but the data entry is different. Do not use <Control-Insert G> in tables. Use a <Tab> to separate items in any columned material. See Tables. 

guide words

Guide words are the "beginning-end" constructs found on the top margin of dictionaries or telephone directories to tell you the range of entries found on a page. In Braille, guide words are placed on the bottom line of the page showing the first and last entry for the braille page. 

You need to mark the beginning of each paragraph to show the words that could be a guide word (depending on how the page breaks are placed). MegaDots automatically figures out the guide words when it formats the braille page. Mark each item as a block, then type Control-F G. This marks the word or words as potential guide words. 

If you want a guide word but don't want it to show up in the body of the text, mark it as inkprint only as well as guide text. See also glossary and inkprint only. 

Guide words are discontinued when a new braille page is forced and that page does not have any guide words defined. 

half sign

To enter a one half sign in your document, press Alt-plus sign and select half. You cannot use simple replace to search for this symbol. Use complex replace (Control-F9), search for and Alt-plus sign H inside of quotes. 

hard disk

Your hard disk is usually designated by the drive letter C. See also directory and drive letter. 

hard return

A hard return is a carriage return which is used to start a fresh paragraph. It means an unconditional new line, no matter what carriage width is used to display or print the document. Contrast with soft return. 

hard space

See blank character. 

Header [style]

A header is a paragraph found on the top of every page. In braille, these are called running heads, and in North America usually contain the title or abbreviated title of a book. It is abbreviated if the title does not fit on one line. 

In Britain the running head is called a page information line and usually contains the name of a chapter or section of a book. See Chapter 17 for more on the British Page Information Line. 

For a North American running head, type the text for the running header as a separate paragraph. Then type Alt-R H <Enter> to mark a paragraph as a header. See also numbering pages. 

If you are transcribing a book, you are required to have the full title of a book on top of page 1 (not the abbreviated title mentioned above). See Book Title for the details on how MegaDots can do this automatically. 

To terminate a header, create a blank paragraph and apply the Header style. 

Header even [style]

An even header only shows up on even pages. This format is never used in braille, It is common to have headings on odd pages only in interpoint output. We offer this style for completeness. This style only does alternating output on interpoint embossers. On single-sided embossers, MegaDots ignores the command. 

Header odd [style]

An odd header only shows up on odd pages. This format is often used in interpoint output. This style only does alternating output on interpoint embossers. On single-sided embossers, MegaDots puts the headers on all pages. 

heading area

A heading area is the characters between the current cursor position and the next heading. For example, if you place the cursor at the beginning of a heading, and press Control-K H, you Kut out all the text from the current position until the next heading. You can then paste that text somewhere else. 

You can also press Alt-PageDown or Alt-PageUp to move the cursor by heading area. 

heading emphasis

In braille, you can only show a heading as a major heading or as a minor heading. You may find a situation where you want to show the distinction between two different heading levels. You can use heading emphasis markers to do this. These are explicit symbols placed before headings. To use heading emphasis, go to the appropriate level in the Heading Setup Screen in the Document Menu. See the help screen for the choices. 

Heading Setup [Document Menu]

Type F10 D H to get to the Heading Setup Screen in the Document Menu. This menu lets you specify the braille and inkprint format for each level of headings in MegaDots. For example, lets say there are three levels of headings in your document. You could define level 1 to be done with Major Heads with a page break, level 2 to be done with Major Heads, and level 3 to be done with Minor Heads. A certified transcriber looking at the inkprint can help make these important decisions. 

headings

You need to learn the structure of headings in your inkprint source document. With this information, you can define the headings in the Headings Setup Screen of the Document Menu. For more information, see the section of Chapter 8 on headings. Once you have set up your headings, you can apply the correct heading level by typing Alt-H followed by the appropriate number. 

Headings in braille come in two flavors: major head and minor head. See the section on headings in Supplement 2 for more details. In braille, it is against the rules to use any other form of emphasis (italics, bold face, underlining, etc.) for the text in a heading. Of course, if a specific item in a heading (such as the name of a referenced book) needs emphasis, that is OK; it is the universal application of emphasis that is not allowed. 

In MegaDots, headings are designated by a number (heading level 1, heading level 2, etc.). To set a paragraph as a level 3 heading, type Alt-H 3 <Enter>. 

You control how different levels of heading are formatted in MegaDots. Use the Heading Setup Screen in the Document Menu to specify the braille and inkprint format for each level of headings. 

help

See technical help. 

help index

The help index is an alphabetized list of all the help screen topics. Selecting an item from the list brings up the appropriate help screen. Press F10 H H from the Editor to bring up the help index. As in other MegaDots lists, move to the topic you want by typing the beginning letters or by using the up and down arrow keys, and press <Enter> to select that help screen. 

Help Menu

The Help Menu is located on the top menu, Type F10 H to get to the Help Menu. The Help Menu has a series of items to supplement the MegaDots 2.5 Documentation. 

hierarchy

Hierarchy refers to the concept of a multi-level structure. For example, a table of contents may have main items, sub items, and sub-sub items. This would be a three-level hierarchy. 

To see the level of an item, look to the right of the style name on the bottom status line. A hierarchy level is only given for styles that have hierarchies. How a paragraph behaves at different hierarchy levels is defined in the style information. Some styles (such as Body text) do not have any hierarchy. 

If you want to move something down one notch in a hierarchy, press Alt-Right Arrow. To move up one level, press Alt-Left Arrow. You can also set the level by directly pressing Alt-Digit. 

hidden text

You can set text in a file as "hidden text". Hidden text is not be printed or brailled. Hidden text is related to "inkprint only" or "braille only". Hidden text is output to neither output device. 

To create hidden text, highlight it, and type control-F H. It is visible on the screen in show markup, and goes away in WYSIWYG. 

Hidden text is used for unfamiliar HTML commands when importing web (html) files with excess emphasis set to "allow". See web (html) file. 

high bit characters

High bit characters have an ASCII number over 127. There is no standard for high bit characters (the PC uses a different set than the Mac, etc.). MegaDots supports most all of the PC high bit characters. Many of these characters have no defined standard in braille. If you import a file with PC graphics characters (the characters used to create decorative frames), MegaDots replaces these characters with hyphens. 

highlight

Highlight means to mark a block of text in preparation for a specific command to affect that section of text (delete, make italics, copy to clipboard, change styles, etc.). To highlight a block of text you can use the mouse (press the button and move the mouse). Or you can press Control-X and then move the cursor keys. Once you have highlighted your text, you can give the appropriate command. 

Hot Dots file

Hot Dots is a braille translation program for the PC sold by Raised Dot Computing before the introduction of MegaDots. MegaDots can directly read Hot Dots $$ files. 

hot key

See shortcut key. 

Huge Outline [style]

Braille rules make a distinction between ordinary outlines, and outlines so large that they are an entire book. Huge outline is the MegaDots term for an outline that is so big it is its own document (the TBF Codebook for Textbook format is an example of a huge outline). To specify the Huge Outline Style, type Alt-B H <Enter>. 

hyper text

Hyper text refers to ways to locate cross-references and headings in a large text. MegaDots contains several hyper text features. If you press Control-J G space, you get to view a list of all the headings in your document (Control-J G shows a list of ALL paragraphs, space toggles a feature to restrict your view only to headings). 

If you import a web (html) file, MegaDots retains the cross-references. See web (html) file. 

hyphen, optional

An optional hyphen is a special character that allows a line to be broken inside a word at the designated location. Specify an optional hyphen by pressing Control-Hyphen. You can only see an optional hyphen in All markup mode. Type Control-Z MA to show all markup. One use for the optional hyphen is to hyphenate a word which causes the previous line to have too many spaces at the end. You can search for these lines with the short line search feature. See short line search. 

hyphen, unbreakable

An unbreakable hyphen (dash) is a hyphen that cannot be used to divide a line. Specify an unbreakable dash by pressing Control-U. 

hyphenization

MegaDots does not have automatic hyphenization. You can tell the program where it can divide words by using the optional hyphen (Control-Hyphen) command. At present, the file importer strips off hyphenization markup, since these codes can confuse the braille translator. 

icon for Windows

The installation program creates desktop icons for you. See Chapter 2 for the details on MegaDots installation. 

import file

Use the F3 key to open or import a file into MegaDots. See Chapter 7 for more information about file importation. See also Chapter 18 for tips on importing files by clicking in Windows Explorer. See also automatic file recognition, file conversion, interpret format and source of document. 

inches shifted from binding

Some printers give too small a left margin. If you want MegaDots to push the text from the left edge of the paper to make a more appropriate left margin, specify the inches shifted from binding value in your inkprint device preference set-up. In addition, when you press F7 to print a document, the inches shifted from binding value is one of the settings you can change. The equivalent MegaDots setting for braillers is the Shift Right setting. 

Incidental note [style]

Incidental notes (such as "See the Handbook.") are brailled without a reference indicator, placed in a 7-7 paragraph, and a blank line precedes and follows the reference. Press <Alt-N I> to specify this style. This style is the same as Cross reference. 

incremental search

In a MegaDots list, incremental search lets you find the item you want quickly. Type the beginning characters. As you add more characters, MegaDots brings you to the first item that matches what you have typed so far. If the cursor jumps to a new item, that one is spoken. If it no longer finds a matching item, it beeps. 

indent

The indent is the position in a line where a paragraph starts. The indentation is specified in a style. See Supplement 2 for more information. 

indent increment

The indent increment is a question in the style system which controls how much the indentation goes up for each additional level in a hierarchy. See Supplement 4 for more information. 

Indent 1 [style]

This (and several related styles) are used with the Susan Christensen Word template. Use of these styles is discouraged, since these styles lack some basic braille context information for creating proper braille format. 

index [book section]

An index is a special kind of braille page. Type Control-Insert B S I to start an index. As you do data entry, MegaDots uses the style index. Enter each entry as a paragraph (press <Enter> after each entry). See index [style]. 

Index [embosser]

Index is a brand of embossers made by the Index Company in Sweden. Those in use in the United States include the Index Basic, the Index Advanced, and the Everest (interpoint). Driver software for Index embossers is included with MegaDots 2.5. See the Interface Guide or press F10 H I from the Editor for directions on setting these up for use with MegaDots. 

index [style]

If the document you are producing in braille has an index, then you need to use the index style. To specify the index style, type Alt-S I <Enter>. 

Indexes frequently use hierarchy. Use the hierarchy commands (Alt-Left Arrow, Alt-Right Arrow, or Alt-Number) to change the hierarchy of an index entry. 

InftyReader files

InftyReader is a project to optically scan mathematics inkprint into files that contain mathematics. Duxbury DBT can import InftyReaderX files. MegaDots can import those file from Duxbury DBT. See math file import. 

inkprint

In MegaDots, documents are either inkprint or braille. Press F5 to switch between braille and inkprint. The bottom left of the screen is either I for inkprint or B for braille. 

Inkprint braille printing modes

MegaDots offers 10 different ways to print out braille dot patterns on your inkprint printer. See Chapter 10 for the details. 

inkprint device (inkprint printer)

An inkprint device is also known as a printer. Use the Inkprint Device Preferences Screen to define your inkprint device. Use the F1 help button as a guide to the prompts. If you do not find your inkprint printer in the menus of MegaDots, See Chapter 5 for possible solutions. 

Inkprint Document Setup [Document Menu]

Type F10 D I to get to the Inkprint Document Setup Screen in the Document Menu. This menu lets you specify some common formatting attributes that affect an entire document as a unit. You can set orphan and widow control, define the printer used to format the document on the screen. 

inkprint only [translation mode]

When you mark one or more characters as inkprint only, they appear only when the document is in inkprint, and not when it is in braille. One use of this feature is to adjust the translation by marking an inkprint word as inkprint only and following it with the desired translation marked as exact translation and braille only. To mark something as inkprint only, mark it as a block and then press Control-T I. See also braille only and exact translation. 

inkprint page indicator

In Textbook and British format braille, each page of braille has an indicator showing which inkprint page the current braille corresponds with. In North American braille it is in the upper right hand corner of each braille page, and also at the end of a line of dashes for inkprint page transitions within a braille page. 

To produce inkprint page indicators in MegaDots, select the Textbook or British style sheet, using the Style Sheet Selection option in the Document Menu. 

In the document itself, you must show MegaDots where each new inkprint page begins. Get your cursor on the first character of the new inkprint page, after a space if the new page starts in the middle of a paragraph, or otherwise, as the first character of a new paragraph (after the end of paragraph marker). Press Control-Enter. MegaDots prompts you with a page number; if it is incorrect, type the correct number followed by <Enter>. You do not see the number in inkprint WYSIWYG. In Show markup display, you see arrows enclosing a number sign followed by the page number. In your braille output and in braille WYSIWYG display, MegaDots automatically places the inkprint page indicators correctly, with prefix letters for continuation pages. 

To examine, search, or modify your inkprint page indicators, press Alt-Z. At this screen, you have many choices. If you want to jump to page 10, just press 10 <Enter>. You can renumber all your inkprint page numbers in one stroke. If you import your document from another source, such as an optical scanner file, with the page breaks intact, you can use this screen to assign all of the inkprint page indicators automatically. 

To specify a range of inkprint pages for the inkprint page indicator (such as several blank inkprint pages followed by a page of text), use the tilde character (~). For example, at the start of inkprint page 105, which follows blank pages 102-104, give the insert inkprint indicator command with the number 102~105. 

If you give a running head, always position the cursor on the first character after the running head line to insert the first inkprint page indicator. 

To terminate the use of print page indicators, there are two choices. If a hyphen (-) is entered into the <Control-Enter> IPP box, MegaDots puts in a full line of dots 3-6 (left to right margin) at that point, and discontinue print page numbers for the rest of the document, or until they are defined again. If a <Delete> <Enter> is entered at the <Control-Enter> box, MegaDots discontinues print page numbers from that point forward. However, if this is happening mid braille page, there is no indication as to where the page numbering is actually ending. 

Inkprint Section Layout [Document Menu]

Type Control-Z I to get to the Inkprint Section Layout Screen (also in the Document Menu). This menu lets you specify common formatting attributes (such as margins and tabs). 

insert clipboard

See paste. 

Insert Doc [File Menu]

The Insert Doc option (Control-F3) lets you specify a file (MegaDots, textfile or word processor file), to be inserted into your document at the cursor. This is ideal for combining several files into one large MegaDots file. 

Insert Menu

The Insert Menu is a menu of special items which can be inserted into a MegaDots document. To call up the Insert Menu, press Control-Ins. 

insert mode

Insert mode means that when you type in the Editor, the characters are inserted in the text. The alternative is overstrike mode (characters you type overstrike or replace the characters under the cursor). To switch between these modes, press the Insert key. If you are insert mode, the characters <INS> show up in the upper right hand corner of the screen. With audio cues set to sounds, you get a sound cue when you change modes. 

installing MegaDots

See Chapter 2 of the User Manual for installation information. 

Interface Guide

The Interface Guide gives detailed interfacing information about connecting your access technology (especially braillers) to your computer. It is provided in print with every copy sold. To get access to the Interface Guide within MegaDots, press F10 H I. Use the menu of documentation from Start Menu, Programs, Duxbury, MegaDots 2.5 Documentation. See also documentation. 

international committee file

See ICADD file. 

interpoint output

An interpoint embosser is an embosser that can emboss on both sides of the paper at once. There are subtle formatting differences on output to interpoint embossers. It is common to suppress even page numbers for interpoint output. Choose this option in the Braille Document Setup Screen of the Document Menu. See also generic document. 

interpret format

Once you import a file, you can press Alt-I to open the interpret format screen. This lets you see at a glance what kind of file you have imported, and gives you a chance to give revised instructions to MegaDots to re-import the file. 

If you want to, you can tell MegaDots to always open the interpret format screen just after importing a file. Open the File Import Preferences, and choose the file type. The last prompt on the Import Options Screen is "Auto report". Answer this prompt "yes" if you want to open the screen automatically after each file import. See also re-import and Chapter 7 of the User Manual. 

intrinsic MegaDots error

If you get a message about an intrinsic MegaDots error, please call Duxbury Systems for the solution. 

introduction [book section]

A book introduction is part of the preliminary pages in literary format and in British braille (though sometimes an introduction is part of the main body pages in British braille). An introduction is part of the main body pages in textbook format. See Preliminary pages. To start an introduction as a preliminary page, type Control-Insert B P and pick introduction from the list. This starts the material on a fresh braille page. 

Italian

All Italian documents in the United States are produced in grade one braille. Italian uses a different accented e than other languages, so you need to tell MegaDots that the document is in Italian. Go to the Translation setup screen in the Document Menu. Set the Braille Standard prompt to I for Italian, and set the Default Translation Method to O for One. A shortcut is to load the document with a slash toi (for Translation grade One for Italian). For example, you can type mega sec1.txt /toi <Enter> to force Italian translation. 

If you want to mix grade two English with grade one Italian, just set the Braille Standard prompt for Italian, leave the Default Translation Method at T for Two, and mark any text you want in Italian as grade one (mark a block any type Control-T O). 

As an alternative, you can set the Braille Standard prompt for Italian, set the Default Translation Method at O for One, and mark any text you want in English as grade two (mark a block any type Control-T T). In either system, English is grade two and Italian is grade one. It is just a matter of deciding whether you want to be marking English or Italian segments. 

You can enter all the accent marks within MegaDots. See accented letters and foreign text. 

Be aware that the Spell Checker is MegaDots is only good for English. This makes spell checking material containing Italian a problem. You may find proofreading without the Spell Checker more efficient. 

In North America, the dot 6 is used for the capital sign. This is the default for MegaDots. If you are preparing materials for use in Italy, then you need to use dots 4-6 for the capital sign. To do this, change the European caps sign dots 4-6 prompt in the Translation Setup screen in the Document Menu. 

italics

Mark text as a block and then type Control-F I for italics. The Translation Setup Screen in the Document Menu controls how italics are represented in braille. If you have a braille document, and you want to change how the italics material is shown, first translate back to inkprint, then change the Translation Setup Screen, then translate back into braille. 

When editing a document, you may wish to search for material that has been set in Italic emphasis. You can do this with Complex find; include [emph]=~i in the Complex find text. For example, to search for a hyphen in Italic emphasis, use: [emph]=~i~- in the Find text. You can also use this in a rules file. 

items

See List. 

ITS file

The ITS (Integrated Translation System) software is a braille translator used by the Royal National Institute for the Blind in the United Kingdom. The source files for ITS are ASCII files containing dollar formatting codes. MegaDots automatically recognizes and imports ITS files. For more information on British braille, See Chapter 17. 

JAWS

Jaws for Windows offers speech and braille access for the Windows 95/98/NT/2000/XP/Vista environment. JFW 3.0 and higher contain support for MS-DOS programs. MegaDots works well with JAWS. 

For more information about MegaDots and JAWS, See Chapter 13. 

Juliet [embosser]

The Juliet is an interpoint brailler made by Enabling Technologies. See the Interface Guide or press F10 H I from the Editor for directions on setting it up for use with MegaDots. The Juliet has 4 different options in the MegaDots list of embossers: single sided vs. interpoint and regular graphics vs. high resolution graphics. The +H (plus sign H) means with high resolution graphics. 

jumbo braille

In jumbo braille, the dot combinations are identical to those used in traditional braille, but the horizontal spacing between the dots and cells is increased just a little bit. The dots themselves are the same size as those used in standard-sized braille. Jumbo braille was specifically developed for blind people for whom limited sensitivity in their fingertips makes it harder to feel the dots in ordinary braille. 

A number of embossers, including the Romeo and Juliet models, have a setting for spacing which can be set for jumbo braille. MegaDots can produce jumbo braille on these embossers. 

jump to [Edit Menu, verb]

Press Control-J to jump to (move the cursor to a different location). If you type Control-J G you get a vertical menu showing the start of each paragraph, so that you can select the paragraph you want to jump to. You can press Spacebar to toggle the list between all paragraphs and just heading paragraphs. You can also change styles in the Control-J G display. If you type Control-J D, you get a list of documents currently opened in MegaDots. See also bookmark. 

key to tables

To create a key to tables with an indent of 1, and a runover of 3, make a list and then apply the Control-F T command. The first paragraph is in 7-5 format, and subsequent paragraphs are in 1-3 format. 

keyboard modes.

MegaDots allows both 6-key Perkins-style braille keyboard and full keyboard use. See Perkins keyboard entry. 

kut [Edit Menu, Verb]

Kut means to remove a section of text and also copy the material into the clipboard. Use Kut when you want to move some text from one location to another. The sequence is: mark a block, press Control-K, move the cursor, and press Control-P to paste the clipboard to the new location. If you have not already marked a block, pressing Control-K brings up a menu of choices (word, sentence, paragraph, page, document) to help you specify what you want to kut: Character, Word, Line, Sentence, paraGraph, Page or Document. See also append kut. 

Labeled Table [style]

A labeled table uses a format not approved by BANA. The labeled format is similar to the offset method (also not approved). The labeled method puts in letter labels at the start of each table entry. The offset method uses several lines of braille for each line of inkprint (with no cell runover). See offset table, and the help when you press Alt-T. See also compact tables. 

large print access

To get large print output on a printer, see large print output. MegaDots lets you work with large print on the screen in two different ways. MegaDots has its own large sized character font (see text size for more information). Or you can use an external large print program like ZoomText or LP-DOS (see the entry large print program for more information). 

large print output

See typeface and font size. 

large print program

MegaDots lets you work with large print on the screen in two different ways. MegaDots has its own large sized character font (see the entry text size for more information). Or you can use an external large print program like ZoomText or LP-DOS. To tell MegaDots that you are using an external large print program just launch MegaDots by typing: mega /a2 /f <Enter>. The magnification number right after the /a can be any number from 2 to 5 (See Chapter 19). 

laser printers

MegaDots supports several laser printers. In the inkprint devices section of the Preferences Menu, the following are laser printers: HP LaserJet I, HP LaserJet II, Panasonic 4410, and Postscript. For most modern laser printers, the HP LaserJet II is probably the best choice. 

last file

MegaDots allows you to have more than one document loaded in memory at one time. If you do so, you can switch between them easily. To switch to the next file, press F8. To switch to the last (previous) file, press Control-F8. To choose from a list of documents, type Control-J D. 

last save

See bookmark. 

LaTeX files

LaTeX files contain mathematics. Duxbury DBT can import LaTeX files. MegaDots can import those file from Duxbury DBT. See math file import. 

launching MegaDots

See starting MegaDots. 

LBF files

Linear Braille Format (LBF) is a set of rules for showing formatting information on a linear refreshable braille device, such as a Braille Note. Since linear braille devices cannot show indent and runover, explicit symbols are used to show format. For example, new paragraph is (ed)p, new line is (ed)l, heading level 2 is (ed)hble2. 

MegaDots can automatically generate LBF braille in two ways and achieve the same results. You can emboss to the braille output device LBF. Or you can export a file to file type "LBF linear braille format". 

leader dots

See guide dots. 

leading

See extra spaces between lines, characters. 

Left Flush [style]

Left Flush is an informal style designed to push text to the left margin. Type Alt-B L <Enter> to specify the Left Flush style. Use this style for the salutation of a letter as in "Dear Abby:." 

left margin

Setting a left margin increases the spacing from the left edge of the paper. To set the left margin in inkprint, type Control-Z I. We do not offer a left margin prompt for braille. Instead we offer a Shift Right prompt. Use this if you do not have any control over the left margin on your embosser. In particular, don't use the shift right setting for interpoint brailling; set the left margin on the interpoint brailler itself. To set shift right in MegaDots permanently for a braille device, press F10 P B and select that brailler to get to the Set up a brailler screen. In addition, when you press F7 to emboss, you have an opportunity to change shift right before pressing F10 to start embossing. See also shift right. 

letter

To prepare a letter (i.e. a piece of correspondence) in MegaDots, you may want to use the Letterhead style for the return address, date and the closing elements. Use the Left flush style for the salutation (the salutation is the Dear so-and-so line). These styles are available when you press Alt-B. You can also import a file and then press Alt-I and set "style selection" to "Letter". 

Do not use the Letterhead style unless the entire document you are creating is a letter. For example, if you are preparing a textbook that is displaying a letter on a page, do not use Letterhead (the use of the style damages the format of the rest of the textbook). 

letter sign

The letter sign is used to show that you have an isolated alphabet letter, and not a braille contraction. The MegaDots translator makes appropriate use of the letter sign. However, you may want to have manual control of the letter sign. To force or require a letter sign, type Control-R L. To suppress a letter sign, press Control-S L. For example if you have the sentence Take bus line B.; you want to require a letter sign for the B. 

lettered subparagraphs

In Britain, what North Americans call "outlines" are called "lettered subparagraphs". If you want to create lettered subparagraphs, use the Outline style. 

Letterhead [style]

The Letterhead style should be used for the address and date at the top of a letter. These elements are shifted right so that the longest line is flush right. If the closing (the "Sincerely Yours") is also in the Letterhead style, then it becomes even with the letterhead to the beginning of the letter. Do not use the Letterhead style unless the entire document you are creating is a letter. For example, if you are preparing a textbook that is displaying a letter on a page, do not use Letterhead (the use of the style damages the format of the rest of the textbook). 

Type Alt-B LET <Enter> to specify the Letterhead style. 

LEX.AUX file [Spell Checker]

The LEX.AUX file contains words you add to the spell checker. If you desire, you can modify this file with as ASCII editor, such as Notepad. You can mess up the spell checker if you foul up this file. Please make a backup copy before making any changes. 

ligature

See diacritics. 

light line

A light line is a secondary line used to separate parts of a table. It is shown in braille as a line of dropped c's. To enter a light line, press <Control-Insert> L L. 

Line [Insert Menu]

Typing Control-Insert L brings up a menu of special lines used as separators in braille documents. For example, you can pick the article separator, used to separate articles in a braille magazine. 

line [noun]

If you press Control-F without first defining a block, you get a list of ways of referring to text (word, line, sentence, paragraph, document). The word line refers to a line on the screen. 

line numbering for poetry

Poetry often has line numbers (usually on every fifth line). To show this in MegaDots, move the cursor to the first line and type Control-Insert L N. To specify numbering every fifth line, type 1+5. Type the digit 1, a plus sign, followed by the digit 5. It means this is line 1, number every fifth line. In the braille, the line numbers are placed on the right margin without the number sign. To stop line numbering at any point (usually at the end of the poem), type Control-Insert L N 0 <Enter>. To restart numbering at another point, just re-issue the Control-Insert L N 1+5 command. 

line numbering for prose

Prose sometimes has line numbers. To show this in MegaDots, move the cursor to the first line and type Control-Insert L N and then type 1+5 <Enter>. [Note: for North American, it does not matter if you enter 1+1 or 1+5; we recommend 1+5 so the file also works for British braille.] Move after the last line of prose to be numbered, and type Control-Insert L N and then type 0 <Enter>. If you begin line numbering right before a heading, then prose and headings are numbered; otherwise, only prose and not headings are numbered. 

Do the data entry in inkprint, not in braille. You must mark where the print lines end by typing space forward slash space right where the dividing point is. Do not put a slash at the end of a paragraph-MegaDots already counts that as the end of a line. If you enter the slash correctly, MegaDots displays the slash with green to make it stand out. If it isn't highlighted, this means either you don't have spaces around the slash, or you haven't used Control-Ins L N. 

In North American braille, MegaDots uses three blank cells to show separation of the print lines, or nothing if new print line begins exactly on a new braille line. MegaDots automatically determines how much of a right margin to use for the line numbers and puts them in the appropriate places. In addition, once you use numbering for something other than the Poetry and Play styles, MegaDots automatically follows Textbook code and number each and every print line, even if you asked for a different increment, such as five. MegaDots also makes sure two print lines don't begin on the same braille line; in this case, the beginning of the second print line is brought down to the next braille line. 

In British braille, MegaDots does not show the line changes in the text unless you put a double slash instead of the single slash for that line. This is because not all line changes are supposed to be shown, and it is to the discretion of the transcriber as to which are. If you are showing the divisions, you want to put a space double slash at the end of each print paragraph. MegaDots shows these in the braille, but not count these extra times as long as there is nothing after the double slash. In British braille, MegaDots automatically determines how much of a left margin to use for the line numbers and puts them in the appropriate places. MegaDots also breaks the lines appropriately, according to rule 33.4.2. It is considered the transcriber's job to put in the transcriber note mentioned in rule 33.4.3. 

Sometimes in British braille a transcriber may want to use prose line numbering where the braille lines are numbered instead of the print, as in rule 33.4.4. To do this, translate your document to braille, and when everything is perfect, highlight the area of prose to be numbered with Control-X and run the rules file EXAMNUMS.MDR. This automatically puts in a marker at the end of every braille line. You can re-run the rules file again later if the line breaks change. 

line of colons

A line of colons is a way of showing separation between a heading and text in British braille. See Chapter 19 for more information about British braille. Press Control-Ins L G for a line of colons (you need to use the BRITISH, AUSSIE or BRITUP style sheets). 

line of commas

A line of commas is a way of showing separation between a sub-heading (side heading) and text in British braille. A line of commas is less important than a line of colons. See Chapter 19 for more information about British braille. Press Control-Ins L M for a line of commas (you need to use the BRITISH, AUSSIE or BRITUP style sheets). 

line spacing

In the Document Menu, the braille section layout and the inkprint section layout each let you change the linespacing. To change inkprint line spacing, position the cursor to the appropriate point and then type Control-Z I. To change braille line spacing, position the cursor to the appropriate point and then type Control-Z B. Enter the appropriate number to the line spacing prompt. 

Braille double spacing is used for lower grade material. Remember, if you want the entire document double spaced to move to the top of the file before typing Control-Z B. See also physical underscoring. 

line through accent

To indicate a character with a line through it, press Alt-Hyphen. See also foreign text. 

linear braille format

Linear Braille Format (LBF) is a set of rules for showing formatting information on a linear refreshable braille device, such as a Braille Note. MegaDots can automatically generate LBF braille. Press F7 to print. Answer the printing device prompt with LBF. 

lines per page

In MegaDots, form length is measured in inches for inkprint, and in lines for braille. MegaDots allows you two places to set the form length: when defining a printer, or at the moment of printing. You can also set the bottom margin in the appropriate section layout screen in the Document Menu to change the effective form length. See also form length. 

lines, blank

Blank lines are an aspect of output format, which is controlled by the MegaDots style system. For example, if a paragraph of Body text is adjacent to a paragraph of List, then MegaDots puts a blank line between them. Getting the right pattern of blank lines is usually a matter of selecting the right styles. 

As a general rule, avoid creating a blank paragraph (i.e. two carriage returns in a row, so there is no text between them). See Chapter 4 for more information. 

List [style]

Things in list style start at the left margin, with runovers to the right of the margin. This is also called a hanging indent or outdent. Type Alt-B LI <Enter> for the list style in MegaDots. 

list (selection interface)

MegaDots uses several different systems for getting different kinds of information or selections from you, the user. We call these systems form, quick form, list, user list, and menu. The list selection interface lets you choose one item from a fixed list of choices. You cannot insert, delete, or rename items, as you can in a user list. Unlike a menu, a list may occupy more than one screen. For example, pressing Alt-A brings up the list of all styles, which takes several screens. When MegaDots presents you with a list, pressing F1 twice provides help on using the list selection interface. 

LITERARY [style sheet]

See Literary format. Use the style sheet selection option from the Document Menu to select a style sheet for the current document. Use the New Document Preferences to specify the style sheet for future documents. 

LIT-NLS [style sheet]

The LIT-NLS style sheet is just like literary format, except that it borrows the outline format and the poetry format from textbook braille. Many people prefer these formats and prefer them to the official rules for literary braille. Use the style sheet selection option from the Document Menu to select a style sheet for the current document. Use the New Document Preferences to specify the style sheet for future documents. 

Literary format

Literary format is simpler than Textbook format. Literary format does not call for print page indicators. Literary format uses a braille page number on the upper right hand corner of the braille page. Use only in North America. 

Load Preferences [Preferences Menu]

Load Preferences is a choice in the Preference Menu that allows you to switch to a different preferences file. You can have many preferences files if you choose. Different users or different kinds of projects may require different preferences files. See Preferences. 

locate file

To locate a file on a hard disk, use the WHERE program included with MegaDots. From MegaDots you can use the DOS shell (Alt-F10) to quickly get to the DOS command line. At that point, you can issue the WHERE command and other DOS commands. To locate all files that start with dog, type WHERE DOG*.* <Enter>. This process shows the complete file name with directory names of any files that match this description. When you are ready to go back into MegaDots, just type EXIT <Enter>. See also DOS Shell and DOS commands. WHERE is also described at the end of Chapter 19. 

locate text

Find and find/replace are in the Tools Menu. Press F9 from the Editor to specify which string you want to find. See Chapter 12 for more details on find and replace. You also can locate text by inkprint page indicators by pressing Alt-Z. 

Long lines wrap [editor preferences]

Setting Long lines wrap to on or off changes the screen display if your printer or embosser can print more characters per line than MegaDots can fit on each screen line. This issue comes up if you are using large print on the screen or refreshable braille access or if your inkprint printer can print more than 80 characters per line. When Long lines wrap is off, the text at the end of each line may be missing on the screen; pressing Home or End shows you the beginning part or the ending part of the line. Pressing Alt-L (a toggle) switches between Long lines wrap off and on. If Audio cues is set to Sounds, switching Long lines wrap on makes two beeps, and switching it off makes one beep. The Long lines wrap item in editor preferences changes the default setting, the setting when you first go into MegaDots. 

LOOKSS

LOOKSS is a program that lets you see the contents of the style sheet files. See Supplement 4 for more information. 

lost file

See locate file. 

low bit characters

Low bit characters is the term for the first 128 ASCII characters. Low bit characters include the control characters (non-printing characters which control format or devices), and the printable characters commonly found on the computer keyboard. 

lower (subscript)

Lower is the MegaDots word for subscript (we like to have a unique first letter for different attributes). To mark something as a subscript for inkprint, put it in a block and type Control-F L. Some inkprint printers cannot show subscripts, so you may not be able to see subscripts in inkprint. 

LOWER.MDR
This rules file is supplied with MegaDots to put all the text in lower case. To invoke it, just type Alt-F9 LOWER <Enter>. See also UPPER.MDR and rules file. 

LP-DOS

LP-DOS is a large print program that is not part of MegaDots. See Large print program. 

LPT1

LPT1 is the name the PC uses for the primary parallel port. A parallel port is a jack on the back of the PC which can send parallel data, usually to a printer. A parallel port is usually a female jack with 25 holes in two rows. See Embossit 3.0 and parallel port. 

MAC file

Files with the extension MAC are MegaDots macro files. See macro. 

Macintosh

Yes, MegaDots can run on a Macintosh using software such as Parallels (a $80 product). Once you install Parallels, install Windows 7 Home Edition (32 bit, not the 64 bit edition). See Chapter 2 for the details. 

macron

See diacritics for general guidelines. Note that when a macron is over a ligatured oo, use Alt-_ o Alt- o (macron o, ligature o). Or use the Alt-* to get these items. 

macro

A macro is a recorded sequence of keystrokes (text and/or commands) which can be executed in one stroke. For example you could create a macro to insert a new print page indicator and then execute three Page Down commands. For a full description of macros, see the help screen under macros in the Preferences Menu. 

Macros are individual files, with the MAC file extension. Press Alt-M to start recording a macro. You are asked for the macro name. Enter a name up to 8 characters. Record your macro and then press Alt-M again. You are asked to name a key combination (8 are available, from shift-F1 through shift-F8). You can change how macros are linked to keystrokes in the Macro Screen of the Preferences Menu. You can execute a macro by name by pressing shift-F10. You can edit a macro file if you want to. 

A macro can have a point in it where it waits for the users to press Enter or F10 before it continues. A macro file must be manually edited to use this feature. Insert a <wait-done> command in the appropriate spot to make this happen. 

The keys Control-Alt-A through Control-Alt-Z are available for macros. These keys always call the first macro that starts with that letter. If you want to be sure a certain macro is called each time you press a specific Control-Alt-letter combination, make sure the first letter of the name is that letter, and the second letter is a hyphen. For example, T-TRANS would always be called by Control-Alt-T. Otherwise, MegaDots picks the first macro starting with the name T, in alphabetical order. 

You can also run a macro from the DOS command line using the /K (forward slash K). If you want to exit the Editor with your macro, you need to manually add Alt-X <Enter> to the end of the macro file. 

magazine format

Magazine format refers to several of the special braille items found in braille magazines. Choose the LITERARY style sheet. To separate articles, use the article separator. Type Control-Insert L A for an article separator. You might also use the sidebar separator (Control-Insert L S) or a text break (Control-Insert L T) in a magazine. 

mailing list

To import a mailing list into MegaDots, add space, hyphen, list after the file name when you import the file. That preserves the blank lines in your list and marks all lines in the List style. 

main body pages [book section]

Main body pages are pages after the Preliminary pages of a braille volume. See Supplement 2 on braille basics for more information on how to tell what is preliminary pages and what is main body pages. It is important that you show the distinction between the preliminary pages and the main body pages. To specify the end of preliminary pages and the beginning of the main body of text, type Control-Insert B M M. As a rough guide, the table of contents is usually the last section of the preliminary pages, and the text after the table of contents is the Main Body pages (there are exceptions, especially in Textbook format). See also prelim.meg and preliminary pages. 

Major Head

A major head in braille is a heading which is centered and, in most cases, has blank lines above and below it. The exception is that there is no blank line above a major head at the top of a braille page or at the start of an inkprint page in Textbook format. When you first get MegaDots, the default heading set-up is for the Heading level 1 style to be formatted in braille as a major head. The Heading Set-Up Menu in the Document Menu lets you redefine how to format Heading level 1, Heading level 2, etc. in your current document; similarly, the Heading Set-Up Menu in the New Document Preferences Menu lets you change the default heading settings for all new documents. 

make clipboard columns [tools menu]

This option takes a list of items in the clipboard and creates columnar material from it. The software figures out how many rows and columns to use. Start by typing the text as one long list (i.e., an <Enter> at the end of each item). Block the list, and then use <F10 T M> for the Make clipboard column option from the Tools menu. Choose whether the items should be arranged in columns or rows. MegaDots figures out how many columns fit on the page and give you the choice of how many should be used. Press <Control-E> to go back to the Editor. 

make directory

See MD. 

make protect

If you mark a block with control-F M, that block is marked as "make protect". This block will not split between page boundaries. Be careful, this feature does not work unless the environmental variable RNIB_PAGE is set. 

manual

See documentation. 

Manual Note [style]

Use the Manual Note style when you have an entire paragraph giving some sort of explanation built into the text. Type Alt-N M <Enter> to specify the Manual Notes style. See also marginal note. 

Marathon [embosser]

The Marathon Brailler is a high-speed interpoint brailler made by Enabling Technologies. See the Interface Guide or press F10 H I from the Editor for directions on setting it up for use with MegaDots. 

margin

To set the margins in inkprint, type Control-Z I and make any changes you want to the settings for Left, Right, Top, or Bottom margin. Press F10 to return to the Editor. To set margins for the entire document, press Control-Z I at the beginning of the document. To change any of the margins within a document, press Control-Z I at the point where you want the settings to change. 

In braille, use carriage width to establish a right margin and form length to establish a bottom margin. To set carriage width and form length permanently for a braille device, press F10 P B and select that brailler to get to the Set up a brailler screen. In this screen you can also establish a left margin with the shift right setting or a top margin with the shift down setting. However, don't use the shift right setting for interpoint brailling; set the left margin on the interpoint brailler itself. In addition, when you press F7 to emboss, you have an opportunity to change carriage width, form length, or shift right before pressing F10 to start embossing. 

You can also change braille margins with Control-Z B. But this is not recommended, since the braille rules call for using the entire page. 

See also carriage width, form length, shift right, and shift down. 

marginal note

A marginal note is a footnote with no reference indicator. Textbook format uses the general reference indicator (two dropped g's) in braille when there is no reference indicator. Place the text in the most logical location. Use the Manual note style, starting off the paragraph with these three characters: open parenthesis, close parenthesis, space. In braille this becomes two dropped g's followed by a space. See also footnote. 

mark a block

A number of MegaDots commands can work on a section of text within your document which you mark as a block. MegaDots gives you two ways to specify a section of text as a marked block. You can press Control-X, and then move the cursor to a new location. Or you can click and drag the mouse. Press another Control-X to cancel the block. Performing a command on a marked block cancels the block marking. If you want a block to remain marked after performing a command on it, use Shift-Control-X to mark and hold a block. 

Mark and hold a block

This is like marking a block (see mark a block), except that the block remains marked after you perform a command on the block. Press Shift-Control-X to start or stop marking and holding a block. 

mark shape [Insert Menu]

Occasionally, inkprint has a special graphics such as a circle in the text. Type Control-Insert M followed by a key letter or letters to represent the shape. For each special symbol you use, create an entry in the Special Symbols page of your preliminary pages. 

marked print [File Menu]

Marked print is a feature that produces an inkprint output that includes MegaDots markup. It is designed to make life easier for braille transcribers who want to cross check their work against the original inkprint. Press Control-F7 to generate a marked printout. 

markup

Markup is the word for explicit characters which show format and translation information. If you would like to see markup, type Control-Z M F to show markup for format and changes in braille code. Type Control-Z A to show all markup, even special characters which help in braille translation. Type Control-Z M N to return to WYSIWYG. Alt-W switches between these two modes. See Supplement 5 for more information on MegaDots markup. If you want to manipulate MegaDots files outside of the MegaDots Editor, you can import and export files with MegaDots markup. See Chapter 7 and See Chapter 20 for details. 

Markup view mode [editor preferences]

Your Markup view mode preference determines the level of markup (see previous entry) that appears when you first enter MegaDots. As you work, you can change the level of markup quickly, as described in the previous entry. 

math file import

You can transfer math files from Duxbury DBT to MegaDots. MegaDots can import the DUxbury dxp files directly. Since Duxbury DBT can import MathType, Scientific Notebook, InftyReader, Latex files and other types of math files, this gives a good route to obtain this mathematical material into MegaDots. 

math translation

See Nemeth code. 

mathematics [translation mode]

A key part of the Nemeth translator is the ability to figure our what is literary and what is math context. In show markup, math segments show up in light blue letters, and literary segments show up as white letters. If you feel that the translator is not doing a good job in choosing between literary and math contexts, you can take manual control. Mark any text as a block. Issue the command Control-T M and that material is treated as math context. Use Control-T T for literary context. See also Nemeth code. 

MathType files

MathType files contain mathematics. Duxbury DBT can import MathType files. MegaDots can import those file from Duxbury DBT. See math file import. 

MBOS

See Embossit 3.0. 

MBOSS-1 [embosser]

The MBOSS-1 is an embosser which is no longer produced. See the Interface Guide or press F10 H I from the Editor for directions on setting it up for use with MegaDots. 

MBOSS-35 [embosser]

The MBOSS-35 is an embosser which is no longer produced. See the Interface Guide or press F10 H I from the Editor for directions on setting it up for use with MegaDots. 

MD [DOS command]

To change from on directory to another, use the DOS MD command. MD stands for Make Directory. From MegaDots you can use the DOS shell (Alt-F10) to quickly get to the DOS command line. At that point, you can issue the DOS MD command and other DOS commands. To make directory called JUNK, type MD \JUNK <Enter>. When you are ready to go back into MegaDots, just type EXIT <Enter>. See also Supplement 1. 

MDR file

Files with the extension MDR are MegaDots rules files. See rules file. 

MEG file

By convention, files with the extension MEG are MegaDots files. A MegaDots file can be read by MegaDots, but it cannot be read by any other software. To create a file which can be read by other programs, you need to export the file. See Chapter 20 for more information. 

MEGABANNER

If you set the environment variable MEGABANNER to your name at the DOS command line (such as SET MEGABANNER=CHARLIE BROWN <Enter>), then MegaDots produces a banner page labeling your braille printouts with your name, the file name, the time, and the date. See banner. 

MEGADIRS

This feature lets you specify the default directories from an environment variable. See default directory. This feature is very useful for those on a server network. See also network. The environment variable MEGADIRS can be set to a list of default directories, each one separated by a semicolon. The Default directories are: Working directory, Personal uses directory, MegaDots files directory, Word processor documents directory, SGML import directory, Auto save directory, Auto backup directory and Temporary files directory. There are some useful shortcuts as well. A double quote mark means use the same directory as the last one, a period means use the calling directory, and the letter w means the working directory. For example, you could have the following line in your AUTOEXEC.BAT file: SET MEGADIRS=C:\DAVID\MYWORK;";";";";.;.;. 

MegaDots

MegaDots is the name of the software you are now using. It is written and distributed by Duxbury Systems of Westford, Massachusetts. To learn more about Duxbury Systems, look at the web page at //www.duxburysystems.com. 

MegaDots 2.5 Documentation

See documentation. 

MegaDots better braille

MegaDots better braille is the name of the True Type screen font allows MegaDots to display a braille font when MegaDots cannot run in a full screen. This font does not use shadow dots. Also see MegaDots window braille. 

This font is only useful as a screen font for MegaDots. 

MegaDots icons

The installation program puts two icons on the desktop, MegaDots 2.5 without speech (intended for those with sight) and MegaDots 2.5 with speech (intended for those using JAWS or WindowEyes speech programs with MegaDots). 

MegaDots serial number

See serial number. 

MegaDots window braille

MegaDots window braille is the name of the True Type screen font allows MegaDots to display a braille font when MegaDots cannot run in a full screen. This font uses shadow dots. Also see MegaDots better braille. 

This font is only useful as a screen font for MegaDots. 

MegaMath

MegaMath is the name of the Nemeth translator for MegaDots. See Chapter 22 for more information. 

MegaPrn

MegaPrn is a program within MegaDots that lets MegaDots send inkprint data to a Windows device. When you use MegaPrn (connection port MPRN), MegaDots prompts you to select your Windows device. However, you can use the megaprn dialog to set one Windows device as the default for inkprint and another as the default for braille. See Chapter 5 and See Chapter 10 for the details. 

menu (selection interface)

MegaDots uses several different systems for getting different kinds of information or selections from you, the user. We call these systems menu, list, user list, form, and quick form. A MegaDots menu lets you choose further action. A menu always fits on one screen. Within a menu, an item marked with a greater than sign is a sub-menu, and an item marked with an ellipsis (three periods) is a form, quick form, or user list. When you are in a MegaDots menu, pressing F1 twice provides help on using the menu selection interface. 

Menu item [style]

Use the Menu item style for entries in a restaurant menu. Use this style for paragraphs which end in guide dots and a price. Type Alt-B M <Enter> for the Menu item style. To add the guide dots and the price, just type Control-Ins G followed by the price, followed by <Enter>, since the price is the last thing in the paragraph. 

menu, restaurant

To produce a restaurant menu, make use of the Menu item and Menu text styles. Use Menu item for paragraphs which end in guide dots and a price. Use Menu text for paragraphs which do not. You can use Headings, Body texts, and Lists when appropriate. 

After importing a restaurant menu, press Alt-I and set "style selection" to "restaurant menu". 

Menu text [style]

Use the Menu text style for descriptions in a restaurant menu. Use this style for paragraphs which do not end in a price. Type Alt-B M Down-Arrow <Enter> for the Menu text style. 

menus

MegaDots has a series of menus you can go to from the Editor. Press F10 to get to the top menu bar. This consists of File, Edit, Styles, Document, Tools, Preferences, and Help. You can use the arrow keys and return to select a menu item, or you can press the first letter. Each item in the top menu has a sub-menu. To learn more about any of these choices, press F1 for help. To get back to the MegaDots Editor, press Control-E. 

merge files

To merge two files, use the insert doc option from the File Menu (press Control-F3). This inserts a new file into the current document at the point of the current cursor position. 

Another way to merge two files is from the command line. If you type mega frog.meg dog.meg cat.meg /c <Enter>, the three files are be combined under the name of the first file name. 

Microbraille

Microbraille is a direct entry braille program. It stores its data using non-standard characters. MegaDots can directly read Microbraille files, which it treats as any other braille ready file. MegaDots cannot generate Microbraille files, but it can generate PokaDot files (Microbraille can read PokaDot files). See braille ready file for more information. 

microcon

This is a program operated on the DOS Command line. Type microcon [source file] [target file]. Microcon converts Microbraille files into standard braille ready files for other applications. 

Microsoft Word

MegaDots can import Microsoft Word files (2003, 2007, 2010) using the machinery of a modified Duxbury DBT built into MegaDots. See Chapter 7 for more information about file importation. Also see the entry for BANA Braille 2010 for information about Susan Christensen's Word Template. 

MegaDots can export to Microsoft Word files (2003, 2007, 2010) using the machinery of your copy of Word. See Chapter 20 for more information about file export. 

MegaDots can also export into Word files that have the styles marked as they are in the MS Word/BANA Template. You can do this to prepare files for Duxbury DBT. 

Minor Head [style]

A Minor Head in braille is formatted in braille with a blank line before but not after it and with all lines beginning in cell 5. The exception is that there is no blank line above a minor head at the top of a braille page or at the start of an inkprint page in Textbook format. When you first get MegaDots, the default heading set-up is for the Heading level 2 style to be formatted in braille as a minor head. The Heading Set-Up Menu in the Document Menu lets you redefine how to format Heading level 1, Heading level 2, etc. in your current document; similarly, the Heading Set-Up Menu in the New Document Preferences Menu lets you change the default heading settings for all new documents. 

missing file

See locate file. 

mixed numbers

To enter a mixed number, use a hyphen to separate the whole number from the fraction. For example, type 2-1/2 instead of 2 1/2. See also fraction. 

modes

We use the term mode for choices that determine how MegaDots operates. Modes include Markup view (WYSIWYG or Show markup), Braille view mode (five choices for viewing braille) on the screen, Insert/Overstrike, Long lines wrap (On or Off), Cursor go everywhere (On or Off), and Braille keyboard (On or Off). 

monochrome

Monochrome means single color. A monochrome screen does not show color. If MegaDots does not recognize that you have a monochrome screen, it may be difficult to read the screen. Type mega /m /f<Enter> to launch MegaDots in monochrome mode. On some systems, you need to add the line MODE BW80 to your AUTOEXEC.BAT file. 

moon type

Moon type is a non-braille tactile form of writing still used in Britain. At present, MegaDots does not produce moon type. At some point MegaDots may generate files used to produce moon type. 

moving text

To move text from one place to another, use the clipboard. See clipboard, copy, kut, and paste. 

MPRN

See MegaPrn. 

MS-DOS

See DOS. 

MS Word /BANA Template

BANA Braille 2010 is a Word Template created by Susan Christensen. The intention is to offer Duxbury DBT users some of the organized structure found in MegaDots to the DBT user. Natually, Team MegaDots is not standing still. Now MegaDots 2.5 can read Word files created with this Template. Documentation is provided in the file Bana_template.htm. 

MegaDots 2.5 can to export Word files that use the BANA 2010 Template. Export to the file type MS Word/BANA Template. These Word files can be loaded into DBT with full braille formatting information. MegaDots can create these files in either inkprint or braille. Importing a braille MS Word/BANA Template file into DBT requires DBT 11.1 SR3 or greater. 

multiple copy printing

To print from MegaDots, press F7. If you just want to print one copy of the current file using system defaults, press F10. If you want to, you can ask for multiple copies, and then press F10. 

multiple spaces

In general, multiple spaces are not used in braille. MegaDots automatically collapses multiple spaces in inkprint into a single space in braille. MegaDots does not collapse multiple spaces into single spaces for the styles Exercise, Direction, or for exact translation mode. 

To force multiple spaces in braille in other places, use the Control-B command (type a regular space followed by two Control-B blank characters; the regular space allows for normal line breaking). Three spaces are sometimes used to separate items to save space, such as with a vocabulary list. 

multiple spacing

See line spacing. 

music

At present, MegaDots does not support music braille. You can use exact translation to directly enter music braille is you desire. 

native MegaDots file [NimPro]

See nmg file. 

NEMETH [style sheet]

See Nemeth code. Use the style sheet selection option from the Document Menu to select a style sheet for the current document. Use the New Document Preferences to specify the style sheet for future documents. This selects the MegaMath Nemeth translator. If you have not purchased this option, you are allowed a limited number of trial uses. 

Nemeth code

The braille code for mathematics and science is called Nemeth Code. The MegaMath Nemeth translator is built into MegaDots 2.5. You can import math files from Duxbury DBT into MegaDots. 

An older Nemeth translator (Baby Nemeth) is also available for those who need to work with very simple items. To use the Baby Nemeth translator, choose the BABYNEM style sheet. See baby Nemeth for the details. 

network

The major problem with computer networks is access to printing and embossing resources. The best way to do this with MegaDots is with MegaPrn and Embossit. See Chapter 5 and See Chapter 10 for the details. 

MegaDots has several features designed to make MegaDots easier on networks. The Default directory screen of the Preferences Menu is designed to allow easier access to files on a network. Be aware that you can set these preferences before you launch MegaDots with the environment variable MEGADIRS. See MEGADIRS. The MEGABANNER feature is designed to help keep better track of embossing jobs on a network. 

New Document [Preference Menu]

Each time you create a new document in MegaDots, the program applies the defaults to many questions. Using the screens in the New Document Menu, you specify these defaults. For example, if you want to use Textbook format for your documents, set the defaults here. Each time you create a new document, it is set up in Textbook format. 

Don't forget to save your changes using the Save Preferences option, or else your settings are not retained. 

new file [File Menu]

To start a new (blank) document in MegaDots, press F2. To create a document containing the text of an existing file, press F3 to open or import a file. To switch to the next document, press F8. To switch to the last document, press Control-F8. 

new page

You can independently force a new inkprint page and/or a new braille page. To force a new braille page, type Control-Insert B F or Control-Insert B R. To force a new inkprint page, type Control-Insert I F. Sometimes you need to declare that you have a new type of page (start of title page, start of something other than a title page, start of table of contents, start of the main body pages). Type Control-Insert B and then choose the appropriate answer. See also force new page. 

next document

MegaDots allows you to load more than one document in memory at a time. To switch to the next document, press F8. To get a list of documents, type Control-J D. 

network devices

See Windows devices. 

NIMAS file

The NIMAS file format is designed to allow textbooks to be prepared in alternative formats (including braille). See Chapter 14 for the details. 

NimPro

NimPro is a program produced by Duxbury Systems. NimPro allows MegaDots and Duxbury DBT to read NIMAS files. Download NimPro from the Duxbury Systems website. See Chapter 14 for the details. 

nmg file

An nmg file is just like a MegaDots meg file. The only difference is that NimPro makes nmg files, and MegaDots makes meg files. If they are the same, why have a different file extension? There was concern that Nimpro produced .meg files might be confused by MegaDots produced .meg files. The default for NimPro is to produce .nmg files (nmg is short for native mega) which are read-only. You can change the defaults in NimPro to change the file extension (and you can also make the created files writeable). No matter what they are named, these file contents remains the same For example, if you save as an nmg file, then change the defaults, and save as an meg file, you get the exact same file. 

If you choose to save using the .nmg file extension, it is hard to avoid calling them "nutmeg" files. 

no translation

If you do not want braille contractions, choose grade one braille. If you do not want something modified at all by the act of translation, choose exact translation mode. Mark a block, and then type Control-T X. Ordinary text should not require no translation. Use no translation when faced with issues (such as dictionary diacritics) not covered in MegaDots. 

NOBREAK.MDR
This rules file is supplied with MegaDots to remove forced, or hard, page breaks. To invoke it, JUST type Alt-F9 NOBREAK <Enter>. See also rules file. 

NIMAS file

See Chapter 14 for the details. These are publisher files that can be read by the NimPro program and then exported into MegaDots. 

NONUMS [style sheet]

To suppress all braille page numbering, select the NONUMS style sheet. Use the style sheet selection option from the Document Menu to select a style sheet for the current document. Use the New Document Preferences to specify the style sheet for future documents. 

North American localization of MegaDots

MegaDots 2.5 can be localized in three different ways: North American, Australian and British. The North American version uses the LITERARY style sheet as the default. See also British localization of MegaDots. 

note

See footnote. 

Notepad

Notepad is a simple text editor built into Windows. 

note pages

See end notes. 

numbering lines

See line numbering for plays and line numbering for prose. 

numbering pages

MegaDots numbers braille pages automatically. To suppress page numbers, choose the NONUMS style sheet. Or you can stop a sequence of page numbers by specifying that the next page number is zero by typing Control-Insert B N 0 <Enter>. Type Control-Insert I N 0 <Enter> to suppress inkprint page numbers. To restore page numbers, repeat the sequence with a non-zero page number. 

If you need to arbitrarily increase the braille page number to leave room for graphics pages, type Control-Insert B G (see gap for graphics). 

To number pages in inkprint, create a running header or footer to number the pages. Type a line for the running header or footer. Type Control-Insert C to put the current page number on each page. To create a running head, write the text as a paragraph and then press Alt-R H <Enter>. Press Alt-R F <Enter> (running) footer. You may want to mark this paragraph as inkprint only if you do not want to affect the braille output. 

nutmeg file

See Chapter 14 (and nmg file). 

NVIDIA 6150 video card

MegaDots has many problems with the NVIDIA 6150 video card. This card does not support many of the video modes used by MegaDots. If you can, obtain another video card. See Chapter 21 for more information. 

ocicat

The other kind of MegaDots (use Google to see all the cute photos). 

OCR

OCR stands for Optical Character Recognition. See optical scanner. 

odd page only

See interpoint output. Select suppress even page numbers from the Braille Document Setup Screen in the Document Menu to number for odd pages only. This is often done for material printed on an interpoint embosser. MegaDots ignores this command (i.e. puts page numbers on all pages) when embossing to single-sided embossers. See also interpoint output. 

oe diphthong

See diphthong. 

Offset Table [style]

Offset Table is a method for preparing braille tables not approved by BANA. An offset table is similar to the basic table method, except that more than one braille line is used to show each inkprint line. For example, one braille line could have table columns 1 through 4, while the next could have table columns 5 through 7. Cell runovers are not allowed. See also compact tables. 

Ohtsuki [embosser]

The Ohtsuki Printer is an embosser made in Japan which lets you produce just braille, braille and print together, or just print. It is sold in the United States by American Thermoform Corporation. See the Interface Guide or press F10 H I from the Editor for directions on setting it up for use with MegaDots. 

Open Book

Open Book and An Open Book Unbound are reading machines for getting access to printed text made by Arkenstone. An Open Book is a stand-alone unit, and An Open Book Unbound is a similar system which runs on your existing computer. See Chapter 7 and see the Interface Guide or press F10 H I from the Editor for information on how to use them with MegaDots. 

open file [File Menu]

To open or load a file, choose F3. For more information about importing and exporting files, See Chapter 7 and See Chapter 20. 

optical character recognition

An optical character recognition (OCR) is a device or system which takes an image of a paper, and converts its contents into a useable file. See Chapter 16 for more information on issues related to using OCR with MegaDots. See the last section of the Interface Guide for more information on different brands of optical character recognition systems. 

We are aware that some OCR software titles create RTF files and call them Word files, sometimes even using the .doc file extension. You need to load and save these files using a copy of Word, and being very careful about the file type as you do a "Save As" from Microsoft Word. 

optical scan cleanup

When you import a file which has been optically scanned, you can ask MegaDots to fix format and text that have been damaged by the process of being scanned. To have this done whenever MegaDots thinks a file being imported was scanned, press F10 P F <Enter> and set "Optical scan cleanup" to "auto". Or you can request this be done after a file is imported by pressing Alt-I and giving the appropriate response to the "Optical scan cleanup" prompt. It can be a time consuming process. Press <Esc> if you want to cancel the cleanup during its operation. 

optical scan reconstruction [spell checker]

The MegaDots Spell Checker wants to know if your text was originally scanned. If you answer Y, then the software makes suggestions appropriate for words mangled by an optical scanner. If you answer N, then the software makes suggestions appropriate for typically misspelled words. 

optional hyphen

See hyphen, optional. 

orphan control

An orphan is the first line of a paragraph on the bottom of a page. Braille rules allow orphans, so there is no orphan control for braille in MegaDots. In inkprint, one usually tries to avoid orphans. You can turn orphan control on or off in the Inkprint Document Setup of the Document Menu. See also widow. 

OsCaR

OsCaR is a reading machine for getting access to printed text made by TeleSensory. See Chapter 7 and see the Interface Guide or press F10 H I from the Editor for information on how to use it with MegaDots. 

Outline [style]

An outline is a structured list with more than one level. If an outline is really large (so that it fills a book) then see huge outlines. Type Alt-B O <Enter> to specify the Outline style. Use the Alt-Left Arrow and Alt-Right Arrow keys to force an outline entry down or up one level of the hierarchy. 

One issue that keeps coming up is that outlines are harder to read in Literary format than in Textbook format. The official braille rules say that Textbook outlines are outdented; Literary outlines are indented. If you want Textbook style outlines in Literary format, use the LIT-NLS style sheet. 

output

See print. Press F7 to print a document. Press F10 to accept the parameters and start output. 

output file

See braille ready file. 

overdot

See diacritics. 

overstrike mode

Overstrike mode means that when you type in the Editor, the characters overstrike existing text. The alternative is insert mode. To switch between these modes, press the Insert key. If you are in insert mode, the characters <INS> show up in the upper right hand corner of the screen. If you are in overstrike mode, the upper right hand corner is blank. 

page [noun]

A page in this context means an output page. You need to be in WYSIWYG mode to see page breaks on the screen. You also need to be in WYSIWYG to use page commands like Control-J P (jump to page) or Control-W P (which page am I on?). To get into WYSIWYG, type Control-Z M N. 

page break

You can force a page break (force a new output page) independently in inkprint and braille. To force a new braille page, type Control-Insert B F. To force a new inkprint page, type Control-Insert I F. You can prevent a page break in a block of text marked as a protected zone in the Braille Section Layout Screen of the Document Menu. See also force new page and protected zone. 

page information line

The term for the top line in British braille. See Chapter 17 for more information about the page information line and British braille. 

page layouts

Page layouts are specialized pages with unusual formatting requirements (title pages, dedication pages), or special page numbering requirements (glossaries without inkprint page numbering, etc.). Page Layouts are part of the style sheets. To select a page layout, type Control-Insert B and then select from the menu. To create a new page layout, see Supplement 4. 

page numbering

For inkprint page indicators to be used in Textbook format braille, see inkprint page indicator. For numbering braille pages consecutively, see page numbers, braille. For numbering pages in an inkprint document, see page numbers, inkprint. 

Page numbering is the placement of numbers on the page. To change the page numbering, type Control-Insert B N for braille page numbering or Control-Insert I N for inkprint page numbering. If you want to suppress page numbering, use the same command, only type a zero for the page number. Later on, you can specify a non-zero number to resume page numbering if you want to. 

page numbers, braille

Braille page numbers refer to the page numbers on each braille page which number the braille pages consecutively. The placement of braille page numbers varies with the kind of material and is controlled in MegaDots by the style sheet. To get no page numbering in the entire document use the NONUMS style sheet. The LITERARY style sheet places braille page numbers in the upper right (omitting page 1). The TEXTBK97 and BRITUP style sheets places braille page numbers in the lower right. See Chapter 8 for more information and See Chapter 17 for information about British braille. 

To change the braille page number, type Control-Insert B N, and type the new page number. In the Show markup display, this creates a line saying <<Section Info>> Braille Page number: followed by the given page number. In WYSIWYG display, you see the new braille page number only when the document is in braille. 

To suppress braille page numbering in part of the document, type Control-Insert B N 0 <Enter> (to set the new braille page number to zero). To restart braille page numbering, use the Control-Insert B N command again. 

You can also suppress page numbers on even pages for interpoint brailling. See also suppress even page numbers and generic document. 

page numbers, inkprint

This entry discusses page numbers on the top or bottom of each inkprint page. These are not to be confused with the inkprint page indicators that show inkprint page transitions in a braille document (used in Textbook or British braille). For information on inkprint page indicators, see inkprint page indicators. 

The default in MegaDots is not to number pages in inkprint. If you do want your inkprint pages numbered, you need to issue a special formatting command that is part of a running header or footer. To get page numbering in inkprint, place the markup for the Current page number in a header or footer line. In MegaDots, you create a running header or running footer by creating a paragraph in the Running text style group. 

To get inkprint page numbering on the top of each page, create a paragraph in the Header style by pressing Alt-R H <Enter>. Type whatever text you want in the header line, press Control-Insert C, wherever you want the page number to go, and press <Enter> at the end of the line. If you want only the page number on the header line, with no text, do not type any text. In Show markup display, you see =pg# inside of arrows where the page number goes. To put inkprint page numbers on the bottom of each page, use the same procedure but press Alt-R F <enter> for the Footer style. 

To put the header or footer line in only the inkprint document and not the braille, mark it as inkprint only; mark the header or footer paragraph as a block and press Control-T I. You may mark one header line as inkprint only and a different one as braille only (Control-T B). 

The header and footer styles that come with MegaDots produce centering. If you don't want your inkprint page numbers centered, add your own styles. To make your own header style, use the Style Sheet Editor (see Supplement 4), and set the style group to Running Text and the hierarchy type to header. For your own footer style, set the hierarchy type to footer. 

PageMaker files

MegaDots can now read PageMaker files. See unknown file with text. 

paperless braille device

See refreshable braille device. 

paragraph [noun]

A paragraph in MegaDots is a series of characters with a carriage return (Enter key) on either end. By definition, pressing Enter starts a new MegaDots paragraph (even if it is very short). Each MegaDots paragraph has a single style. 

Pressing Alt-Enter forces a new line within one paragraph. If your Windows system does not allow you to use the Alt-Enter command, an alternative is Control-Ins L F. 

paragraph heading

A paragraph heading is an emphasized sentence or phrase at the start of a paragraph that labels a paragraph and is immediately followed by text on the same line. MegaDots does not treat paragraph headings as a heading which is part of the hierarchy of headings. In MegaDots, simply mark the emphasized portion of a body text paragraph as Italics. 

paragraph list

To scan through a list of paragraphs in your document, type Control-J G (jump paraGraph). Within the Control-J G display, you can change styles a perform other tasks. Press F1 from within the Control-J G display for the details. 

paragraph mark

To enter a paragraph mark in your document, press Alt-plus sign and select paragraph. This is the graphic symbol for paragraph used by proofreaders, looking like a backwards P with a double vertical stroke. You cannot use simple replace to search for this symbol. Use complex replace (Control-F9), search for and Alt-plus sign P inside of quotes. 

paragraph protect

Paragraph protect is one of the questions in the Style Sheet Editor. Paragraph protect keeps an entire paragraph on one output page. This is used for lines of poetry or lines of a computer program to make sure that they are not split between two pages. 

Paragraph table [style]

The paragraph table is no longer approved by BANA, but is still available in MegaDots. Each table row is reduced to a braille paragraph in 1-3. Each table item is separated by a semicolon, with a period after the last item in the row. 

parallel port

A parallel port is a jack on the back of the PC which can send parallel data, usually to a printer. A parallel port is usually a female jack with 25 holes in two rows. From the software end, the primary parallel port is designated LPT1 (LPT is an abbreviation for line printer, an IBM term for a printer). 

Parallels

see Macintosh. 

parenthesis emphasis

Parenthesis emphasis is one way of showing emphasis in braille. The word or words are enclosed in parenthesis. You can specify the different forms of inkprint emphasis to be produced in braille in parenthesis emphasis in the Translation Setup Screen in the Document Menu. If you have a braille document, and you want to change how emphasized material is shown in braille, first translate back to inkprint, then change the Translation Setup Screen, then translate back into braille. 

pass through command

Many times a command is shared between an applications program (such as MegaDots) and a screen access program. In these situations, the applications program does not see the keystroke. Each screen access program has a pass through command, which allows the next keystroke or combination to pass through to the applications program. For JFW it is Insert+3. Refer to your screen access documentation to learn the pass through command for your system. 

paste clipboard [Insert Menu]

To paste the clipboard at the current cursor position, press Control-P. [To copy a blocked area into the clipboard, use Control-C.] Obviously, you need to copy something into the clipboard before you can paste it from the clipboard. See also copy, kut, and clipboard. 

To paste an entire file into your current document, use the Insert Document command, Control-F3. 

path

The path (or standard path) is a list of directories DOS which directories to search through when a command is issued. 

MegaDots 2.5 installs into c:\mega25, and does not add to the standard path since the program authors figured the user would be launching MegaDots from the icon, not from the DOS Command line. 

If you want to launch MegaDots from the DOS command line, you need to add c:\mega25. If you have Windows 98, you changed the path by editing the autoexec.bat file in the root directory. Notice that the directories are separated by semi-colons in the path statement. See AUTOEXEC.BAT. See also Supplement 1. 

If you have Windows XP, 2000, Vista, or Windows 7, you need to use the Control Panel. Go into the Control Panel, and select System, Advanced, Environment Variables. One the System Variables (bottom half of the panel), select path, then click on edit. Add c:\mega25 to the end. 

pathname

A pathname is the name of a file complete with all the drive letters and the directory names. For example, c:\data\megadata\fish.meg is a pathname. See also locate file. 

Patterns Series

The Patterns Series is a sequence of teaching materials on grade two braille available from APH. The Beginner Braille feature for MegaDots contains templates for all of the lessons in the Patterns Series. See Beginner Braille. 

PDF files

MegaDots cannot import Acrobat PDF files. Numerous products can convert PDF files into Microsoft Word files. One example is the company ABBYY, which sells a product called "ABBYY PDF Transformer". Another example is the company 123 PDF Converter which sells a product called "PDF to Word". 

As long as you have a copy of Word that itself is capable of export to PDF, you can directly export to PDF files from MegaDots. See Chapter 20 for the details. 

Perkins keyboard entry [editor preferences]

The Perkins keyboard entry Editor Preference tells MegaDots when you want to use the standard full keyboard and when you want to use the six keys SDF JKL as a braille keyboard, like the keyboard on a Perkins Brailler. The choices are Always (to use braille keyboard at all times in MegaDots), Braille (to use braille keyboard only in the Editor when your document is currently in braille), Editor (to use braille keyboard whenever you are in the Editor, whether your document is currently in inkprint or braille), and None (to use the full keyboard all the time in MegaDots). The default setting is None. The Braille setting turns on the braille keyboard in an inkprint document is the cursor is on material marked as exact translation. This includes editing a paragraph in the Exact translation style. See also Exact translation style. 

No matter how you set this preference, you can toggle between braille keyboard and full keyboard at any time by pressing Alt-scroll lock. If the Audio cues preference is set to Sounds, pressing Alt-scroll lock makes two beeps when it turns braille keyboard on or one beep when it turns braille keyboard off; if Audio cues if set to Combo or Messages, pressing Alt-scroll lock gives a message of braille keyboard on or off. 

If you have a top menu bar (i.e., if the Unframed text preference is set to No), then the symbol <6> shows in the upper right whenever your current keyboard is the 6-key braille keyboard. If there is any problem with turning braille keyboard on or using it, bring up the Perkins keyboard entry help screen by pressing F10 P E F1 from the Editor. This help screen can assist you with hardware and software problems. 

You can use MegaDots' braille keyboard outside of MegaDots (see BKEYS and Chapter 19). 

Personal Brailler

The Personal Brailler is an embosser which was made by Enabling Technologies but is no longer produced. See the Interface Guide or press F10 H I from the Editor for directions on setting it up for use with MegaDots. 

Peseta sign

To enter a Spanish Peseta sign in your document, press Alt-dollar sign and select Peseta. You cannot use simple replace to search for this symbol. Use complex replace (Control-F9), search for and Alt-dollar sign P inside of quotes. 

phonetics and phonemics

Phonetics and phonemics are not supported by MegaDots. Use exact translation and enter the braille directly for these difficult segments. See the Textbook Format Codebook for more information. See also diacritics (which are supported by MegaDots). 

physical underscoring

Physical underscoring is a form of emphasis in braille in which a line of dots 1-4's (the letter c) is placed underneath the emphasized material on a line reserved for this emphasis. Generally, physical underscoring is used for the lower grade levels as an alternative to braille italics. 

pictures as items in exercises

When items in an exercise are shown as pictures, or as pictures with text, insert the transcriber's note symbol (6, 3) before the word Pictures. Place the closing transcriber's note symbol after the last entry." In MegaDots use Require dot 6 (Control-R D) followed by apostrophe for both the opening transcriber's note symbol and the closing transcriber's note symbol. If you are using the Nemeth style sheet, you can use the item called Transcriber's grouping mark instead. 

PIL

PIL stands for page information line, the top line in British braille. See Chapter 17 for more information about the page information line and British braille. 

pitch (inkprint spacing)

Pitch is the number of characters per inch. A pitch of 10 is called pica, a pitch of 12 is called elite, and a pitch of 17 is called compressed. You can set the pitch of a section by typing Control-F F and then picking a typeface family. 

plate embossers

Plate Embossers are large, expensive machines used by braille presses to produce metal plates for braille printing. See the Interface Guide or press F10 H I from the Editor for configuring MegaDots with a plate embosser. 

plays

To do plays in MegaDots, use the selection of styles in the Alt-P Plays and Poems group. A prose play is a normal play, a verse play is a play in the form of poetry, such as the works of Shakespeare. See Prose Play and Verse Play. 

plus H (+H)

The +H (plus sign H) in the list of embossers means with high resolution graphics. 

Poetry [style]

To do poems in MegaDots, use the selection of styles in the Alt-P Plays and Poems group. Use the Alt-Right Arrow key to force a line of poetry down one level of the hierarchy if it is indented in the inkprint. MegaDots automatically adjusts the indent and runovers depending on how many levels of indentation there are. Please note: Literary format braille does not show levels of indentation, so you need to use Textbook format if you want to see levels of indentation in the braille. Use the New stanza style for the first line of a poem to put in a blank line between stanzas. 

poetry line numbers

See line numbering for poetry. 

PokaDot

PokaDot is a direct braille entry program which is available from the National Braille Association. MegaDots can directly read PokaDot files (though imperfectly). MegaDots can also create output files which can be read by PokaDot. See Chapter 7 for the details. 

port

A port is a jack in the back of the computer for data transmission. There are serial, parallel and USB ports. Parallel ports are female 25 pin jacks. Serial ports are male and are usually 9 pins (very old computers used 25 pins). 

Portuguese

All Portuguese documents in the United States are produced in grade one braille. Portuguese uses a different accented e than other languages, so you need to tell MegaDots that the document is in Portuguese. Go to the Translation setup screen in the Document Menu. Set the Braille Standard prompt to P for Portuguese, and set the Default Translation Method to O for One. A shortcut is to load the document with a slash top (for Translation grade One for Portuguese). For example, you can type mega sec1.txt /top <Enter> to force Portuguese translation. 

If you want to mix grade two English with grade one Portuguese, just set the Braille Standard prompt for Portuguese, leave the Default Translation Method at T for Two, and mark any text you want in Portuguese as grade one (mark a block any type Control-T O). 

As an alternative, you can set the Braille Standard prompt for Portuguese, set the Default Translation Method at O for One, and mark any text you want in English as grade two (mark a block any type Control-T T). In either system, English is grade two and Portuguese is grade one. It is just a matter of deciding whether you want to be marking English or Portuguese segments. 

You can enter all the accent marks within MegaDots. See accented letters and foreign text. 

Be aware that the Spell Checker is MegaDots is only good for English. This makes spell checking material containing Portuguese a problem. You may find proofreading without the Spell Checker more efficient. 

In North America, the dot 6 is used for the capital sign. This is the default for MegaDots. If you are preparing materials for use in Portugal, then you need to use dots 4-6 for the capital sign. To do this, change the European caps sign dots 4-6 prompt in the Translation Setup screen in the Document Menu. 

Postscript files

MegaDots can export Postscript files, but cannot read them. To export to Postscript, press Control-F4, give the file name, and select the file type Postscript. 

pound sign, British

See British pound sign. 

pre-output rules file

A pre-output rules file is a global replace rules file that is executed on the material being printed or brailled without changing your original data. If you wanted to print a document containing a series of codes, you could have the codes expanded at the point of printing or brailling. This feature could also be used to remove emphasis before printing. 

preface [book section]

A preface is part of the preliminary pages in literary format and in British braille. A preface is part of the main body pages in textbook format. See Preliminary pages. To start a preface as a preliminary page, type Control-Insert B P and pick preface from the list. This starts the material on a fresh braille page. 

preferences

Preferences are the list of choices of how you use MegaDots, the kinds of documents you create, and the equipment you work with. Preferences are saved in a file so MegaDots can be customized to meet your needs. Different preferences can be loaded from the command line (See Chapter 19) or from the Preferences Menu. 

Preferences File

Your entire collection of preferences can be stored in a file, called a Preferences File. The default name for a preferences file is ENVIRON.ENV. When you launch MegaDots, and if you do not specify a preferences file with the slash e command, the default preferences file is loaded. You can also specify a preference file when you start up MegaDots. For example, typing mega /edh <Enter> uses the DH.ENV <Enter> preferences file. 

Preferences Menu

Type F10 P to get to the Preferences Menu. The Preferences Menu lets you specify your preferences, and then lets you save them in a file. See also preferences file. You can switch preferences in the Preferences Menu (load preferences). You can change the behavior of the Editor, you can specify inkprint or braille devices used with MegaDots. Your choice of devices can affect the layout of documents on the screen. 

prelim.meg-B
The file prelim-b.meg in your MegaDots directory is a sample MegaDots file which shows how to create preliminary pages in a braille volume for British braille. 

prelim-n.meg
The file prelim-n.meg in your MegaDots directory is a sample MegaDots file which shows how to create preliminary pages in a braille volume for North American braille. 

preliminary pages

Preliminary pages are pages at the beginning of a braille volume containing the title page, some special pages, and the table of contents. See Supplement 2 on braille basics for more information on how to tell what is preliminary pages and what is main body pages. To specify different kinds of braille pages, type Control-Insert B P and select from the list. To specify the end of preliminary pages and the beginning of the main body of text, type Control-Insert B M M. As a rough guide, the table of contents is usually the last section of the preliminary pages, and the text after the table of contents is the Main Body pages (there are exceptions, especially in Textbook format). See also prelim.meg and main body pages. 

Print Document [File Menu]

To output a document to a printer or a brailler, press F7. Choose the appropriate parameters and then press F10. 

In MegaDots, documents are either inkprint or braille. Press F5 to switch between braille and inkprint. The bottom left of the screen is either I for inkprint or B for braille. 

print page indicator

In Textbook format braille, each page of braille has an indicator showing which inkprint page it is from. This is usually on the upper right hand corner of the page. The transition point of a new inkprint page is shown in braille as a line of dashes ending in the new print page number. The line of dashes is not used if the new print page starts at the top of a new braille page. 

To produce print page indicators, you need to use the Textbook style sheet. Use the Select Style Sheet Screen in the Document Menu. In the document itself, you need to show where each new print page begins. Move the cursor to the first character on the new inkprint page. Type Control-Enter to indicator the change of inkprint page. 

If a new print page starts where you are specifying a new running head, always position the cursor on the first character after the running head to place the inkprint page indicator. 

Use the tilde character to specify a range of inkprint pages (such as when you have some blank inkprint pages). Enter 102~105 if pages 102-104 are blank. 

printer

See inkprint printer or braille embosser. 

proofreading bar [editor preferences]

When you press Control-Z P, MegaDots toggles on and off a proofreading bar. The proofreading bar highlights the line containing the cursor. By drawing attention to just one line on the screen, it makes it easier to visually proofread your text. The proofreading bar works in inkprint or in braille, in WYSIWYG or show markup. 

proper noun

Proper nouns are brailled slightly differently than other words. The MegaDots translator does a good job on a large number of proper nouns. 

proportional print

Proportional print places varying widths of characters on an inkprint page, so that a w takes up more room than an i. MegaDots supports proportional print output, as long as you select a proportional font. 

prose line numbering

See line numbering for prose. 

Prose note [style]

Use prose note for a note after a minor heading, exercise, or directions. It formats as an indent to cell 7, runover to cell 5. 

Prose Play [style]

A prose play is a play not in verse. Type Alt-P P to specify the Prose Play style. 

Prose Stage [style]

A prose play is a play not in verse. Stage refers to Stage directions. Type Alt-P P Down Arrow to specify the Prose Stage style. 

protected zone

A protected zone is an area not breakable by a page division. If necessary, MegaDots leaves blank a significant portion of the page prior to the protected zone to avoid breaking the protect zone. 

There are three ways of creating a protected zone. Some styles have the protected zone built-in. Exam questions stay together in the EXAM style sheet. Poetry lines stay together. 

The second way is to move the cursor to the start of a paragraph you want to protect any type Control-Z B (5 right arrows) Y F10. Move to the end of the last paragraph to protect and give the same command, only answering "N" to the prompt. This system keeps entire paragraphs together. 

The third way is to make a block and type Control-F M. You can protect a portion of a paragraph with this command. 

Punctuation, unusual

To select some of the unusual punctuation available on the PC (degree sign, upside down question mark, etc.), press Alt-plus sign. For currency symbols, press Alt-dollar sign. 

Quark files

Quark or Quark Express is desktop publishing software. Quark files cannot be loaded into MegaDots. Your best bet is to load the Quark files inside Quark software and export to marked up ASCII. The problem is that usually you get a large number of separate files. The trick is to load these into MegaDots in the correct order. 

question mark, upside down

To enter an upside down question mark in your document, press Alt-plus sign and select question mark. See also Spanish. You cannot use simple replace to search for this symbol. Use complex replace (Control-F9), search for and Alt-plus sign Q inside of quotes. 

questions

See exercise and directions. 

quick form (information interface)

MegaDots uses several different systems for getting different kinds of information or selections from you, the user. We call these systems form, quick form, list, user list, and menu. When MegaDots needs just one piece of information from you, it puts you in a quick form. When you are in a quick form, pressing F1 twice gives help on using quick forms. 

Quick Mark

Quick Mark is an bookmark that is quick to insert and quick to jump to. To set the Quick Mark, press Alt-J space. To jump to the Quick Mark, press Alt-J Alt-J. See bookmark. 

Quick Mode

The Quick Mode Uses MegaDots from the Command Line to import, translate, and output a file without any human intervention. For example, typing mega fish.doc /b /q <Enter> translates and outputs the file fish.doc to your default braille device. See Chapter 19 for more information. 

QuickTac

QuickTac is a brailler graphics program produced by Duxbury Systems. You can download a copy from the Duxbury Systems website. See brailler graphics for more details. 

quit MegaDots

To quit MegaDots, press Alt-X. You may be asked to save your most recent changes. 

Quotation [style]

Use for a quotation set apart as a separate paragraph (or group of paragraphs). Specify the Quotation style by typing Alt-B Q <Enter>. 

quote

See also single quote. 

When print uses a quotation mark to indicate inches, press Control-R S, quotation mark in MegaDots. The markup on the print side shows Require special symbol followed by quotation mark. This becomes dots 4, 35 in braille. 

When print uses a quotation mark to indicate seconds of arc, press Control-R S Control-R S followed by quote in MegaDots. The markup on the print side shows Require special symbol, Require special symbol, quotation mark. This becomes the letters sec in braille, preceded by a letter indicator where needed. 

raise (superscript)

Raise is the MegaDots word for superscript (we like to have a unique first letter for different attributes). To mark something as a superscript in inkprint, put it in a block and type Control-F R. Some inkprint printers cannot show superscripts, so you may not be able to see superscripts in inkprint. 

Raised Dot Computing

The old company that developed MegaDots. Raised Dot Computing was purchased by Braille Planet, a non-profit corporation in 1998. In 1999, Braille Planet was purchased by Duxbury Systems. Duxbury now supports, produces, and distributes MegaDots. The best source for current information on MegaDots is //www.duxburysystems.com. 

RD [DOS command]

To remove an empty directory, use the DOS RD command. RD stands for Remove Directory. From MegaDots you can use the DOS shell (Alt-F10) to quickly get to the DOS command line. At that point, you can issue the DOS RD command and other DOS commands. To remove the JUNK directory, type RD \JUNK <Enter>. When you are ready to go back into MegaDots, just type EXIT <Enter>. See also Supplement 1. 

re-import a document

See interpret format. 

Reading Advantage

The Reading Advantage, made by Xerox/Kurzweil, is a reading system for providing access to printed material that runs on your existing computer. See Chapter 7 and see the Interface Guide or press F10 H I from the Editor for information on how to use it with MegaDots. 

Reading Edge

The Reading Edge made by Xerox/Kurzweil, is a stand-alone reading system for providing access to printed material. See Chapter 7 and see the Interface Guide or press F10 H I from the Editor for information on how to use them with MegaDots. 

recognition, file

See automatic file recognition. 

reference indicator

See footnote. 

Reference Manual

To access the Reference Manual from within MegaDots, just press F12 from wherever you are in MegaDots. Or you can press F10 H R. You can browse through this list with the up and down arrow and PageUp and PageDown keys or move to a specific topic by typing the first few characters. Once you find the topic you want, press <Enter> to read the Reference Manual text on this topic. Blind readers can read line by line with the down arrow key or with the Continuous read command for their screen reading program. Press F7 to print the entry to your choice of device. Control-V voices the entire entry to your voice device. Control-C copies the text into the clipboard. See also documentation. 

refreshable braille device

A refreshable braille device is a machine like the Braille Note that uses computer-controlled metal pins to show braille on a display. To date, refreshable braille devices have only one or two lines of cells and cannot display conventional paper braille format. Because of this restriction, these devices are sometimes called linear braille devices. The Linear Braille Format system was invented to show format on linear refreshable braille devices. See Linear Braille Format. The easiest way to set up your MegaDots preferences for a refreshable braille device is to start MegaDots by typing MEGA /ar /f <Enter>. 

registered trademark symbol

To enter the registered trademark symbol directly in MegaDots, type Alt-period r (Alt-period followed by the letter r). When the cursor is on this character, the status bar says "r overdot". MegaDots does generate the correct braille for this symbol (in BANA, this is dots 4-5 followed by the letter r). 

registry

See Windows registry. 

Related cols [style]

For columned material with no row headings, but where there is a relationship between adjacent items on the same line, use Related cols. 

For tables with row headings, use Basic table. See Basic table. 

For columned material where items on the same row aren't necessarily related, use Unrelated cols. See Unrelated cols. 

remote desktop

You can run MegaDots through remote desktop. When you install MegaDots, make sure you answer "no" to the question about using the full screen in MS-DOS. See Chapter 2 for the details. 

remove directory

See RD. 

rename file [DOS command]

There are two ways to delete a file. You can do it from inside MegaDots. By pressing F3 F2, highlighting the filename, and then pressing F3. 

Or you can issue the DOS REN command yourself. From MegaDots you can use the DOS shell (Alt-F10) to quickly get to the DOS command line. At that point, you can issue the DOS REN command and other DOS commands. To rename a file, type REN oldname newname <Enter>. When you are ready to go back into MegaDots, just type EXIT <Enter>. See also Supplement 1. 

repeat heading

MegaDots automatically repeats headings on continuing pages when the heading is marked appropriately. This may be done with both Major (centered) and Minor (cell-5) headings. If you press <Control-Insert R> while your cursor is on the heading, MegaDots repeats the heading on the next line, in green. The status line also tells you that it is a repeated heading. If <Control-Insert R> is pressed when the cursor is in another style, MegaDots places the repeated heading on the last heading before the cursor (in other words, if you are several paragraphs into your text and you remember you need to repeat the heading, you don't need to return to the heading to set the repeat). You can also create a repeated heading by using the style Repeat heading <Control-R R>. The heading are repeated with (cont.) on all continuing braille pages until it is turned off. This is done by using <Control-Insert R> or <Alt-R R> on a blank line. 

NOTE: You cannot use a Repeat heading in a table when Table header or Table footer is used. 

replace characters

Find and find/replace are in the Tools Menu. Press F9 from the Editor to specify what text you want to find. Press Control-F9 for complex find/replace for more options. See Chapter 12 for more details on find/replace. 

require contraction

To require (force) a contraction in MegaDots, position the cursor at the appropriate point and type Control-R C. For example, if the word "morning" appears in print the just the "ing" on a new inkprint page, and you are in Textbook format, MegaDots does not use the ing sign. To force the ing sign, put the cursor at the i, and type Control-R C. See translation error. 

requires [Edit Menu]

Pressing Control-R brings up the requires menu. You can require a contraction, a dot six capitalization indicator, a letter sign, or a special symbol. For example, you can require the MegaDots translator to use a letter sign in a situation where it erroneously omits it. For example "James was on the A bus" requires a letter sign. 

resource lists

The Duxbury Systems web site //www.duxburysystems.com has a large, well organized list of resource organizations and companies. Click on "links". 

restart printouts

If you need to restart a printout (i.e. if the output jams after a certain point), press F7 for print. Specify the starting page number at the "From page:" prompt. 

restaurant menus

See menu, restaurant. 

Retain blank lines [file type]

See braille ready file on how to use this option. 

reveal codes

Reveal codes in the term used in WordPerfect to describe a screen that shows the internal codes in the program. MegaDots uses the term show markup. Unlike WordPerfect, MegaDots does not show a split screen. Use Alt-W to switch between show markup and WYSIWYG in MegaDots. 

reverse CBC

Reverse CBC is an option for brailling computer notation in a document where the letters are mostly uppercase. In reverse CBC uppercase letters are unmarked, and the capitalization and caps lock indicators are used to mark small letters (the opposite of normal CBC). To call for reverse CBC translation in a MegaDots document, press F10 D T F9 C <Enter> R F10. This changes the CBC letter translation setting to Reverse. If you want reverse CBC in most of your documents with CBC, set the corresponding preference under Preferences, New Document, Translation. See also CBC. 

Revise Dictionary [spell checker]

To add the highlighted word into the spell checker dictionary, type R A (for revise accept). 

revision date

To find the version number and release date of your MegaDots software, press F10 H A (to get the About MegaDots screen from the Help Menu). 

REVQUOTE.MDR
This is a rules file supplied with MegaDots which reverses single quotes and double quotes. This rule is of use in Britain, where it is important to use double quotes as the outer quotes, and single quotes and inner quotes. To invoke, just type Alt-F9 REVQUOTE <Enter>. See also Chapter 17. 

Right flush [style]

Right flush is an informal style designed to push text to the right margin. Type Alt-B R to specify the Right Flush style. 

right hand page

In interpoint braille, right hand page means a page on the front side of a sheet. When braille page numbering starts with an odd number, as is customary, this also means a page with an odd number. To force an interpoint embosser to move to the top of a right hand page, leaving a blank left hand page if necessary, press Control-Insert B R. You might do this, for example, at the start of a chapter. When MegaDots prints to a single-sided embosser, this command is the same as the ordinary "force a fresh braille page" command. Thus the file prints appropriately on either single-sided or interpoint embossers. See also generic document. 

If the use of this command forces a blank page in interpoint output, then the page is totally blank, without any page numbers. The braille page number is implied, so that the next "front" page is odd. There is no effect on the inkprint page indicator, if one is being used. 

right margin

Setting a right margin decreases the characters printed on each line. To set the right margin in inkprint, type Control-Z I. To set the right margin in braille, type Control-Z B. In general, you should not set a right margin for braille, since conventionally you want to produce the maximum characters per line (without getting too close to the page edge). 

Right unstyled [style]

Right unstyled pushes your paragraph to the right margin without any blank lines before or after it. This style is designed to work with the other members of the unstyled group. 

RNIB_PAGE

The environmental variable that allows "make protect" to work. See make protect. 

Roman numeral

MegaDots follows all the rules for Roman numerals in the text. The appropriate use is made of the letter sign and the capital sign. 

Romeo [embosser]

The Romeo is a brailler made by Enabling Technologies. See the Interface Guide or press F10 H I from the Editor for directions on setting it up for use with MegaDots. The Romeo Pro 50 has 2 different options in the MegaDots list of embossers: regular graphics vs. high resolution graphics. The +H (plus sign H) means with high resolution graphics. 

root directory

Most hard disks have an elaborate directory structure, with many subdirectories branching off of the root directory. One mistake that many beginning computer users make is to place many data files in their root directory. It pays to know how the directories are set up in your computer. See also directory. 

round trip

A round trip is a term we use to describe taking inkprint and translating twice (into braille and then back into inkprint). Part of the design of MegaDots has been to insure that all inkprint is properly reconstructed after a round trip. Press Alt-F5 to verify that your file can go through a round trip. 

RTF file

RTF files are a common format for converying text and format from one file to another. MegaDots 2.5 cannot directly read RTF files (yes, earlier editions of MegaDots could do this). The best solution is to load the file into Word, and save as a Word file. 

We are aware that numerous OCR software titles create RTF files and call them Word files, sometimes even using the DOC file extension. You need to load and save these files using a copy of Word, and being very about the file type. 

MegaDots can use Word automation to export to RTF files. See chapter 20 for the details. 

rules file

A rules file contains a list of instructions for the find/replace system, called rules. Using the rules file performs all of the rules on your document or on a block if one is marked. Rules files must have the extension MDR to work, and they must be located in the MegaDots directory or in your current directory. In MegaDots, a rules file can be very simple or sophisticated with almost programming-like features. See Chapter 12 for more information about rules files. You execute a rules file by pressing Alt-F9; then type the filename without the .mdr extension. 

Several rules files are supplied with MegaDots for your use. You can also inspect them as models for your own rules files. They include CHARS.MDR (counts characters); WORDS.MDR (counts words); LOWER.MDR (puts the document in lower case); UPPER.MDR (puts the document in upper case); FIXCAPS.MDR (puts in appropriate upper case in a file that is all lower case); REVCAPS.MDR (reverses capitalization); REVQUOTES.MDR (reverses single and double quotes); NOBREAK.MDR (eliminates forced page breaks); NOTABS.MDR (removes tabs); MENU.MDR (useful for assigning styles in a menu after importing from another document format); OUTLINE.MDR (useful for assigning styles and hierarchy levels in an outline); FIXNOTE.MDR (works around a problem with footnotes that can cause MegaDots to freeze); FIXIT.MDR (fixes a number of problems); FIXFOREN.MDR (fixes a problem that can cause MegaDots to freeze). 

You can set up to run a rules file upon translation, upon inkprint printing or upon braille output. See finetune braille rules file and pre-output rules file. 

run MegaDots

See starting MegaDots. 

run spell checker

See spell checker. 

running footer

See footer. 

running header

See header. 

runover

The runover is the margin position of a paragraph other than the first line. The position of the first line is called the indent. The runover of a paragraph is controlled in the style. For more information, see Supplement 2. 

runover increment

The runover increment is the amount of additional runover that occurs for each additional level in the hierarchy. For more information, see Supplement 4. 

salutation

To do a salutation of a letter, such as "Dear Ann Landers:" in MegaDots, use the Left Flush style. 

save file [File Menu]

To save a MegaDots document, press F4. We recommend that the file end with .meg extension for MegaDots data files. See also auto save. 

save position

See bookmark. 

Save Preferences [Preferences Menu]

The save preferences option allows you to save your preferences in a file with a .ENV extension. The default file is a file called ENVIRON.ENV. Almost all the time you want to save your preferences in the default file. The only exception would be when you really needed multiple preferences on your system (for example, if you had one blind user and one sighted user on the same computer). 

You can switch preference files by using the load preferences option. You can also use the /e switch when you start MegaDots to specify which preferences file for your session. See also preferences file. 

scanned text

See optical character recognition. 

science

See Nemeth Code. 

Scientific Notebook files

Scientific Notebook files contain mathematics. Duxbury DBT can import Scientific Notebook files. MegaDots can import those file from Duxbury DBT. See math file import. 

screen access program

A screen access program hides in memory to assist a blind person to use the computer. See refreshable braille, large print program, and voice access for more information. See Chapter 13 for more detailed information. 

screen modes

When MegaDots was first written, almost all monitors used EGA/VGA graphics. Many of the screen modes were written for these modes. If you cannot operate MegaDots in full screen mode, then you cannot use some of these screen modes. See screen modes (for full screen) and screen modes (non-full screen). 

screen modes (for full screen)

MegaDots allows a wide variety of screen modes for inkprint or braille. To change the inkprint modes, type Control-Z A. The Access Menu appears. The choices that affect the character size are Small, Normal, Tall, Wide, and Large. The Large size combines Tall and Wide. There are 5 different screen modes for braille. Type Control-Z D to see the list of choices. You can set the default screen mode in the Editor Preferences Screen. 

There are several choices in the Editor Preferences Screen which control how the screen looks in MegaDots. The Transcriber View feature in the Advanced Features Screen of the Preferences Menu makes the inkprint format just like the braille. Do not forget to save your preferences. 

screen modes (for non-full screen)

Just about all of the screen modes for full screen are not possible without the full screen. MegaDots includes 2 screen fonts to allow seeing braille dots on the screen. See braille dots on the screen (non-full screen) and also See Chapter 2. 

There are several choices in the Editor Preferences Screen which control how the screen looks in MegaDots. The Transcriber View feature in the Advanced Features Screen of the Preferences Menu makes the inkprint format just like the braille. Do not forget to save your preferences. 

screen review program

See screen access program. 

scripture

See bible verse. 

search

Press F9 from the Editor to find text in MegaDots. See entry search for words for information about issues of uppercase/lowercase. If you want more options in your search, press Control-F9 for complex find. If you want to use an existing rules file, press Alt-F9. See Chapter 12 and the following entries in this Reference Manual for more information about search and complex search. 

Once you have located something, you can press Control-G for global replace, Control-Y to make just one replacement, and Control-N to go to the next occurrence without making a change. 

search and replace

If you want to replace all instances of the word "cat" with the word dog", enter the following: F9 cat <Enter> Control-G dog <Enter>. Once you perform a search and find one instance, pressing Control-G gives you an opportunity to perform a replacement in all instances. 

search for accented letters

See search for special characters. 

search for bold

Press Alt-W until you are in show markup (the end of paragraph marks are visible). Enter the following: Control-F9 .)"Eb" <Enter>. You can modify this search command for other markup (italics, computer braille, etc.). 

search for capitalization errors

I often make mistakes with the shift key when I type. When I finish, I search as follows: Control-F9 uus <Enter>. This finds words starting with at least 2 upper case letters before shifting to lower case. Then I search with Control-F9 su <Enter>. This searches for an uppercase after a lower case (this finds lots of computer brand names, but it does locate some errors). 

search for end of line (Alt-Enter marks)

To search for end of line characters (what you get when you type Alt-Enter), enter Control-F9 El <Enter>. If your Windows system does not allow you to use the Alt-Enter command, an alternative is Control-Ins L F. 

search for end of paragraph

To search for end of paragraph, enter Control-F9 Eg <Enter>. 

search for extra spaces

In most typesetting applications, you do not want multiple spaces. If you use styles appropriately, there are no multiple carriage returns. if you want to find out if there are multiple "white space" characters, press Control-F9 ww <Enter>. 

search for forced new pages

Press Alt-W until you are in show markup (the end of paragraph marks are visible). Enter the following: Control-F9 X'new page:' <Enter>. This finds both forced new inkprint pages and forced new braille pages. 

search for italics

Press Alt-W until you are in show markup (the end of paragraph marks are visible). Enter the following: Control-F9 .)"Ei" <Enter>. You can modify this search command for other markup (boldface, computer braille, etc.). 

search for not Body text

Sometimes you just want to search for paragraphs which are not Body text style. This could be List, or Headings, or any other style. Just enter the following: Control-F9 Eg{}[style].=^3'bod <Enter>. 

search for special characters

Lets say you want to search for the British pound sign, or an upside down question mark. Your first step is to learn the keystrokes to enter the character in the first place. For example, to enter a British pound sign is Alt-Shift-$ L; to enter an upside down question mark is Alt-Shift-+ Q. To do the search, press F9 then the entry keystrokes, then <Enter>. 

search for style groups

If you want to locate paragraphs which are headings, enter the following: Control-F9 Eg{}[group]="H" <Enter>. 

search for styles

If you want to locate paragraphs with the style Quotation, enter the following: Control-F9 Eg{}[style]="Quotation" <Enter>. 

See also search for not body text. 

search for tabs

To search for tab characters, enter Control-F9 St <Enter>. 

search for words

Press F9 from the Editor to find text in MegaDots. If you just type in lowercase characters, this is a case insensitive search. If you type any uppercase characters, this is a case sensitive search. For example, if you enter F9 cat <Enter> this finds cat or Cat or CAT. If you enter F9 Cat <Enter> this only finds Cat. 

If you want more options in your search, press Control-F9 for complex find. To do a case sensitive search in complex find, enclose the string in double quote marks. To do a case insensitive search in complex find, enclose the string in single quote marks. 

Section Info [style]

Section Info paragraphs are special non-printing paragraphs containing formatting information. You cannot create Section Info paragraphs directly. These paragraphs are created when you specify formatting information such as forcing a new page or changing tab stops. You can see the Section Info paragraph when you show markup (use Alt-W to switch back and forth into show markup mode). 

You cannot make minor editing changes to Section Info paragraphs. You can delete a line or the entire paragraph (be in show markup mode, put the cursor over the material and press the delete key), or you can add more formatting information to an existing section info paragraph by issuing more formatting commands. 

section mark

To enter a section mark in your document, press Alt-plus sign and select section. This is the graphic symbol for section used by proofreaders, looking like a double intertwined S. You cannot use simple replace to search for this symbol. Use complex replace (Control-F9), search for and Alt-plus sign S inside of quotes. 

sentence [noun]

A sentence is a section of text ending in a period, exclamation point, or a question mark. For example, type Control-D S to delete the rest of the current sentence. 

separation line

A separation line separates column headings from the rest of the table, and is used whether or not one appears in print. This is a horizontal line of a single dot 5 followed by dots 25 the width of the column. 

MegaDots assumes the top line of a table are column headings and inserts the separation line after this line. To toggle this line from column headings to a table line (no separation line), press <Shift-Alt-C> while you are on the line above the separation line. 

serial number

To find your MegaDots serial number, type Alt-Shift-R from within MegaDots. You will see your serial number on the bottom status line. 

serial port

A serial port is a jack in the back of the computer that gives serial input and output. Serial ports are male 9 pin connectors in modern computers, and male 25 pin connectors in very old computers. COM1 means serial port 1, COM2 means serial port 2. 

Serial communications requires the matching of communications parameters (baud rate, data bits, parity and stop bits). The most common parameters are 9600 baud, 8 data bits, 1 stop bit, and no parity. You can specify COM port (serial port) parameters when you set up a new device in the Preferences Menu. 

One issue is that MegaDots cannot directly access the serial port on a Windows XP, 2000, Vista, or Windows 7 computer without MegaPrn or Embossit. See MegaPrn and Embossit. 

set off CBC

see computer style. 

SGML files

The most common form of SGML file is web (html). However, sometimes you find files with completely different tags. See Supplement 3 for information about creating a table to control the interpretation of SGML tags into MegaDots. See also web (html) file. 

shape

Occasionally, inkprint has a special graphics such as a circle in the text. Type Control-Insert M followed by a key letter or letters to represent the shape. For each special symbol you use, create an entry in the Special Symbols page of your preliminary pages. 

sheet feed

Printers (inkprint or braille embossers) are described as sheet feed or tractor feed. Sheet feed means they use a stack of separate sheets of paper, like a Xexox machine or a laser printer. Tractor feed means that the paper is connected and has "perfs" on the side that need to be removed. Examples of sheet fed embossers are the Everest and the PortaThiel. Most others are tractor feed embossers. 

shift down (top margin)

A shift down value for your printer or embosser tells MegaDots to automatically move down one or more lines at the top of each page. Use this feature when your printer or embosser makes it difficult to set the top of form to the top margin that you want. Set this value in the brailler or inkprint preferences. 

shift right

Some braillers (such as the MBOSS-1) give too small a left margin. If you want MegaDots to print one or more spaces at the start of each braille line to make a more appropriate left margin, specify that number of spaces as the shift right value in your braille device preference set-up. In addition, when you press F7 to braille a document, the shift right value is one of the settings you can change. If you use a shift right value higher than zero, do not set a left margin on your brailler itself. The MegaDots shift right setting is only for braillers; the equivalent MegaDots setting for inkprint printers is Inches Shifted from Binding setting. 

short form word

A short form word is a contracted spelling of a common word as a shortened version of the full spelling. For example, necessary is written as nec in grade two braille. For a list, see the end of the Braille Intro screen. Press F10 H B from the Editor. 

short line search

MegaDots has a special search for short braille lines. This feature helps you locate places where hyphenization might save a lot of braille space. To do a short line search, make sure you are in WYSIWYG braille at the top of the document, and type Control-F9 G <Enter>. This searches for lines with 10 or more spaces at the end. If you want a different trigger point, enter the number after the G. Once you find a problem spot, break up the first word on the next line into syllables with the Control-hyphen optional hyphen command. See hyphen, optional. 

Shortcut key

Pressing a shortcut keystroke at the Windows Desktop launches the desired application. The MegaDots installation software assigns Alt-Control-M as the shortcut key to open MegaDots 2.5 with speech. This way, a blind user gets right into MegaDots without needing to locate the MegaDots icon on the desktop. 

Shortcut Menu

See Zippy Menu. 

show format markup or show markup

MegaDots has three modes for showing markup. These are WYSIWYG (the screen shows the layout of the hardcopy output), format markup (which shows most of the internal formatting commands in MegaDots), and All (which shows all formatting command, including internal translation codes). You can select the markup view mode by typing Control-Z M. You can switch between WYSIWYG and the last used markup mode by pressing Alt-W. 

side heading

A side heading is a British term for subheading. See Chapter 17 for more information about British braille. 

sidebar

See sidebar separator, and magazine format and box. 

sidebar separator

A sidebar separator is a group of 12 centered dot 6 characters used to show the transition into a sidebar in a braille magazine. Enter a sidebar separator by typing Control-Insert L S. See also magazine format. 

simulated braille

See braille dots from your inkprint printer and braille dots on the screen. 

single quote

An apostrophe and a single quote are different characters in braille. In inkprint the same ASCII character is used for both of these symbols. Usually, the distinction is very clear from context. However, MegaDots allows you to force the distinction. To enter a character in the Editor which is always an apostrophe, just press Control-A. To enter a character in the Editor which is always a single quote, just press Control-Q. For example, if you have a word ending with the letter s inside single quotes, you do not want the ending single quote to be taken as an apostrophe. Just press Control-Q after the s. This looks like a green triangle if you go into show all markup mode (Control-Z M A). See Supplement 5 for more information. 

single spacing

Single spacing is the default. In the Braille Section Layout screen or the Inkprint Section Layout Screen (both found in the Document Menu), there is a question about linespacing. Set this value to 1 for single spacing. See also line spacing. 

six key entry

See Perkins keyboard entry. 

skip blank lines

Usually, when you import a file into MegaDots, you want to ignore blank lines. Some users (such as those working with the Susan Christensen Word Template) may want to see all the blank lines. There is a registry entry that causes the Duxbury file importer to show all blank lines. Run the registry file skip.reg in the main MegaDots directory to show all blank lines. To undo this change, there is a separate file called skip_not.reg. 

skip page number lines

Usually in braille, the page numbers show up in the same lines as text. This does not happen in contents pages or in tables. In the Braille Specific Style Information Screen for a specific style, there is a question skip page number lines? See Supplement 4 for more information. 

small text size

Type Control-Z A S to pack lots of text on the screen at once. 

soft hyphen

See hyphen, optional. 

soft return

A hard return is a carriage return which is meant start a new line within (interior to) a paragraph. Soft returns change depending on the carriage width used to display or print the document. Contrast with hard return. 

software date

To find the release date of your MegaDots software, press F10 H A (to get the About MegaDots screen from the Help Menu). 

software updates

Software updates to MegaDots are free for the first year of purchase. There are modest charges beyond that point. If you are experiencing a software bug, call MegaDots technical support at +1-978-692-3000. At various times, we have free updates at our web site at //www.duxburysystems.com. Updates may be restricted by date of purchase, by your current version number, or subject to other restrictions. 

source of document

When you import a document, MegaDots keeps track of where the document comes from. If a document just imported comes from a non-MegaDots source (such as a WordPerfect or Word file), and you have only made style changes, you have an opportunity to re-import the document with new instructions describing how you want the document to be imported. Any content changes (changes to characters) disallow this possibility. 

spaces, multiple

See multiple spaces. 

Spacing same [style]

You may want to produce a braille format not supported by MegaDots. The Spacing same style is a loophole to let you create any unusual format. Please do not use Spacing same style for things that are supported by MegaDots. Type Alt-U S <Enter> to set a paragraph to Spacing same. 

Put the cursor on the first character of the paragraph. Press space to increase the indent by one. Press Alt-Right arrow to increase the runover by one. Press Alt-<Enter> to put a blank line before the paragraph. You can create any combination of indent and runover you want. See also Translate exact style. 

Spanish

All Spanish documents in the United States are produced in grade one braille. Spanish uses a different accented e than other languages, so you need to tell MegaDots that the document is in Spanish. Go to the Translation setup screen in the Document Menu. Set the Braille Standard prompt to S for Spanish, and set the Default Translation Method to O for One. A shortcut is to load the document with a slash tos (for Translation grade One for Spanish). For example, you can type mega sec1.txt /tos <Enter> to force Spanish translation. 

If you want to mix grade two English with grade one Spanish, just set the Braille Standard prompt for Spanish, leave the Default Translation Method at T for Two, and mark any text you want in Spanish as grade one (mark a block any type Control-T O). 

As an alternative, you can set the Braille Standard prompt for Spanish, set the Default Translation Method at O for One, and mark any text you want in English as grade two (mark a block any type Control-T T). In either system, English is grade two and Spanish is grade one. It is just a matter of deciding whether you want to be marking English or Spanish segments. 

You can enter all the accent marks within MegaDots. See accented letters and foreign text. 

While you are editing in MegaDots, you can press Alt-Plus Sign to pull up a menu containing the upside down question mark and exclamation mark. 

Be aware that the Spell Checker is MegaDots is only good for English. This makes spell checking material containing Spanish a problem. You may find proofreading without the Spell Checker more efficient. 

In North America, the dot 6 is used for the capital sign. This is the default for MegaDots. If you are preparing materials for use in Spain or Mexico, then you need to use dots 4-6 for the capital sign. To do this, change the European caps sign dots 4-6 prompt in the Translation Setup screen in the Document Menu. 

special characters [Insert Menu]

Many special characters are on the Control-Insert menu. Accented letters are Control-Insert A. Most other special characters are under Control-Insert S. You then get a list of categories from which you can make further selection. There is a data entry shortcut for most of the special characters. For example, enter Alt-$ for currency symbols. These shortcuts are on the right side after you type Control-Insert S. 

One exception is Greek letters. For Greek letters, type Alt-G followed by a letter. 

special font

MegaDots has an unusual special font to show braille on the screen. It uses a special graphics character for each braille contraction, for example, the th sign is shown by a t and an h jammed together. This special font may be useful to sighted persons who are just learning braille. To get the special font, type Control-Z D S. The special font requires EGA or VGA graphics in the computer to work. Look at the lower right of the screen for the name of the braille cell your cursor is on. 

special pages

See page layouts. 

special symbols page [book section]

A book special symbols page is part of the preliminary pages. See Preliminary pages. To start a special symbols page, type Control-Insert B P and pick special symbols page from the list. This starts the material on a fresh braille page. 

spell checker

Each MegaDots sold now comes with the spell checker. To run the spell checker, press F10 T R to select Run Spell Checker from the Tools Menu. You are asked if the file came from an optical scanner. If you answer yes, then the spell checker takes into account the typical errors that optical scanners make (such as using ‘iii' for an ‘m'). 

When the spell checker locates a word it cannot recognize, it presents a list of possible choices. Use the F1 key to learn more about the different options. The spell checker is designed to be simple and easy to use. 

You can press a single digit to select the suggested word. You can press A to accept this word in this one instance. You can press E to enter the correct spelling. You can press V to visit the text. Visit text temporarily puts you in the MegaDots Editor so you can correct any errors (press escape or F10 to go back to the spell checker). You can press G to globally change a misspelling (press G followed by a digit, or E). You can press G followed by A to globally accept this word in the rest of this document. You can press R to revise the dictionary (press R followed by A). You can also revise the dictionary manually by modifying the LEX.AUX file. See LEX.AUX. 

The full documentation for the Spell Checker is in the file SPELL.meg. Use the menu of documentation from Start Menu, Programs, Duxbury, MegaDots 2.5 Documentation. See also documentation. 

stairstep table [style]

A stairstep table uses an indented format for each entry of a table. The first column is blocked in cell 1, the second is blocked in cell 3, the third is blocked in cell 5, etc. 

Table entries are separated by tabs. Each line of the table ends with a carriage return. Blank entries are created by another tab. Use a dash (two hyphens) or an ellipsis if shown in the print table. 

MegaDots automatically protects a table row so it doesn't split between braille pages. 

For a transcriber's note before the stairstep table, write a paragraph like the following: Print column form changed as follows: <Tab> Column 1 heading <Tab> Column 2 heading <Tab> Column 3 heading. Mark this paragraph as Stairstep style (<Alt-T S>) and also as a transcriber's note (block the entire paragraph and press <Control-F T>). You get the transcriber's note marks and the necessary braille format automatically. 

stammer

To show the hyphens used to show stammering in inkprint, use the unbreakable hyphen (entered with Control-U). Use grade one for any words which are whole word alphabet contractions. Use grade two for short-form words only if the short form word begins with the same letter or contraction as the stammered portion. You may have to use exact translation and fill in the correct contractions in that situation. Contact a certified transcriber for guidance with stammered words which could be contracted. 

standard path

See path. 

stanza

To show a new stanza of a poem or song, use the New stanza style for the first line of the stanza. This puts in a blank line in braille. 

Stanza Number [style]

If you are producing a long song, each line is in poetry style. If there are stanza numbers, these should be entered as paragraphs with just the number. To mark the paragraph as being a stanza number, type Alt-P S <Enter>. 

Start Menu

You get to the Start Menu of Windows by pressing Control-Esc (or pressing the Windows key if your keyboard has a Windows key). When you install MegaDots, 5 icons are added to the Duxbury group: MegaDots 2.5 without speech, MegaDots 2.5 with speech, Command Line for MegaDots, MegaDots 2.5 Documentation, and Embossit 3.0. 

starting MegaDots

At the Windows desktop, click on the MegaDots icon (with or without the use of a speech program). 

At the command line prompt, just type MEGA <Enter>. If you get a file not found error, then you need to add your MegaDots program directory to your Path. See Path. 

status line

The status line is the bottom line of the MegaDots Screen. It shows whether the current document is inkprint or braille, whether the document has been changed since it was last saved to disk, the file name, the cursor position, the style of the current paragraph, and the emphasis type of the current character. 

stem and leaf plot

See the heading "Stem and Leaf Plots" in Chapter 11. Also, in the examples subfolder of your MegaDots program folder, see the files comments.meg, n18.meg, n20.meg, and n21.meg 

sticky space

See blank character. 

stress

See diacritics for showing primary stress and secondary stress. 

stretched text

Title pages use stretched text (i.e. there has to be material on the first and last line of the title page). Specify a stretched page by typing Control-Insert B P T <Enter>. As you type each line, it is placed in an appropriate place automatically. If you want two lines to be together, separate then with Alt-<Enter> instead of <Enter>. Do not end a title page with a carriage return. 

The title page does not look stretched in inkprint. Once the document is translated into braille, you see the title page format. 

strike through

Strike through is a form of inkprint emphasis which overstrikes a hyphen through the inkprint letters. This is often used in legal documents to show material that is being deleted. To format text as strike through, put the text in a block and type Control-F S. The Translation Setup Screen in the Document Menu controls how strike through material is represented in braille. If you have a braille document, and you want to change how emphasized material is shown in braille, first translate back to inkprint, then change the Translation Setup Screen, then translate back into braille. 

string

String is a term meaning some number of arbitrary characters. The term string is used in discussions of search and replace. A string could consist of zero characters ("the string was replaced by the null string"). 

style

A style is a collection of formatting information that can be applied to an entire paragraph. MegaDots is entirely structured around styles. To learn more about styles, press F10 H S from the MegaDots Editor. This is a copy of Supplement 6. 

style sheet

A style sheet is a collection of styles that can be called together as a group. This determines the basic layout and translation mode of a document. To change a style sheet, use the Style Sheet Selection screen in the Document Menu. To change the default style sheet for new documents, choose the Style Sheet screen in the New Document option found in the Preferences Menu. For a list of style sheets (and an explanation of which one is appropriate for you), press F1 at either of these prompts. To learn how to change a style sheet with the Style Sheet Editor in the Tools Menu, see Supplement 4. Each of the different style sheets can be looked up in the Reference Manual. Also see automatic style sheet selection. 

Style Sheet Editor [Tools Menu]

Press F10 T S to get to the Style Sheet Editor in the Tools Menu. This option allows you to make changes with the MegaDots style system. We recommend you read Supplement 4 on styles and make back up copies before making any changes. You could end up fouling up the formatting system in MegaDots. 

style sheet selection [Document Menu]

Type F10 D S to get to the Style Sheet Selection Screen in the Document Menu. This menu allows you to change style sheets. At this prompt, you can get documentation on the choices by pressing F1 or you can choose from a list by pressing F2. 

Styles Menu

The Styles Menu lets you select the appropriate style for the current paragraph. Type F10 S to get to the Styles Menu. Each of the items in the Styles Menu has a keyboard shortcut that is shown when you type F10 S. For example, the Body text styles shortcut is Alt-B, the Headings styles shortcut is Alt-H. 

subdirectory

A directory inside a directory. You need to learn more about the DOS (Disk Operating System) to make effective use of subdirectories. See also directory and Supplement 1. 

subscript (lower)

To show a subscript in inkprint, put the text in a block and type Control-F L (L is for lower, the MegaDots word for subscript). Some inkprint printers may not be able to perform a subscript. 

For Nemeth Code issues, see Nemeth Code. 

superscript (raise)

To show a superscript in inkprint, put the text in a block and type Control-F R (R is for raise, the MegaDots word for superscript). Some inkprint printers may not be able to perform a superscript. 

For Nemeth Code issues, see Nemeth Code. 

supplemental pages

Supplemental pages contain things like an index or a glossary. To define these pages, Type Control-Insert B S. 

suppress [Edit Menu]

Pressing Control-S brings up the Suppress Menu. You can suppress a contraction, a dot six capitalization indicator, a letter sign, or a special symbol. 

suppress braille page numbers

To suppress all braille page numbers, select the NONUMS style sheet from the Style Sheet Selection Screen in the Document Menu. 

suppress contraction

To suppress an unwanted contraction, put the cursor at the appropriate point and type Control-S C. See translation error. To suppress many contractions in a systematic way (to teach a new student grade two braille), use the Beginner Braille feature. See Beginner Braille. 

suppress even page numbers

In interpoint output it is common to suppress the even page numbers. In the Braille Document Setup Screen in the Document Menu, answer yes to the Suppress even page numbers? question. MegaDots ignores this command (i.e. puts page numbers on all pages) when embossing to single-sided embossers. See also interpoint output. 

switch directory

See CD. 

switch document

MegaDots allows you to load more than one document in memory at a time. To switch between documents, press F8. To get a list of documents in memory, type Control-J D. 

switch drives

In DOS, to switch to a different drive letter, just type the letter followed by a colon. For example, to list the contents of the G drive, you can type G: <Enter> DIR <Enter>. In this instance you could avoid switching drives by typing DIR G: <Enter>. See also Supplement 1. 

Tab

To enter a Tab character, press the Tab key. MegaDots does special things for a Tab used in one of the tabular styles. See Chapter 11 for information on tables. 

To enter a decimal tab, press Shift-Tab. 

To search for a Tab character in Complex find, use St or #9 in the Complex find text. To search for a decimal tab, use #4 in Complex find. 

table of contents [book section]

You can create a table of contents two ways: automatically or manually. See also table of contents generator. To manually create a table of contents, type Control-Insert B P C <Enter>. To separate each entry from the page number, type Control-Insert G. To move an entry down a notch in the hierarchy, press Alt-Right Arrow. To see an example of a manually created table of contents, look at the file prelim.meg on the MegaDots directory. 

In Britain, there are three kinds of table of contents. See general contents, volume contents, and combined contents. 

table of contents generator

The automatic table of contents generator is located in the Tools Menu. First do all the data entry work and correction on your data. Next save your work (press F4) before using the table of contents generator. Now type F10 T C to select Create TOC from the Tools Menu. The program asks you a few simple questions and then goes to work. For British braille, the table of contents generator can produce either a Volume contents or a Combined contents. 

One word of warning: while the table of contents generator can remove an old table of contents, to do so the table of contents must be structured properly for MegaDots. If you have just scanned in a file, you may want to manually delete the old table of contents before using the table of contents generator. 

table footer

A Table Footer is used for sequentially numbered tables. Simply type the table heading a second time (abbreviate if necessary) and press <Alt-R End>. This places the title/number on line 25 of the first page and any additional pages. The placement of the Table footer can be a bit tricky. If the table heading is before a boxing line, make sure to place the Table footer AFTER the boxing line. When a table is preceded by any <Alt-N> style, or a transcriber's note, place the Table footer BEFORE the notes. When there is body text between the table heading and the table itself, place the Table footer BEFORE the Body text. When the table heading immediately precedes the table, place the Table footer BETWEEN the table heading and the table. 

MegaDots turns off the Table footer when it encounters: an end boxing line (if there is a begin boxing line); after any <Alt-N> styles (footnotes which may appear at the end of the table); or when a table style is no longer being used. If for some reason MegaDots does not turn off the footer, do it manually by creating a blank Table footer at the end of the table. 

When text resumes, MegaDots forces a new braille page, as no text (other than notes) should come between the end of the table and the Table footer. 

table header

When a table is longer than one braille page, it is necessary to repeat the table heading on additional pages. MegaDots can do this automatically. Simply type the table heading a second time (abbreviate if necessary) and press <Alt-R T>. The placement of the Table header can be a bit tricky. If the table heading is before a boxing line, make sure to place the Table header AFTER the boxing line. When a table is preceded by any <Alt-N> style, or a transcriber's note, place the Table header BEFORE the notes. When there is body text between the table heading and the table itself, place the Table header BEFORE the Body text. When the table heading immediately precedes the table, place the Table header BETWEEN the table heading and the table. 

MegaDots turns off the Table header when it encounters: an end boxing line (if there is a begin boxing line); after any <Alt-N> styles (footnotes which may appear at the end of the table); or when a table style is no longer being used. If for some reason MegaDots does not turn off the header, do it manually by creating a blank Table header at the end of the table. 

table item break

You may wish to control where table items divide if they are too long to fit on one line. Use <Control-R T> to require a break (place immediately after the word). Suppress a break by using <Control-S T> immediately after a word. MegaDots does not always pay attention to the Require table item break, but it pays attention to the Suppress table item break. It may be more effective to suppress every space other than where you want it to break. 

TABLE-X.MDR

Tables in MegaDots only work when the same number of columns exist in each row. TABLE-X.MDR is a rules file used to locate places in a table where this is not true. If you have a file containing tables which is unstable, keep the file in inkprint, show markup. Run this rules file. Search for double tilde (~~). Fix the problems, save your work. Then try again to translate into braille. 

tables

MegaDots automatically supports the BANA table rules. You can format tables using eight different styles: Basic table, Labeled, Offset, Paragraph, Related columns, Stairstep, Two page tables and Unrelated columns. For a discussion of each table format, press <Alt-T>, highlight a table style, F1. See Chapter 11 (using the F11 key) for detailed information. For really detailed information, look for the subdirectory EXAMPLES in your MegaDots directory. The EXAMPLES directory contains a series of examples used in the BANA rule book entered as MegaDots files. There is an additional file COMMENTS to explain some of the aspects of formatting tables in MegaDots. 

Data entry is the same for all table styles. Table entries are separated by a <Tab>. Each line of the table ends with a carriage return. Blank entries are created by another tab. Use a dash (two hyphens) or an ellipsis if shown in the print table. 

MegaDots assumes the top line of a table are column headings and automatically puts in the separation line. Place the cursor on this text line and use <Shift-Alt-C> to toggle a line from being column headings to a regular table line (no separation line). 

For tables that won't fit the width of the page because of long lines (many columns), even with some runovers, MegaDots solves the problem by letting you specify a Backup table method. The backup default method is Stairstep. To change this default in your Preferences, go to <F10 P N B, Table backup method (and save your Preferences when you are done). To change it for the current document only, use <F10 D B, Table backup method>. 

You can block a column in a table to manipulate different columns (reverse columns, etc.). See column blocking. 

tabs

When formatting tables, MegaDots automatically sets the tab stops. There are three kinds of tabs in MegaDots: regular tabs, decimal tabs, and combination tabs. 

Press the <Tab> key for a tab. Use a <Tab> between each column entry. A <Tab> is also used when a blank space appears in the table (dot 5s appear in the width of the column, or three dot 5s in a Stairstep table). Use the <Tab> between column headings. Use a <Tab> at the beginning of the column headings row if the first column does not have a heading (which leaves that portion of the separation line blank.) 

Decimal tabs are <Shift-Tab>. A decimal tab lines up the decimal points. The decimal point is currently the only mark which MegaDots aligns. If it is necessary to align columns by commas, use the correct number of <Control-B> to force the alignment. 

Combination tabs are <Control-Tab>. These are used to show that some column headings are "parents" to other subcolumn headings on the next line. See Combination tab for more detailed information. 

You may want to use tabs in other situations where you control the tab stops. MegaDots lets you separately list regular tab stops and decimal tab stops. These may be set in the Braille section menu of Document or Preferences. To use the Zippy menu, press <Control-Z B> to set the braille tab stops. Press <Control-Z I> to set the inkprint tab stops. 

tactile graphics

See brailler graphics. 

TameDOS

TameDOS is an inexpensive software program that helps run MS-DOS programs (like MegaDots) run in a larger window than you can have without the use of TameDOS. Download this program from http://www.tamedos.com. TameDOS can be run in a virtual machine like the XP Mode of Windows 7 or VM-Lite. 

When you run TameDOS, you need to right click on the TameDOS title bar, and go to Text Preference, font, to select "MegaDots cleaner braille" as the font to use. 

technical help

To get help in MegaDots, press F1 from whatever screen you are in. Make extensive use of the F12 Reference Manual. Also press F11 to see if there is an appropriate chapter in the User Manual. Sometimes problems are caused by not understanding the vocabulary of the documentation. Use the Reference Manual to learn the right vocabulary. If you still need help, call the MegaDots technical support at at +1-978-692-3000. The e-mail address is megadots@duxburysystems.com. 

TED-600 [embosser]

The TED-600 is an interpoint brailler made by Enabling Technologies. See the Interface Guide or press F10 H I from the Editor for directions on setting it up for use with MegaDots. 

test

See exam. 

text break

A text break is a minor break in the text in a braille magazine consisting of 3 centered asterisks. The text break should be considered a more minor separation than the article separator. Enter a text break by typing Control-Insert L T. See also magazine format. 

Text size

MegaDots lets you vary the size of the letters on the screen. If you want to change the appearance of your screen, type Control-Z A from the Editor. The choices are: N for Normal, S for Small text (extended screen), L for Large text (for MegaDots to produce characters of double height and width), W for Wide text (for MegaDots to produce characters of double width only), and T for Tall text (for MegaDots to produce characters of double height only). If you can use tiny print and want to fit a lot on the screen for reviewing, choose S. If you want MegaDots to enlarge the screen characters for you and you do not use a large print system that is separate from MegaDots, choose L, W, or T according to your needs. Otherwise, choose N. In particular, if you use a large print system that is separate from MegaDots, like ZoomText or LP-DOS, choose N. Once you have the size you want, don't forget to save your preferences. 

TEXTBK11 [style sheet]

The new name for the style sheet supporting the 2011 textbook formatting rules. Depending on timing, this will come with MegaDots 2.5 or will be downloaded from a web page. If the rules release is delayed, then it will be named TEXTBK12 for 2012. 

TEXTBK77 [style sheet]

The new name for the style sheet supporting the 1977 textbook formatting rules. All files using the style sheets TEXTBOOK and OLDTEXT are automatically switched to TEXTBK77. 

The style sheet TEXTBK97 is more up to date. In 2011 or 2012 the rules will change again. At that time, we will distribute the stylesheet TEXTBK11 or TEXTBK12. 

See also Textbook format and print page indicators. Use the style sheet selection option from the Document Menu to select a style sheet for the current document. Use the New Document Preferences to specify the style sheet for future documents. 

TEXTBK97 [style sheet]

The new name for the style sheet supporting the 1997 textbook formatting rules. All files using the style sheets TEXTBK and NEWTEXT are automatically switched to TEXTBK97. 

In 2011 or 2012 the rules will change again. At that time, we will distribute the stylesheet TEXTBK11 or TEXTBK12. 

See also Textbook format and print page indicators. Use the style sheet selection option from the Document Menu to select a style sheet for the current document. Use the New Document Preferences to specify the style sheet for future documents. 

Textbook format

Textbook format requires print page indicators (as opposed to Literary format, which does not use print page indicators). MegaDots uses style sheets marked with the last 2 digits of the year (TEXTBK77, TEXTBK97, and possibly TEXTBK11). See print page indicators. Use in North America only. 

textfile

A textfile (also known as an ASCII textfile) is a file without formatting information. MegaDots can read textfiles. See Chapter 19 for more information. 

Thomas [embosser]

The Thomas is a single sided brailler made by Enabling Technologies. See the Interface Guide or press F10 H I from the Editor for directions on setting it up for use with MegaDots. The Thomas has 2 different options in the MegaDots list of embossers: regular graphics vs. high resolution graphics. The +H (plus sign H) means with high resolution graphics. 

Thiel [embosser]

The Thiel is a high speed embosser made by the Thiel Company in Germany. See the Interface Guide or press F10 H I from the Editor for directions on setting it up for use with MegaDots. 

Tiger Embossers

The Tiger Embossers work with MegaDots using the Embossit program. See Chapter 5 for details on configuring MegaDots to use Embossit 3.0. 

tilde accent

One reason for the use of accented letters is doing diacritics (the special pronunciation symbols used in dictionaries or glossaries). If so, see diacritics. (The rest of this text assumes you are not doing diacritics). 

To place a tilde over a character (usually over the letter n in Spanish), press Alt-Tilde. See also foreign text. 

TINYTEST

MegaDots contains a program called TINYTEST to test output to an embosser. To use it, type TINYTEST LPT1 <Enter> at the command line. The parameter is the port name (substitute COM1 or COM2 as appropriate). This produces a framed braille pattern on the embosser and displays the dot pattern on the screen. If you are getting the same dot pattern on the screen as is on the embosser, then your embosser is able to print small files correctly. 

title page [book section]

Title pages use a stretched format (i.e. you are required to put material on the first and last line of the braille page). Type Control-Insert B P T to specify a title page. Separate each line with <Enter> if you want blank lines between them. Use Alt-Enter if you want the lines to be bound together. Usually title pages are carefully structured to contain certain pieces of information (full book title, author, publisher, brailling organization, etc.). If there is too much information to fit on one title page, you can create a Copyright page with some of the overflow information. See Copyright page. Your brailling group should give you guidance on preparing title pages. 

If your Windows system does not allow you to use the Alt-Enter command, an alternative is Control-Ins L F. 

See book title on how what is on title page is used as a replacement for the abbreviated running header just for page 1 of the main body pages. 

toggle

Toggle is a computer term for a feature which is switched on and off by the same command (similar to a pull-chain light switch). For example, the F5 key is a toggle, since you use the same command to go from braille to inkprint as to go from inkprint to braille. 

Tools Menu

The Tools Menu contains handy tools or utilities. Type F10 T to get to the Tools Menu. 

top margin

Setting a top margin pushes down the text from the top edge of the paper. To set the top margin in inkprint, type Control-Z I. We do not offer a top margin prompt for braille. Instead we offer a Shift Down prompt. Use this if you do not have any control over the top of form on your embosser. To set shift down in MegaDots permanently for a braille device, press F10 P B and select that brailler to get to the Set up a brailler screen. See also top of form and shift down. 

top menu

The top menu is the highest level menu in MegaDots. In the sighted-oriented screen layout, the top menu is seen across the top line of the screen. It is hidden in the blind-oriented screen layout. In both cases, press F10 to activate the top menu. 

tractor feed

Printers (inkprint or braille embossers) are described as sheet feed or tractor feed. Sheet feed means they use a stack of separate sheets of paper, like a Xexox machine or a laser printer. Tractor feed means that the paper is connected and has "perfs" on the side that need to be removed. Most embossers are tractor feed, except for the Everest and the PortaThiel. 

trademark symbol

To enter the trademark symbol directly in MegaDots, type Alt-period t (Alt-period followed by the letter t). When the cursor is on this character, the status bar says "t overdot". MegaDots does generate the correct braille for this symbol (in BANA, this is dots 4-5 followed by the letter t). 

training mode

MegaDots has a training mode to teach transcribers about braille. In training mode, you are limited to Big dots screen mode and braille keyboard. You are not allowed to translate your text (you are allowed to translate a totally empty file). The idea behind training mode is that some groups want a transcriber to prove they know how to produce braille manually before they are allowed to use a translator. To switch on training mode, add the environment variable SCREENPRO to your system. This might be done by adding the line SET SCREENPRO=1 to a launching batch file. 

transcriber features

MegaDots has many features designed to assist the braille transcriber. These are described in Chapter 16 of the User Manual. 

transcriber lists

The Duxbury Systems web site //www.duxburysystems.com has a large, well organized list of braille transcribers. Click on "resources on or off the web". 

Transcriber View [advanced features]

When the Transcriber View Mode is on, then the inkprint uses the same indent, runover, and blank lines as the braille. It also shows transcriber's notes. Braille only text segments are visible in inkprint (screen and printouts) with Transcriber View mode on. Transcriber View displays braille files with WYSIWYG and inkprint files with show markup. Transcriber View is located in the Advanced Features Screen of the Preferences Menu. 

transcriber's note

A transcriber's note is inserted text that explains the inkprint to a braille reader. Mark the text (as a block) and type Control-F T. The text for a transcriber's note can be a portion of an existing paragraph, or a paragraph of its own. Don't worry about the style of the paragraph (Body text does nicely.) MegaDots formats the material appropriately. 

Since a transcriber's note is extra material which might be confusing to an inkprint user, MegaDots does not show a transcriber's note in WYSIWYG inkprint. To see a transcriber's note in inkprint, press Alt-W to switch to show markup mode. Of course MegaDots shows transcriber's notes in the braille edition. 

transcriber's note page [book section]

A book transcriber's note page is part of the preliminary pages. See Preliminary pages. To start a transcriber's note page, type Control-Insert B P and pick transcriber's note page from the list. This starts the material on a fresh braille page. 

translate

To translate a file in MegaDots, press the F5 key. This is a toggle, so it translates inkprint into braille or braille into inkprint. 

translate [Edit Menu, verb]

Pressing Control-T brings up a menu of choices for changing the braille translation mode. You can select grade one, CBC, grade two, inkprint only, braille only, or exact translation modes. To change translation mode for a section of text, mark it as a block and press Control-T. If you have not already marked a block, pressing Control-T brings up a menu of choices (word, sentence, paragraph, page, document) to help you specify what you want to translate: Character, Word, Line, Sentence, paraGraph, Page or Document. 

translate as [spell checker]

This option is used to force the highlighted word into a special translation mode, such as exact translation, computer braille, or grade one. 

Translate exact [style]

You may want to produce a braille format not supported by MegaDots. The Translate exact style is a loophole to let you create any unusual format. Please do not use Translate exact same style for things that are supported by MegaDots. Type Alt-U T <Enter> to set a paragraph to Translate exact. 

Put the cursor on the first character of the paragraph. Press space to increase the indent by one. Press Alt-Right arrow to increase the runover by one. Press Alt-<Enter> to put a blank line before the paragraph. You can create any combination of indent and runover you want. 

Anything entered in Translate exact is not changed for the translator at all. The inkprint display shows the braille format. If you have the braille keyboard set to turn on when you are in braille, the braille keyboard turns on whenever the cursor is inside a Translate exact paragraph. See also Perkins keyboard entry. 

translate file [File Menu]

To translate a document from inkprint to braille or from braille to inkprint, press F5. 

translation errors

Sometimes the translator in MegaDots is not perfect. Of course we would like to know about any translation errors you encounter. Please direct these corrections to the Department of Perfect Translation. 

MegaDots has a number of features which may be useful to get around problems temporarily. These include exact translation, require or suppress letter sign, require or suppress contraction, blank character, and global replace. You can even set up a rules file to run automatically upon the use of the translator into braille. See finetune braille rules file. 

translation markup

To remove ambiguity in braille, MegaDots introduces invisible non-printing characters to modify the translation of ambiguous sequences. These characters are responsible for the "perfect" round trip of inkprint to braille back to inkprint. If you want to see these characters, type Control-Z M A (show All markup). For a list of the translation markup in MegaDots, see Supplement 5. See also round trip. 

translation modes

MegaDots has 6 translation modes: grade one, grade two, CBC, braille only, inkprint only, mathematics, exact, and diacritics. If you mark a block, press Control-T a switch translation modes. 

In the Translation Setup screen of the Document Menu, you can change an entire document to be grade one, grade two, CBC, exact, or diacritics. Each of these translation modes is listed in the Reference Manual. 

Translation Setup [Document Menu]

Press F10 D S to get to the Translation Setup Screen in the Document Menu. This Menu lets you change how a document is translated. 

triple spacing

In the Braille Section Layout Screen or the Inkprint Section Layout Screen (both found in the Document Menu), there is a question about linespacing. Set this value to 3 for triple spacing. There is no rule for braille format which calls for triple spacing, so use triple spacing only for inkprint. See also line spacing. 

Turn colors off [editor preferences]

The Turn colors off preference tells MegaDots whether to tailor screen output for a black and white monitor. The choices are Y for Yes and N for No. In general, choose Y if you use a black and white monitor and N if you have a color monitor. Some people with limited vision using a color monitor set the Turn colors off preference to Yes because it makes the screen display easier for them to read. To set Turn colors off to Yes and save your preferences, launch MegaDots by typing MEGA /m /f <Enter> (See Chapter 19). 

Two page table [style]

If you have a very wide table, you may want to try this style <Alt-T T>. This formats the table to fit on two pages side by side. In braille WYSIWYG, it appears as a very wide table with a line down the middle to show you where the two pages separate. If brailled on an interpoint embosser, MegaDots makes sure to start the table on an even page, so it is brailled across facing pages. For single sided embossers, it is up to the user to bind the first page of the table flipped over. 

txt files

Files with a txt extension are usually ASCII textfiles. These files are devoid of any formatting information. You can import ASCII textfiles into MegaDots. See ASCII file. 

typeface

MegaDots lets you specify a typeface and a font size for inkprint. You can set up document defaults. You can specify that some portion of the text is printed in a different typeface or font size than the default. To set the default, press F10 D I. Press F1 for help on the different prompts. 

To mark a segment with a different typeface, mark a block and then press Control-F F. To mark a segment with a different font size, mark a block and then press Control-F P. See also font size. 

umlaut

One reason for the use of accented letters is doing diacritics (the special pronunciation symbols used in dictionaries or glossaries). If so, see diacritics. (The rest of this text assumes you are not doing diacritics). 

The diereses or umlaut is an accent mark that looks like two dots above a letter. To access the list of diereses or umlaut characters from the Editor, type Alt-" (Alt-Double Quote). The double quote is suggestive of the appearance of the double dots. See also foreign text. 

unbreakable hyphen

An unbreakable hyphen (dash) is a hyphen that cannot be used to divide a line. Specify an unbreakable dash by pressing Control-U. Use the unbreakable dash for the hyphens used for showing stammering and speech hesitation. 

underdot

See diacritics. 

underline

To mark something as underlined, mark it as a block, then type Control-F U. The Translation Setup Screen in the Document Menu controls how inkprint underlining is represented in braille. If you have a braille document, and you want to change how underlined material is shown in braille, first translate back to inkprint, then change the Translation Setup Screen, then translate back into braille. 

underline spaces

It is a matter of personal preference whether the space between two underlined words should be underlined. To turn this feature on or off, go to the Inkprint Document Screen in the Document Menu. 

underscoring

Physical underscoring is a form of braille emphasis used at the lower grade levels. See the discussion on emphasis in Chapter 8. 

uneditable

You may get the Editor error message "uneditable" if you are in Cursor go everywhere mode. You might have issued the Alt-E command by mistake to go into Cursor go everywhere mode. This command is a toggle. Just type Alt-E to get out of Cursor go everywhere mode again. See Cursor go everywhere. 

undo

There is no undo feature built into MegaDots. 

uninstall program

MegaDots 2.5 works with the Windows uninstall system. Go to the Control Panel, Add/Remove Programs, MegaDots 2.5 to uninstall MegaDots 2.5. 

United Kingdom

See British braille. 

unknown file with text

MegaDots can read many file new file types, even some that are unidentified. When a file is read as "unknown file with text", then MegaDots scans the file and figures out what is text and throws away any additional codes. 

MegaDots can read PageMaker, .EXE, and many help file systems using "unknown file with text". When you import the file, type the file name followed by? (hyphen question mark), and enter "unknown file with text". 

Unrelated cols [style]

Use for columned material where items on the same row aren't related. An example of an appropriate use of Unrelated columns is a spelling word list. The braille does not use guide dots between the columns. 

You can automatically create Unrelated columns by typing the text as one long list (i.e., an <Enter> at the end of each item). Block the list, and then use <F10 T M> to use the Make clipboard column option from the Tools menu. Choose whether the items should be arranged in columns or rows. MegaDots figures out how many columns fits on the page and give you the choice of how many should be used. Press <Control-E> to go back to the Editor. 

For columned material with no row headings, but there is a relationship between adjacent items on the same line, use Related cols. See Related cols. 

For tables with row headings, use Basic table. See Basic table. 

unsaved directory

If you exit MegaDots without saving your changes, your files are saved in the C:\mega25\UNSAVED directory. The next time you go into MegaDots, press control-L to restore your files. This is another way that MegaDots tries to protect you from your mistakes. 

update date

To find the version number and release date of your MegaDots software, press F10 H A (to get the About MegaDots screen from the Help Menu). 

updates

Software updates to MegaDots are free for the first year of purchase. There are modest charges beyond that point. If you are experiencing a software bug, call the MegaDots technical support line at +1-978-692-3000. At various times, we have free updates at our web site at //www.duxburysystems.com. Updates may be restricted by date of purchase, by your current version number, or subject to other restrictions. 

UPPER.MDR
This is a rules file supplied with MegaDots which puts all the text in uppercase. To invoke, just type Alt-F9 UPPER <Enter>. See also LOWER.MDR and rules file. 

uppercase toggle [spell checker]

Occasionally, the spell checker makes a mistake and offers suggestions in the wrong case. Press U to switch between lowercase, uppercase, and all uppercase (a three-way toggle). Now press the appropriate digit. 

upside down punctuation

See exclamation mark and question mark. See also Spanish. 

USB port

You can emboss to a USB port in MegaDots. See Computer Ports, USB, and Embossers or the section of USB Ports in the Interface Guide. 

user ID

See serial number. 

user interface

The user interface is how you interact with a program. MegaDots is designed to contain several user interfaces: for sighted users, for voice output, for refreshable braille devices, and for large print. 

user list (selection interface)

MegaDots uses several different displays for getting different kinds of information or selections from you, the user. We call these displays form, quick form, list, user list, and menu. The user list selection interface lets you choose one item from a list which you have created. Unlike the list selection interface, the user list lets you insert, delete, or rename items. Unlike a menu, a user list may occupy more than one screen. When MegaDots presents you with a user list, pressing F1 twice provides help on using the user list interface. 

User Manual

The User Manual is a collection of individual chapters which gives a broad introduction into the use of MegaDots. Press F11 to get access to the User Manual from within MegaDots. Use the menu of documentation from Start Menu, Programs, Duxbury, MegaDots 2.5 Documentation. See also documentation. 

UTF-8

UTF-8 is a system for encoding Unicode files in an 8 bit system. A UTF-8 is just like a regular ASCII file, except for its unusual way of encoding accented letters and specialized typesetting characters. 

MegaDots can read UTF-8 textfiles as long as they start with the UTF-8 prefix of "EF BB BF" (three bytes expressed as hexadecimal). MegaDots can now read HTML/XML files that use UTF-8 character encoding as long as the file is identified in a tag as using "UTF-8" encoding. 

If MegaDots finds a character that it cannot identify, it will convert the character into hexadecimal and save the character in an identifiable sequence. For example, the Unicode character "0816" is imported into MegaDots as [~0816] (notice the added brackets and tilde). You can write a ruled file to convert these into sequences that make the correct braille. 

UTF-8 can be a useful intermediate file format. For example, we were e-mailed a textfile written in "code page 1250". We imported the file into Notepad, and found that Notepad was able to correctly work out the correct accent marks. Notepad is able to export to a UTF-8 textfile with the usual 3 byte identifier. MegaDots is able to import the UTF-8 file Notepad exported. 

utilities

See tools. 

vendor lists

The Duxbury Systems web site //www.duxburysystems.com has a large, well organized list of vendors. Click on "resources on or off the web". 

VersaPoint

The VersaPoint is a single-sided embosser made by TeleSensory. See the Interface Guide or press F10 H I from the Editor for directions on setting it up for use with MegaDots. 

Verse play [style]

A verse play is a play in verse, such as a work of Shakespeare. Type Alt-P V to specify the Verse Play style. 

Verse stage [style]

A verse play is a play in verse, such as a work of Shakespeare. Stage refers to Stage directions. Type Alt-P V Down Arrow to specify the Verse Stage style. 

version date

To find the version number and release date of your MegaDots software, press F10 H A (to get the About MegaDots screen from the Help Menu). 

vertically centered

See dedication page. 

VIEW

VIEW is a command line program included with MegaDots to let you examine braille ready files. Type VIEW [filename] <Enter> from the DOS command line to use VIEW. Further instructions are on the screen. For more information, See Chapter 19. 

virtualization

For information on creating and using a virtual XP on a 64 bit systems (and on a Macintosh), See Chapter 2. 

virtual XP machine

For information on creating and using a virtual XP on a 64 bit systems (and on a Macintosh), See Chapter 2. 

visit text [spell checker]

Visit text lets you enter the full MegaDots Editor while spell checking. Visit mode puts the cursor at the beginning of the word. You can do any editing operation except translation or make use the top menu bar. To exit from visit mode and go back to the spell checker, press escape or F10. 

Vista

See Windows. Also See Chapter 2. 

visual boxes and lines

Many ASCII files, especially README files for software make decorative use of different characters to frame headings and show other aspects of format. MegaDots can read this format and produce quality braille from these files. If necessary, the ability to strip about these decorative elements can be suppressed. 

VM-Lite

VM-Lite is a virtualization product that lets you run MegaDots on a 64-bit system (such as most copies of Windows 7) See Chapter 2 for the details. 

VMware

VMware is a virtualization product that lets you run MegaDots on a 64-bit system (such as most copies of Windows 7) See Chapter 2 for the details. 

voice [Edit Menu, Verb]

Voice means to read aloud a section of text. Use voice when you want to have a certain segment of text (word, sentence, paragraph, page, document) read through your voice synthesizer. Press Control-V to bring up the menu. If you are not in the Editor, Control-V reads the screen. 

voice access

A voice access program hides in memory to assist a blind person to use the computer. See Chapter 13 for detailed information. 

voice preferences

Launch MegaDots with MEGA /AV /F <Enter> to force MegaDots into voice preferences. From within MegaDots, type Control-Z A V for voice preferences. To turn off voice preferences, replace the V with N in the above commands. For more information about voice access, See Chapter 13. 

volume contents

The Volume contents in British braille in a multi-volume work gives the braille page numbers for items in that braille volume. In volume 1, the Volume contents comes after the General contents which shows the print page numbers for the whole book. MegaDots can create a Volume contents automatically using the table of contents generator. Or you can create the Volume contents yourself manually by typing Control-Ins B P V (as long as you are using British braille). The guide dots in a volume contents are dots 3-6. If there is only one volume in your book, use a Combined contents instead. See also British braille, table of contents generator, and Chapter 17 of the User Manual. 

volume end indicator

A volume end indicator is used to show the end of a volume (but not the end of a book). It centers the words End of Volume in the end of the braille. To enter an volume end indicator, position the cursor at the end of the last paragraph, and type Control-Insert L V. MegaDots puts in the Roman numeral for the volume number (end of volume IV). If you want to override the supplied value, type a Roman numeral right after the volume end indicator. See whole book end indicator. 

volume of braille

A volume of braille is the amount of braille which is bound together as a unit. MegaDots assumes that if your document switches from Main Body pages back to preliminary pages, you are starting a fresh braille volume. In a large document, it is generally best to have each volume be one MegaDots file. 

Web Braille

Web Braille is a service provided by the NLS (National Library Service for the Blind and Physically Handicapped). Registered, eligible individuals can download braille ready files. You can emboss these files directly with the Embossit program, without using MegaDots at all (see Embossit 3.0). However, if you wish to do some reformatting before embossing, use MegaDots. See braille ready file. 

web (html) copies of MegaDots documentation

Using the last choice in the Help Menu (or use the menu of documentation from Start Menu, Programs, Duxbury, MegaDots 2.5 Documentation). See also documentation. 

web (html) file

MegaDots can import and export web (html) files. 

To create a link in a MegaDots files, highlight some text (such as "click here for more information on my summer vacation") and type Control-F J. Here you can reference the file summer.htm. How do you create summer.htm? By exporting summer.meg into html. With some practice, you can create a whole series of files that all link to each other and link to web sites around the web using MegaDots and the export feature. 

To create a bookmark in a file, highlight some text and type Alt-J followed by insert. 

If you are creating web (html) files from MegaDots, it is recommended that the first paragraph of the MegaDots file be in Header style (Alt-R H), and the second paragraph be in Heading level 1 style (Alt-H 1). When you export to web (html), this creates a non-printing "title" and a heading level 1 which does show up as the main heading in the web page. 

In the File Import Preferences, there is a question "excess emphasis". If you answer "allow", then MegaDots retains HTML commands it does not recognize as "hidden text". If you export this file back to web (html), then the hidden text is reconstructed back into HTML commands. If "excess emphasis" is set to "disallow", then MegaDots throws away the HTML commands it does not recognize. 

Another important preference is "World Wide Web Link" in the Translation Set Up page of the Document Menu. This option lets you change how links are shown in braille. I know this can be confusing. But think about it. When writing a web page in inkprint MegaDots, we have to figure out how to render the web links (the association between the text "click here for more information about my summer vacation" and the file name "summer.htm"). 

If you want to change how MegaDots imports web (html) files, see the ASCII file HTML.MSG. See Supplement 3 for documentation on how to modify this file. You can set it up so MegaDots can understand many additional html bracket commands. 

WHERE

See locate file. 

where am I [Edit Menu, Verb]

Pressing Control-W brings up a menu of choices (word, sentence, paragraph, page, document) to help you identify your position: 

· Character -- print emphasis or name of braille cell 

· Word -- n/a 

· Line -- line number in document 

· Sentence -- n/a 

· paraGraph -- style name and hierarchy level if any 

· Page -- page number 

· Document -- name of current document and output device 

whole book end indicator

A whole book end indicator is used to show the end of an entire book. It centers the words The End. To enter a whole book end indicator, position the cursor at the end of the last paragraph, and type Control-Insert L W. See volume end indicator. 

whole paragraph note

A Whole Paragraph Note (WPN) is an entire paragraph of any style you wish marked as a footnote. This entire paragraph then joins the End Notes pages. You can add headings, running heads, anything you want to the End Notes Pages. The WPN is designed to give greater freedom in formatting End Notes Pages in British Braille. See footnote, end note in the Reference Manual, and Chapter 17 on British Braille. The section Format Control of End Notes Pages in Chapter 17 is useful even if you are producing North American braille. 

You need to be very precise in your cursor movements, or the WPN does not "take" or work. An extra space or misplaced cursor causes MegaDots to not recognize the paragraph as a WPN. 

You need to be in show markup to create a WPN. Use Alt-up or down arrow to get to the precise start of a paragraph, then Control-X to mark a block, Alt-down, then left arrow, then Control-F N. Notice that the cursor should be exactly on a carriage return when you give the Control-F N command. 

If for some reason your paragraph does not "take" as a WPN, go back to show markup, remove the note markup, and repeat the process to create the WPN. 

widow control

A widow is the last line of a paragraph showing up as the first line of a page. Braille rules allow widows, so there is no widow control for braille in MegaDots. In inkprint, you want to try to avoid widows. In the inkprint Document Setup Screen of the Document Menu, there is a question about whether to do widow control. See also orphan. 

wildcard

A wildcard is a character in a file name that can stand for a number of other characters. DOS uses two wildcards, asterisk and question mark. A question mark stands for one character. The specification t?.txt matches with t1.txt, t.txt, and tq.txt. An asterisk matches with any number of characters. The specification T*.* matches with any file with a T as the first character of the name. Any book about DOS has more information about using wildcards in file names. See also Supplement 1. 

Window-Eyes

Window-Eyes is a speech program that works with MegaDots. Use the MegaDots 2.5 with speech icon with Window-Eyes. See Chapter 13 for additional details. 

Windows

MegaDots must be installed on a Windows computer. MegaDots is an MS-DOS application and not a true Windows program. See Chapter 2 for information for installing MegaDots from Windows and using MegaDots from Windows. MegaDots works with 95, 98, NT, 2000, ME, XP, Vista, and Windows 7. Vista and Windows 7 offer some challenges in running on a full screen; See Chapter 2 for the details. MegaDots does not work in a full 64 bit version of Windows. MegaDots runs in a variety of virtual XP systems, See Chapter 2 for the details. 

Windows devices

The programs Embossit 3.0 and MegaPrn allow MegaDots to output to Windows devices. See Chapter 5 and See Chapter 10 for the details. 

Windows emulation

You can run MegaDots on an emulated copy of Windows. When you install MegaDots, make sure you answer "no" to the question about using the full screen in MS-DOS. (click here for all of the details). 

Windows help files

MegaDots can read Windows help files. 

Windows registry

MegaDots uses some registry settings to control how the DBT file import engine chooses to import files. If you want to see what those settings are, see the file importer.reg. If you want to, you can edit this file, and then use the modified file to change the registry. 

Word (filetype)

MegaDots can import Microsoft Word files (2003, 2007, 2010) using the machinery of a modified Duxbury DBT built into MegaDots. See Chapter 7 for more information about file importation. Also see the entry for MS Word/BANA Template for information about Susan Christensen's Word Template. 

MegaDots can export to Microsoft Word files (2003, 2007, 2010) using the machinery of your copy of Word. See Chapter 20 for more information about file export. 

word [noun]

A word is a word is a word. As an example of a command using the noun word, you can type Control-D W to delete the rest of the current word. 

word processor files

MegaDots can import Microsoft Word files (2003, 2007, 2010) and WordPerfect files using the machinery of a modified Duxbury DBT built into MegaDots. See Chapter 7 for more information about file importation. Also see the entry for MS Wor/BANA Template for information about Susan Christensen's Word Template. 

MegaDots can export to Microsoft Word files (2003, 2007, 2010) using the machinery of your copy of Word. See Chapter 20 for more information about file export. 

word wrap

Many printers and embossers have a setting for word wrap. If a printer or embosser has word wrap set to on, it watches for lines which are too long and automatically moves to a new line if the next word cannot fit. Because MegaDots already handles these issues when you print or emboss from MegaDots, we recommend that you set word wrap to off on your printer or embosser. 

WordPad

Wordpad is a simple text editor built into Windows. 

WordPerfect files

MegaDots can read WordPerfect files, using the machinery of Duxbury DBT. See Chapter 7 for more information. 

WORDS.MDR
This rules file is supplied with MegaDots to count the words. In your document or marked block. To invoke it, just type Alt-F9 WORDS <Enter>. Your document is unchanged. The word count is on the bottom line. See also CHARS.MDR and rules file. 

Working directory

The working directory is the place where your store most of your work files. It is a good idea to set this up in you Default Directories under Preferences. When you do, MegaDots automatically changes to this directory for you whenever you start up the program. 

WYSIWYG

WYSIWYG is an abbreviation for What You See Is What You Get. WYSIWYG describes the effort to displays on the screen what you would get if you printed your current document. In MegaDots (as in other word processors), inkprint WYSIWYG is not perfect, because of limitations of the resolution of the screen. 

XML files

The most common form of XML file is web (html). However, sometimes you find files with completely different tags. See Supplement 3 for information about creating a table to control the interpretation of XMLL tags into MegaDots. See also web (html) file. 

XP Mode (of Windows 7)

The XP Mode of Windows 7 is discussed in chapter 2 (click here for all of the details). 

yen sign

To enter a Yen sign in your document, press Alt-dollar sign and select Yen. You cannot use simple replace to search for this symbol. Use complex replace (Control-F9), search for and Alt-dollar sign Y inside of quotes. 

zip to the end of word [spell checker]

Zip to the end of word is exactly like Visit mode, except that the cursor is placed at the end of the word. This lets you enter the full MegaDots Editor while spell checking. You can do any editing operation except translation or make use the top menu bar. To exit from visit or zip mode and go back to the spell checker, press escape or F10. 

Zippy Menu

To make life easier for the MegaDots users, we have collected many of the most common forms and questions that come up in MegaDots, and have put these in a special menu called the Zippy Menu. Press Control-Z to bring up the Zippy Menu. You can switch the screen mode for braille, the markup mode, toggle the proofreading bar, and specify common formatting commands from the Zippy Menu. 

ZoomText

ZoomText is a screen enlargement program for the PC independent of MegaDots. If you are using MegaDots with ZoomText, MegaDots sets and saves the appropriate editor preferences when you type MEGA /a2 /f <Enter> where the number after the /a, between 2 and 5, is the magnification you are using in ZoomText. When you need to be more specific about screen dimensions, set the Editor Preferences. 

